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ROLE OF SELF INSTRUCTIONAL   MATERIAL INDISTANCELEARNING 

 

The need to plan effective instruction is imperative for a 

Successful distance teaching repertoire. This is due to the fact that the instructional designer, the 

tutor, the author (s) and the student are often separated by distance and may never meet in 

person. This is an increasingly common scenario in distance education instruction. As much as 

possible, teaching by distance should stimulate the student’s intellectual 

Involvement and contain all the necessary learning instructional activities ties that are capable of 

guiding the student through the course objectives. Therefore, the course / self-instructional 

material are completely equipped with everything that the syllabus prescribes. 

To ensure effective instruction, a number of instructional design ideas are used and these help 
students to acquire knowledge, intellectual skills, motor skills and necessary attitudinal changes.  
In this respect, 

Students ‘assessment and course evaluation are incorporated in the text. 

The nature of instructional activities used in distance education self- instructional materials 

depends on the domain of learning that they reinforce in the text, that is, the cognitive, 

psychomotor and affective. These are further interpreted in the acquisition of knowledge, 

intellectual skills and motor skills. Students may be encouraged to gain, apply and communicate 

(orally or in writing) the knowledge acquired. Intellectual- skills objectives may be met by 

designing instructions that make 

use of students’ prior knowledge and experiences in the discourse as the foundation on which 

newly acquired knowledge is built. 

The provision of exercises in the form of assignments, projects and tutorial feedback is necessary. 

Instructional activities that teach motor skills need to be graphically demonstrated and the 

correct practices pros vided during tutorials. Instructional activities for inculcating change in 

attitude and behavior should create interest and demonstrate need and benefits gained by 

adopting the required change. Information on the adoption and procedures for practice of new 

attitudes may then be introduced. 



 

 

 

 

Teaching and learning at a distance eliminates interactive 

Communication clues, such as pauses, intonation and gestures, associated with the 

face-to-face method of teaching. This is particularly so with the exclusive use of print 

media. Instructional activities built into the instructional repertoire provide this missing 

interaction between the student and the teacher. Therefore, the use of instructional 

activities to affect better distance teaching is not optional, but mandatory. 

Our team of successful writers and authors has tried to r e d u c e  

This. Divide and to bring this Self Instructional Material as the b e s t  

teaching and communication tool. Instructional activities are varied in order to assess the 

different facets of the domains of learning. 

Distance education teaching repertoire involves extensive use of self- instructional 

materials, be they print or otherwise. These materials are designed to achieve certain pre-

determined learning outcomes, namely goals and objectives that are contained in an 

instructional plan. Since the teaching process is affected over a distance, there is need to 

ensure that students actively participate in their learning by performing specific tasks that 

help them to understand the relevant concepts. 

Therefore, a set of exercises is built into the teaching repertoire in order to link 

what students and tutors do in the framework of the course outline. 

These could be in the form of students ‘assignments, a research project 

or a science practical exercise. Examples of instructional activities in distance education 

are too numerous to list. Instructional activities, when used in this context, help to 

motivate students, guide and measure students’ performance (continuous assessment) 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

PREFACE 

 

 

We have put in lots of hard work to make this book as user-friendly as possible, but 

we have not sacrificed quality. Experts were involved in preparing the materials. However, 

concepts are explained in easy language for you. We have included many tables and 

examples for easy understanding. 

We sincerely hope this book will help you in every way you 

Expect. 

All the best for your studies from our team! 

 

 

 

 

 

 

All the best for your studies from our team! 



 

 

Unit 1 Skeletons and Rigging 

 

 

Time Required to Complete the unit 

 

The time required to study thus Unit is broken as follows 

1. 1st Reading: It will need 2 Hrs for reading a unit 

2. 2nd Reading with understanding:  It will need 3 Hrs for reading and understanding a unit 

3. Self Assessment:  It will need 3 Hrs for reading and understanding a unit 

4. Revision and Further Reading: It is continuous process 
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1.1 Introduction 

Skeletons 
Skeletons are hierarchical, articulated structures that let you pose and animate 
bound models. A skeleton provides a deformable model with the same 
underlying structure as the human skeleton gives the human body. Just like in 
the human body, the location of joints and the number of joints you add to a 
skeleton determine how the skeleton‟s bound model or „body‟ moves. 

Skeleton components 

A skeleton is composed of a series of joints and bones that form joint chains. 

1.1.1 Joints and bones 
Joints are the building blocks of skeletons and their points of articulation. Joints 
have no shape and therefore can not be rendered. Each joint can have one or 
more bone attached to it, and more than one child joint. Joints let you transform a 
skeleton when posing and animating a bound model. In simple words it 
represents the rotational pivot points. 
Bones do not have nodes, and they do not have a physical or calculable 
presence in your scene. Bones are only visual cues that illustrate the 
relationships between joints. In simple words it represents how joints are 
connected. 
 

1.1.2 Anatomical joint types 
Various joint attributes determine how joints behave. By adjusting the attributes 
of a joint, you can limit how far a joint can rotate or restrict what planes it can 
rotate about. 
1. Ball joint: A ball joint is a joint that can rotate about all three of its local 
axes. For example, the human shoulder is a ball joint. 
2. Universal joint: A universal joint is a joint that can rotate about only two of 
its local axes. The human wrist is an example of a universal joint. 
3. Hinge joint: A hinge joint is a joint that can rotate about only one of its 
local axes. For example, the human knee is a hinge joint. 
Joint chains 
A joint chain is any group of joints and their bones connected in a series. Joints 
are connected linearly, and their paths are drawn on screen by the bones. A joint 
chain begins at the highest joint in the chain‟s hierarchy, and its bones are drawn 
pointing down the chain. 
 

1.1.3 Skeleton hierarchy 
A skeleton hierarchy is composed of a series of joints and joints chains with 
hierarchical relationships. Each joint in a skeleton hierarchy is a child joint and a 
parent joint. The root joint is the highest joint in a skeleton‟s hierarchy. A skeleton 
can have only one root joint. You can move and orient the entire skeleton in 
world space by translating and rotating the root joint. 
 

1.1.4 Skeleton > 
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Joint Tool 
Join tool creates joints and joint chains. The options in the option box are: 
 
Joint Settings: 
1. Degrees of Freedom: This option specifies which of the joint‟s local axes; 
the joint can rotate about during inverse kinematics posing. 
2. Orientation: This setting sets the orientation of the local axes for all the 
joints you create with the Joint Tool. All the selections specify that the 
joint‟s local axis be oriented so that the first axis points into the joint‟s 
bone, the second axis points at right angles to the first and third axes, and 
the third axis points sideways from the joint and its bone. 
3. Second Axis World Orientation: This setting sets the world axis 
orientation for the second rotation axes of all the joints you create with the 
Joint Tool. 
4. Scale Compensate: When this option is on, the joints you create are not 
scaled automatically when you scale joints above them in the skeleton‟s 
hierarchy. 
5. Auto Joint Limits: When this option is on, Maya automatically limits the 
extent a joint can rotate about its axes according to the angles at which 
you build the skeleton‟s joints. 
6. Create IK Handle: When this option is on, an IK handle is automatically 
created for any joint chain you draw and the IK Handle Options section of 
the Joint Tool settings is available. The IK handle that is automatically 
created will run from the joint chain‟s start joint to its end joint. 
7. IK Handle Options: This option specifies the creation options for the IK 
handle that is automatically created when Create Ik Handle is on. 
8. Bone Radius Settings: When you create joints, the radii of your joints are 
determined by the length of their bones. 
a. Short Bone Length: This setting sets the bone length at which a 
bone is classified as short. 
b. Short Bone Radius: This setting sets the bone radius of short 
bones. 
c. Long Bone Length: This setting sets the bone length at which a 
bone is classified as long. 
d. Long Bone Radius: This setting sets the bone radius of long 
bones. 
 
Insert Joint Tool 
Insert Joint Tool lets you add an additional joint to an existing joint chain. 
 
Reroot Skeleton 
Reroot Skeleton designates the current joint as the parent or root of its hierarchy. 
 
Remove Joint 
Remove Joint option deletes the current joint and unites the remaining joints and 
bones into a single joint chain. 
 
 
Disconnect Joint 
Disconnect Joint option breaks the skeleton at the current joint, separating the
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skeleton into two joint chains 
 
Connect Joint 
Connect Joint option connects the selected joints. The options available are: 
1. Connect Joint: This option connects the selected joints and moves the 

joint chain of the first joint to the position of the second joint. 

2. Parent Joint: This option connects the selected joints by inserting a new 
bone between them. 
 
Mirror Joint 
This option duplicates the current parent‟s joint chain across the specified plane, 
as well as changes the orientation of the resulting duplicate joints. The available 
options are: 
1. Mirror Across: This option mirrors the joint across the plane you specify. 
2. Mirror Function: There are two options: 
a. Behavior: When this option is on, the mirrored joints have the 
opposite orientation as the original, and the local rotation axis of 
each joint points in the opposite direction of their counterparts. 
b. Orientation: When this option is on, the mirrored joints have the 
same orientation as the original joints. With this setting, you can 
copy animation from one limb to another and get identical behavior. 
c. Replacement names for duplicated joints: This option lets you 
specify the name identifier of the joints in the mirrored joint chain 
and lets you specify the names with which to replace the mirrored 
joint. 
 
Orient Joint 
This option sets the orientation of the selected joint. The options available are: 
1. Orientation: This option specifies the orientation of a joint‟s local axis. 
2. Second Axis World Orientation: This setting sets the world axis 
orientation for the second rotation axes of all the joints you create with the 
Joint Tool. 
3. Hierarchy (Orient child joints): When this option is on, the settings for 
Orient Joint will affect all the joints below the current joint in the skeleton‟s 
hierarchy. 
4. Scale (Reorient the local scale axes): When this option is on, the local 
scale axes of the current joint are also reoriented. 
 
Set Preferred Angle 
Set Preferred Angle lets you specify whether to set the preferred angle for the 
current joint or for all the joints from the current joint to its chain‟s end joint. The 
options available are: 
1. Selected Joint: This option sets the current angle of the selected joint as 
its preferred angle. 
2. Recursive: This option sets the current angles of all the joints from the 
selected joint to the joint at the end of the chain as their preferred angles. 
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Assume Preferred Angle 
This option returns the current skeleton‟s joints to the angles they possessed 
when their preferred angles were initially set. Lets you specify whether to reset 
the current joint‟s angle to its preferred angle or to reset all the joints from the 
current joint to its chain‟s end joint to their preferred angles. The available options 
are: 
1. Selected Joint: This option resets the current angle of the selected joint 
to its preferred angle. 
 
Recursive: This option resets the current angles of all the joints from the 
selected joint to the joint at the end of the chain to their preferred angles. 

 

1.2 IK Handles And Solvers 

1.2.1 Kinematics 

Kinematics is the branch of classical mechanics concerned with describing the 
motions of objects without considering the factors that cause or affect the motion. 
 

1.2.2 Forward kinematics (FK) 

With forward kinematics (FK), you rotate or move individual joints to pose and 
animate your joint chains. Moving a joint affect‟s that joint and any joints below it 
in the hierarchy. Forward kinematics is ideal for creating non-directed motion 
such as the rotations of a shoulder joint, and should not be used to animate a 
large, complicated skeleton. Also, forward kinematics is difficult to use for 
specifying goal-directed motion. 
 

1.2.3 Inverse kinematics (IK) 

With inverse kinematics (IK), you move an IK handle to pose an entire joint chain. 
An IK handle is an object you can select and move that affects the joints it is 
assigned to. A joint chain that has an IK handle is called an IK chain. When you 
pose and animate a joint chain with an IK handle, the IK solver automatically 
rotates all the joints in the IK chain. The IK solver is what Maya uses to calculate 
the rotations of all the joints in the IK chain when you position the IK handle. 
Inverse kinematics is more intuitive for goal-directed motion than forward 
kinematics because you can focus on the goal you want a joint chain to reach 
without worrying about how each joint in the chain should rotate. 
 
Full body IK (FBIK) 
You can quickly and easily create natural looking poses and animation for your 
biped and quadruped characters with the new full body IK. 
 
IK handles 
In an IK chain, the joint where the IK handle begins is called the start joint and 
the joint where the IK handle ends is called the end joint. The end of the IK 
handle, which is located at the last joint of the IK chain by default, is called the 
end effecter. When you move the IK handle, the IK solver uses the end effecter‟s
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position and orientation in its calculations to rotate the joints in the IK chain 
accordingly. 
 
IK/FK blending 
You can pose and animate the joints of a joint chain using both FK and IK. This is 
called animation blending. Ik Blend lets you switch between posing and 
animating with pure FK or pure IK, as well as control the blend between the two 
kinds of animation. 
 

1.2.4 IK Solvers 
IK solvers are the mathematical algorithms behind the IK handles. IK solvers 
calculate the rotations of all the joints in a joint chain controlled by an IK handle. 
The effect an IK handle has on a joint chain depends on the type of IK solver 
used by the IK handle. IK solvers available in Maya are: 
1. Single Chain IK solver (ikSCsolver) 
2. Rotate Plane IK solver (ikRPsolver) 
3. Spline IK solver (ikSplineSolver) 
4. Human IK solver (hikSolver) 
5. 2 Bone IK solver (ik2Bsolver) 
6. Multi-Chain IK solver (ikMCsolver) 
7. Spring IK solver (ikSpringSolver) 
 

1.2.5 Pole vector 

The pole vector is a manipulator that lets you change the orientation of the IK 
chain. The pole vector also lets you control flipping. 
 
IK Handle Tool 
IK Handle Tool is used to create IK handles for the joint chains. The options 
available in the option box are: 
1. Current Solver: This drop-down menu specifies the type of IK solver IK 
handle will have. 
2. Autopriority: When this option is on, software sets the IK handle‟s Priority 
automatically upon creation. 
3. Solver Enable: When this option is on, the IK solver will be active upon 
creation. 
4. Snap Enable: When this option is on, IK handle will snap back to the IK 
handle‟s end joint‟s position. 
5. Sticky: When this option is on, the IK handle will stick to its current 
position and orientation when you pose the skeleton using other IK 
handles or when translating, rotating, or scaling individual joints. 
 
Enable IK Handle Snap 
This option causes the IK handle to snap back to its end joint‟s position. 
 
Enable IK/FK Control 
When Enable IK/FK Control is on, you can rotate the joints in an IK chain 
whether or not the IK handle has keys. 
 
Enable Selected IK Handles
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This option turns the editability of the selected IK handles on, and sets their Ik 
Blend values to 1.000. 
 
Disable Selected IK Handles 
This option turns the editability of the selected Ik handles off, and sets their IK 
Blend values to 0.000. 
 

 
1.2.6 Constraints > 
 
Pole vector constraint: pole vector constraint is a constraint that causes the 
end of a pole vector to move to and follow the position of an object, or the 
average position of several objects. 
 
To create Pole Vector Constraint : 
Select Constrain > Pole Vector 
First set creation options and create a pole vector constraint, or you can 
immediately create a constraint with the current creation options also. 
 
To delete Pole Vector Constraint: 
Delete the pole vector constraint node. 
 
To set pole vector constraint options: 
Select Constrain > Pole Vector > 
The Pole Vector Constraint Options window is displayed. 
So, now you can set the options. 
 
To edit pole vector constraint attributes: 
Select the pole vector constraint node. 
Open the Attribute Editor by selecting Window > Attribute Editor 
 

1.2.7 Spline IK: This is used to control a chain of linked objects or bones of a 

character as a connected chain like the bones of a tail or spine, so the bones will 
be able to move like the same when we move them. 
In Maya a NURBS curve is used to control an IK Spline handle, so when the 
NUBRS curve is moved or animated the bones will be having the same 
animation. 
You can convert any NURBS CV in to Spline IK joint chain by using Edit Curves 
> Curve Editing Tool 
 

 
1.2.8 Skeleton > 

 
IK Spline Handle Tool 
IK Spline Handle Tool is used to create Ik spline handle for the joint chains. The 
options available in the option box are: 
1. Root on Curve: When this option is on, the start joint of the IK spline 
handle is constrained the curve. You can drag an offset manipulator to
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slide the start joint along the curve. 
2. Auto Create Root Axis: When this option is on, a parent transform node 
above the start joint in the scene hierarchy is created with the spline IK 
handle. 
3. Auto Parent Curve: If you create a handle that starts at a joint in the 
chain lower than the root joint of your skeleton, turn this option on to 
ensure that the joint chain moves with the transformations of its parent 
joint. 
4. Snap Curve to Root: When this option is on, the start of the curve snaps 
to the position of the start joint. The joints in the chain rotate to adapt to 
the shape of the curve. 
5. Auto Create Curve: When this option is on, Maya creates a NURBS 
curve when you create the spline IK handle. The curve that is created 
follows the path of the joint chain. 
6. Auto Simplify Curve: When this option is on, Maya automatically creates 
a NURBS curve with the specified Number of Spans. The number of 
spans corresponds to the number of CVs in the curve. 
7. Number of Spans: Number of Spans specifies the number of CVs for the 
curve that Maya automatically creates when you create the spline IK 
handle. 
8. Root Twist Mode: When this option is on, manipulating the twist 
manipulator at the end joint will twist the start joint slightly with the other 
joints. 

 

1.3 Assignment 

1. Build Skeleton and FK Walk Cycle 

2. IK Walk Cycle 
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UNIT 2  Facial Expressions 
 

 

 

Time Required to Complete the unit 

 

The time required to study thus Unit is broken as follows 

1. 1st Reading: It will need 2 Hrs for reading a unit 

2. 2nd Reading with understanding:  It will need 3 Hrs for reading and understanding a unit 

3. Self Assessment:  It will need 3 Hrs for reading and understanding a unit 

4. Assignment: It will need 4 Hrs for completing an assignment 

5. Revision and Further Reading: It is continuous process 
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2.1 Blend Shapes 
 
2.1.1 Create Blend Shape 
Blend shape deformers let you to deform a surface into the shapes of other 
surfaces. You can blend shapes with the same or a number of vertices (or CVs). 
Objects whose shapes you want to use to deform the shape of another object are 
called target objects, and the object being deformed is called the base object. 
The options available in the option box are: 
1. BlendShape Node: This option specifies the name of the blend shape 
deformer. 
2. Envelope: This option specifies the deformation scale factor. 
3. Origin: This option specifies whether the blend shape will be relative to 
the base object shape‟s position, rotation, and scale or to the world. 
4. Target Shape Options: 
a. In-Between: This option specifies whether the blending will be in 
series or in parallel. Shape transitions will occur in the order in 
which you selected the target shape(s). The effect will be that the 
blend shape will be able to change from the first target object 
shape, to the second, and so on, back and forth through the series 
of target object shapes chained together as “in-between” shapes. 
b. Check Topology: This option specifies whether to check if the 
base shape and the target shape(s) have the same topology. 
c. Delete Targets: This option specifies whether to delete the target 
shape(s) after creation. 
 

2.1.2 Edit Blend Shape 
1. Add: This option adds the selected object to the blend deformer. 
2. Remove: This option removes the selected object from the blend 
deformer. 
3. Swap: Swap option interchanges the blend targets; this is useful in case if 
you blend with in-between option. 
4. Bake Topology to targets: With Bake Topology to targets, you can 
regenerate or update your blend shape deformations so that any 
topological changes made to your blend shape base shapes are also 
applied to their target shapes. 
 
Blend Shape Editor 
Blend shape editor provides you with the options to control the blend deformer. In 
this editor you will be provided with the 
target weight sliders, target names and 
buttons to key the blend deformer. 
The options available are:
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1. Target weight sliders: Each slider provides a way for you to set the 
target weight quickly. You can change the orientation of the sliders from 
the options menu. 
2. Target weight boxes: Each box displays the current weight for each 
target. 
3. Target names: By default, the target name is the name of a target object. 
Entering a new target name does not change the name of the target 
object. 
4. New button: Click New to create a new blend shape deformer. 
5. Add button: It bakes the selected base shape and add it as a target. 
6. Key All button: Key all weights at their current values. 
7. Reset All button: Set all weight values to zero. 
8. Select button: Select the blend shape deformer node. 
9. Key buttons: Key the current value. 
 

 
 
 

1.2 Texturing 
 
1.3 Shaders, Materials and Mapping 
 

2.3.1 Hypershade 
Hypershade is a window in which you can create, edit and connect the rendering 
nodes such as materials, shaders, rendering utilities, lights, etc. Hypershade is 
the best way to map relationships and edit shading networks. In a way, you are a 
programmer because you are connecting coded elements to produce an 
algorithm to describe a material to render. The result is a Shader that has certain 
visual properties that are then applied to a surface. Hypershade simply graphs 
the elements that comprise your Shader. 
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2.3.2 Interface 

 
When you open Hypershade, you are presented with three areas. The first is 
Create Nodes, on the left. The second is the top tabs, where materials, textures, 
and other related materials are located. The bottom tab contains a work area as 
well as tabs such as the Shader Library; this is where most of the mapping of 
relationships occurs. 
Hypershade window has its own menu bar. 
1. File menu contains command for importing and exporting the materials. 
2. Edit menu contains command for deleting, selecting, converting and 
rendering texture range. 
3. Create menu contains command for creating render nodes. 
4. Tabs menu contains commands for creating, renaming and deleting tabs. 
 
Texture Libraries 
You can also create texture libraries for reusable textures. This is done by 
following these steps: 
1. Create a Library project by going to File > Project > New. Set the Use 
Defaults button on. 
2. Make a tab in your Hyhpershade window by selecting Tabs, Create New. 
3. Type Library in the New Tab Name text box. 
4. Set the Initial Placement to Bottom, and set Tab Type to Disk. 
5. Click the Root Directory folder icon to browse to the Library project. 
6. Click creates to see the new tab in the lower Hypershade panel. 
 

2.3.3 Understanding the Network Graph of Material 
In the Hypershade pellette right click on any of the assigned material and select 
Network graph. Down there you can get the Network graph of the material.
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2.3.4 Raytracing 
Raytracing is a rendering technique used to create photorealistic reflections and 
refractions on reflective surfaces, and to produce shadows. Raytracing is a highquality 
alternative to reflection mapping, although it requires more computation 
time. Raytracing accurately renders the properties like: 
1. Direct Illumination 
2. Shadows 
3. Specular Reflections 
4. Transparency Effects 
The raytracing algorithm calculates the color for each pixel by emitting rays from 
the camera into the scene. When a ray hits an object, its color is evaluated and 
then a secondary ray is projected (bounced) if the object is reflective or 
refractive. Maya calculates raytracing only when it is turned on in the raytracing 
quality section in render options. 

 
2.3.5 Hypershade Nodes 
Nodes in the Hypershade window are divided into following categories: 
1. Material Nodes: The Material node is further categorized into following: 
a. Surface Material Nodes 
b. Displacement Nodes 
c. Volumetric Nodes 
2. Texture Nodes: The texture node is further categorized into following: 
a. 2D Texture Nodes 
b. 3D Texture Nodes 
c. Environment Nodes 
d. Other Textures Nodes
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3. Image Planes Nodes: 
4. Render Utilities Nodes: The Render Utilities node is further categorized 
into following: 
a. General Utilities Nodes 
b. Color Utilities Nodes 
c. Switch Utilities Nodes 
d. Particle Utilities Nodes 
5. Lights Nodes 
6. Glow Nodes 
 
Common Surface Attributes 
The following attributes are common to most surface materials. 
1. Color: The default material color. 
2. Transparency: A material‟s color and level of transparency. For example, 
if the Transparency Value is 0 (black), the surface is totally opaque; if the 
Transparency value is 1 (white), the surface is totally transparent. 
3. Ambient Color: If the Ambient Color becomes lighter, it affects the 
material‟s Color by lightening it and blending the two colors. If there are 
ambient lights in the scene, the color and brightness of those lights is used 
to control how much the ambient color contributes to the final color of the 
material. 
4. Incandescence: The color and brightness of light that a material appears 
to be emitting. 
5. Bump Mapping: Makes the surface appear rough or bumpy by altering 
surface normals (during rendering) according to the intensity of the pixels 
in the bump map texture. A bump map does not actually alter the surface. 
A silhouette of the surface appears smooth. 
6. Diffuse: Gives the material the ability to reflect light in all directions. The 
Diffuse value acts like a scaling factor applied to the Color setting—the 
higher the Diffuse value, the closer the actual surface color is to the Color 
setting. 
7. Translucence: Gives the material the ability to transmit and diffuse light. 
Light falling on a translucent surface is first absorbed beneath the surface, 
and then diffused in all directions. 
8. Translucence Focus: The Translucence Focus value controls how much 
translucent light is scattered depending on the direction of the light. 
9. Specular Color: The color of shiny highlights on the surface. A black 
Specular Color produces no surface highlights. 
10. Reflectivity: Gives the surface the ability to reflect its surroundings or the 
Reflected Color 
11. Reflected Color: Represents the color of light reflected from the material. 
12. Special Effects: These attributes control the appearance of glows 
produced from light reflecting off surfaces, or from surface incandescence. 
Special Effects attributes are available for Anisotropic, Blinn, Lambert, 
Phong, and PhongE material types. 
13. Matte Opacity: You can control the mask value for individual objects. Matt 
Opacity attributes are available for Anisotropic, Blinn, Lambert, Layered 
Shader, Phong, PhongE, Shading Map and Use Background material 
types. 
14. Raytrace Options: The Raytrace Options attributes control the



Maya Part II  
    BMGA303 

 

25 

appearance of a surface during raytracing only. Raytrace Options 
attributes are available for Anisotropic, Blinn, Lambert, Phong, and 
PhongE material types. 
 

2.3.6 IPR Renders 
IPR stands for Interactive Photo Realistic rendering. It‟s a tool designed to allow 
you to make interactive adjustments to the final rendered image, and which 
greatly enhances rendering productivity. IPR lets you preview and adjust lights, 
shaders, textures, and 2D motion blur quickly and efficiently. IPR is ideal for 
visualizing your scene as you work because it almost immediately shows the 
changes you make. IPR doesn't support all software renderable features like 
raytracing. 
 
To render a single frame choose Render > Render Current Frame. 
 

2.3.7 Material 
Material is an picture of the objects look like when it is rendered. It is also known 
as shader. 

 
 
Anisotropic 
An anisotropic material reflects specular light differently in different directions. If 
you spin an anisotropic sphere, its specular highlight changes, depending on the 
direction of the grooves. The options specific to this shaders are: 
1. Angle: Angle determines the orientation of the grooves. 
2. Spread X/Spread Y: Spread determines how much the grooves spread
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out in the X and Y directions. The X direction is the U direction rotated 
counter-clock-wise by the specified Angle degrees. The Y direction is 
perpendicular to the X direction in UV space. 
3. Roughness: Roughness determines the overall roughness of the surface. 
4. Fresnel Index: A fresnel is a flat lens consisting of a 
number of concentric rings that reduces spherical 
abnormalities. The Fresnel Index value computes the 
fresnel factor that connects the reflected light wave to the 
incoming light wave. 
5. Anisotropic Reflectivity: If Anisotropic Reflectivity is on, 
Maya automatically calculates Reflectivity as a fraction of Roughness. 

 
Blinn 
An isotropic material (such as Phong or Blinn) reflects specular light identically in 
all directions. If you spin an isotropic sphere, its specular highlight remains still. 
Blinn is a material that is particularly effective at simulating metallic surfaces (for 
example, brass or aluminium) which typically have soft specular highlights. The 
options specific to this shaders are: 

1. Eccentricity: Eccentricity controls the size 

 
of shiny highlights on the surface. 
2. Specular Roll Off: Specular Roll Off gives 
the surface the ability to reflect its 
surroundings (the environment, other 
surfaces) or the Reflected Color, when viewed at oblique angles. 
Lambert 

 
Lambert is a material that represents matte surfaces (unpolished 
surfaces) with no specular highlights. The default shading group uses 
a special Lambert surface material. Do not modify it; instead, create 
and apply a new Lambert material. There are no specific options for 
Lambert.
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Layered shaders 
You can layer shaders when you want to use more than one material for an 
object. Layered shaders let you create the appearance of variations in the 
material qualities of the surface by combining two or more material nodes that 
each has their own qualities. The options specific to this shaders are: 
1. Transparency: Transparency sets the material‟s transparency. By default 
the material is semi-transparent. 
2. Compositing Flag: This option is used to composites the layers in either 
Layered Shader node or Layered Texture node. Each mode calculates the 
transparency flag differently. 
a. Layered Shader: The color and transparency are processed and 
passed together to the Layered Shader. 
b. Layered Texture: Color and transparency are passed separately to 
the layered shader. 

 
 
Phong 
Phong is a material that represents glassy or glossy surfaces with a 
hard specular highlight. The options specific to this shaders are: 
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1. Cosine Power: Cosine power controls the size of shiny 
highlights on the surface. 
 
Phong E 
PhongE is a material that is a simpler version of the Phong material. The 
specular highlights on Phong E surfaces are softer than those on 
Phong surfaces, and Phong E surfaces render faster. The options 
specific to this shaders are: 

 
 
1. Roughness: Roughness controls the specularity focus. 
2. Highlight Size: Highlight Size controls the amount of 
specular highlight. 
3. Whiteness: Whiteness controls the specular highlight color. 
The default is white, but you can choose any color. You can also map a 
texture to this value. 
Ramp Shader 
The Ramp Shader is a material that you can use for extra control over the way 
color changes with light and the view angle. You can simulate a variety of exotic 
materials and tweak traditional shading in subtle ways. 
All the color-related attributes in the Ramp Shader are controlled by ramps 
(gradients). Graphs let you avoid complex shading networks by making certain 
looks, like toon shading, easier to achieve. 
You can set the many attributes of the Ramp Shader to control the appearance 
of objects. Each color entry in a ramp has a circular color handle above the ramp, 
and a square color icon below the ramp. The active color has a white border 
around its color handle and icon. 
 
Textures 2D 
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Bulge 
Bulge procedurally creates a grid of white squares that fade to gray toward the 
edges. Use as a bump or displacement map to create surface bulges, as a 
transparency map or specular map to simulate real-world objects, such as 
windows that are dirty around the edges, or as 
a color map to simulate tiles. The options are: 
 
 
Uwidth, Vwidth: The width of the texture squares in U and V directions. 

 
Checker 

 
Checker procedurally creates a checkerboard pattern. The options available are: 
1. Color 1 & 2: The two colors for the 
patterns. 
2. Contrast: The color contrast 
between the two colors. 
Cloth 
Cloth simulates fabric or other woven materials. The options available are: 
1. Gap Color: The color of the area between the warp (U direction) and weft 
(V direction) threads. The colors blend into the Gap Color at their edges. A
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lighter Gap Color simulates a cloth with softer, more translucent threads. 

 
2. U Color, V Color: U and V thread colors. 
3. U Width, V Width: U and V thread widths. 
4. U Wave, V Wave: The waviness of U and V threads. Use to create 
special wave effects. 
 
5. Randomness: Smears the texture randomly in U and V directions. Adjust 
the Randomness value to create natural-looking cloth with irregular 
threads, or to prevent aliasing and moiré patterns on very fine cloth 
textures. 
6. Width Spread: Width spread randomizes the width of each thread along 
its length by subtracting a random amount from the U Width and V Width 
values. 
7. Bright Spread: Bright Spread randomizes the brightness of each thread 
along its length by subtracting a random amount from U Color and V 
Color. 
File 
File lets you use an image file as a 2D texture. The options available are: 
1. Filter Type: The sampling technique applied to the image file during 
rendering. The Quadratic, Quartic, and Gaussian filters only work when 
the File texture is mapped directly to a shading group. 
2. Pre-Filter: The Pre-Filter and Pre-Filter Radius attributes are used to 
correct file textures that are aliased or contain noise in unwanted areas. 
This can be very useful in displacement mapping. 
3. Image Name: The name of the image file or movie file used by the File texture. 

 
4. Reload: Use this to force a refresh of the texture. 
5. Edit: Launches an external application from Maya so that you can edit your 
textures. 
6. View: Launches an external application from Maya so that you can view 
your textures. 
7. Use BOT: Use block ordered textures. 
8. Disable File Load: If set, then the texture is not loaded. Instead a grey 
color is output in place of the image. 
9. Use Image Sequence/Image Number/Frame Offset: To use a sequence 
of image files as an animated texture when rendering, turn on Use Image 
Sequence. 
Fractal 
Fractal represents a random function with a particular frequency distribution. You
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can use the Fractal texture as a bump or displacement map to simulate rock or 
mountains, or as a transparency map to 
simulate clouds or flames. The available 
options are: 
1. Amplitude: A scaling factor applied to all values in the texture. 

 
2. Threshold: An offset factor applied to all values in the texture. 
3. Ratio: Ratio controls the frequency of the fractal pattern. 
4. Frequency Ratio: This option determines the relative spacial scale of the 
noise frequencies. If this ratio is not a whole integer then the fractal does 
not repeat at the integer uv boundaries. A cylinder with default placement 
would then display a seam. 
5. Level Min, Level Max: The minimum and maximum number of iterations 
used to calculate the fractal pattern. These values control the granularity 
of the fractal pattern. 
6. Inflection: This applies a kink in the noise function. This is useful for 
creating puffy or bumpy effects. 
7. Animated: Animate the fractal pattern by setting Animated on and 
keyframing the Time value. The Fractal texture takes longer to calculate 
when Animated is on. 
8. Time: Change the Time value to adjust an animated fractal pattern. 
9. Time Ratio: This option determines the relative time scale of the noise 
frequencies. 
Grid 
Grid represents a scalar grid pattern. The options available are: 
1. Line Color: Color of the grid lines. 
2. Filler Color: Color of the spaces between the grid lines. 
3. U Width, V Width: Width of the grid lines in U and V directions. 
4. Contrast: Contrast between the Line Color and the Filler Color. 

 
 
Mountain 
Mountain simulates rocky terrain using a 2D fractal pattern. The options available 
are: 

] 
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1. Snow Color, Rock Color: Color of the snow and rock. 
2. Amplitude: Scaling factor applied 
to all values in the texture. 
3. Snow Roughness: Roughness of the snow. 
4. Rock Roughness: Roughness of the rock. 
5. Boundary: Raggedness of the rock/snow boundary. 
6. Snow Altitude: The level (altitude) of the transition between rock and 
snow. 
7. Snow Dropoff: The suddenness with which snow no longer sticks to the 
mountain. 
8. Snow Slope: The maximum angle (expressed as a decimal value) over 
which snow does not stick to the mountain. 
9. Depth Max: The maximum number of iterations used to calculate the 
fractal pattern, which controls the granularity of the fractal pattern. 
 
Movie 
The Movie texture shares the same attributes as the File texture. The difference 
is that the Movie texture assumes all frames are stored in a single concatenated 
file using the assigned Image Name instead of separate files. 

 
 
Noise 
Noise can be used to create many different types of effects. The options 
available are: 
Threshold: The number added to the whole fractal effect, making it uniformly 
brighter. If the Volume Noise is used as a bump map, it appears as plateau 
regions. The options available are: 
1. Amplitude: Scaling factor applied to all the values in the texture, centered 
on the texture's average value. When you increase Amplitude, the light 
areas get lighter and the dark areas get darker. If Noise is used as a bump 
map, increasing Amplitude results in higher bumps and deeper valleys. 
2. Ratio: Ratio controls the fractal noise frequency. Increase this value to 
increase the fineness of the fractal detail. 
3. Frequency Ratio: This option determines the relative scale of the noise 
frequencies. 
4. Depth Max: This option controls how much calculation is done by the 
Noise texture. Use Depth Max to control the maximum amount of 
calculation for the texture. 
5. Inflection: Inflection applies a kink in the noise function. It is useful for 
creating puffy or bumpy effects. 
6. Time: Time is used to animate the Noise texture. You can keyframe the 
Time attribute to control the rate and amount of change of the texture. 
7. Frequency: Frequency determines the fundamental frequency for the 
noise. As this value increases the noise becomes more detailed. It has the 
inverse effect of the scale parameter.
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8. Implode: This warps the noise function in a concentric fashion about a 
point defined by the Implode Center. 
9. Implode Center: This option defines the center UV point about which the 
implode effect is defined. 
10. Noise Type: This option determines which noise to use during the fractal 
iteration. 
a. Perlin Noise: The standard 3D noise used in the solidFractal texture. 
b. Billow: Billow has a puffy, cloud-like effect. 

 
c. Wave: A sum of 3D waves in space. 
d. Wispy: A Perlin noise that is uses a second noise as a smear map; 
this makes the noise stretch out in places, looking wispy. 
e. SpaceTime: A 4-dimensional version of the Perlin noise, where 
time is the 4th dimension. 
11. Density: Density controls how many cells are imbedded in the medium 
used by the Billow noise type. 
12. Spottyness: Spottyness controls the density randomization of individual 
cells used by the Billow noise type. 
13. Size Rand: This option controls the randomization of the size of the 
individual blobs used by the Billow noise type. 
14. Randomness: Randomness controls how the cells for the Billow noise 
type are arranged relative to one another. 
15. Falloff: Falloff controls the way intensity falls off for individual blobs for the 
Billow noise type. 
a. Linear: A uniform falloff from the center to a value of zero at the 
edges of the blobs. 
b. Smooth: More natural looking, using a gaussian falloff. 
c. Fast: Fast focuses the intensity more towards the center of the 
blobs. 
d. Bubble: Uses a reverse falloff, fading to zero at the blob center. 
16. Num Waves: This option determines how many waves to generate for the 
Wave noise type. 
Ramp 
Ramp creates a gradation through a series of colors. The options available are: 
Type: The direction of the color 
ramp. 
1. Interpolation: Interpolation controls the way colors blend in the ramp. 

 
2. Ramp: Each color component in the ramp has a circular color handle on the left 
side, and a square color icon on the right side.
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3. Selected Color: The active color component. The active color has a white 
border around its color handle and icon. 
4. Selected Position: Position of the active color component in the ramp. 
5. U Wave, V Wave: These options control the amplitude of a sine wave 
offset of the texture in the U and V directions. Increasing the U Wave or V 
Wave increases the display of the texture‟s waviness. 
6. Noise: Offset amount in the U and V directions by 2D noise. 
7. Noise Freq: This option controls the noise granularity. 
8. HSV Color Noise: This option randomizes a Ramp texture‟s color using 
three separate 2D noises which affect the color‟s Hue, Saturation, and 
Value. 
9. Hue Noise: Offsets the color hue. Use to mark the color with specks of 
different colors. 
10. Sat Noise: Offsets the color saturation. Use to create a weathered look. 
11. Val Noise: Offsets the color value. 
12. Hue Noise Freq, Sat Noise Freq, Val Noise Freq: These options control 
the granularity for hue, saturation, and value noise. 
 
Water 

 
Water simulates linear water waves, concentric water ripples, or a combination of 
waves and ripples. Use as a bump or displacement map to simulate water, or as a 
color map to simulate light reflections or refractions from a water surface. The options 
available are: 
1. Number Of Waves: The number of linear waves in the texture. 
2. Wave Time: This option controls the appearance of the waves over time. 
To simulate moving waves, animate the Wave Time value. 
3. Wave Velocity: This option controls the wave speed. 
4. Wave Amplitude: Wave Velocity scales the wave height. 
5. Fast: An optimization for the Water texture. 
6. Wave Frequency: This option controls the distance between primary 
waves. 
7. Sub Wave Frequency: This option controls the distance between 
secondary waves that ride on top of primary waves. 
8. Smoothness: Smoothness controls the intensity of secondary waves. 
9. Wind UV: The strength of wind in the U and V directions. 
Concentric Ripple Attributes: These options control the appearance of 
concentric water ripples. The Concentric Ripple attributes do not affect the 
linear wave component of the texture. 
1. Ripple Time: Ripple time controls the appearance of ripples over time. 
2. Ripple Frequency: Ripple Frequency controls the distance between 
individual ripples. 
3. Ripple Amplitude: This Scales the height of the ripples. 
4. Drop Size: The mass of the droplet that starts the water ripples. 
5. Ripple Origin: The location of the center of the ripples along U and V
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directions. 
6. Group Velocity: The speed of the primary ripple. 
7. Phase Velocity: The speed of sub-ripples. 
8. Spread Start: Degree of effect a droplet has on a still water surface at 
time 0. A concentric ripple starts as a point of disturbance in space when 
the Ripple Time value is 0. The size of the disturbance at time 0 is 
determined by the Spread Start value. 
9. Spread Rate: Rate at which the primary ripple breaks into sub-ripples. 
10. Reflection Box: This option activates an imaginary reflective bounding 
box ripples can reflect off. 
11. Box Min, Box Max: These options define the bounding box in the U and V 
directions. If Reflection Box is off, these attributes have no effect. 
3D Textures 
3D textures allow objects to appear as if carved out of materials such as marble, 
rock, or wood. 
 

 
Brownian 
Brownian resembles thickly painted metal. The options available are 
1. Lacunarity: Lacunarity defines the gap between the frequencies you add to form 
the texture. 
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2. Increment: Increment 
determines the ratio for the 
fractal noise. 
3. Octaves: Octaves sets the upper limit for noise frequencies. 
4. Weight3d: This option determines how wavy the image appears when 
projected by controlling the scale of the frequency of any fractal used in 
the procedure. 
 
Cloud 
Cloud simulates the clouds. You should use cloud texture only on spheres. The 
area surrounding the cloud is always transparent. You can combine two or 
more spheres to create complex cloud arrangements. The options available 
are: 

 
1. Color1, Color2: The two colors blended together to form the cloud. 
2. Contrast: The contrast between Color1 and Color2. 
3. Amplitude: Amplitude controls the strength of the fractal noise used to 
generate the Cloud texture. 
4. Depth: Depth controls the granularity of the texture. 
5. Ripples: Ripples determines the texture‟s waviness in the X, Y, and Z 
directions. 
6. Soft Edges: This option simulates natural looking clouds. Gradually 
increases the transparency of the texture as the surface it is mapped to 
turns away from the camera. 
7. Edge Thresh, Center Thresh: If Center Thresh is low and Edge Thresh is 
high, the texture resembles a dense cotton-ball. If Center Thresh is high 
and Edge Thresh is low, the texture resembles a wispy cloud. 
8. Transp Range: The range over which the texture becomes transparent. 
The value controls the sharpness/softness of the cloud‟s edges. 
9. Ratio: Ratio controls the frequency of the fractal noise used to generate 
the Cloud texture. 
Crater 
Crater creates the appearance of both plateaus and craters by mixing normal 
disturbance and 3D disturbance, such as color or transparency. The options 
available are: 

 
1. Shaker: Increase this value to 
add more detail to the default 
Shaker texture. 
2. Channel1, Channel2, Channel3: The three channels through which
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information such as color values passes. 
3. Melt: Melt controls the edge softness between the colors in the texture. 
Increase this value to display the borders between the colors smoother 
and wider. 
4. Balance: Balance controls the ratio of the three shaken colors. 
5. Frequency: This option controls the frequency of how many times the 
texture colors are shaken. 
6. Norm Depth: This option controls the depth of the craters when the 
texture is used as a bump map. Increasing Norm Depth deepens the 
craters. 
7. Norm Melt: This option controls the softness of the crater edges when this 
texture is used as a bump map. You can animate this to make the 
cratered surface look like it is melting. 
8. Norm Balance: This option controls the ratio between the low and high 
normal‟s disturbance when this texture is used as a bump map. 
9. Norm Frequency: Norm Frequency controls the amount of rough detail 
when this texture is used as a bump map. 
Granite 
Granite simulates the granite stones. The options available are: 

 
1. Color1, Color2, Color3, Filler 
Color: The color of the three 
different types of cells and the color 
surrounding the cells. 
2. Cell Size: Cell size represents the individual cell size. This value scales 
the entire texture. 
3. Density: Density controls the cell spacing. 
4. Mix Ratio: This option determines which color is dominant. 
5. Spottyness: Spottyness randomizes the cell color intensity. 
6. Randomness: This option randomizes the cell position. 
7. Threshold: Threshold controls how cell colors and filler color mix into 
each other. 
8. Creases: Creases creates boundaries between cells. 
 
Leather 
Leather simulates materials such as snake or alligator skin, Styrofoam, or 
concrete. Major options of leather are similar to the granite except that there is 
one cell color instead of three: 

 
1. Cell Color, Crease Color: The
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color of individual cells and the 
color surrounding the cells. 
 
Marble 
Marble simulates marble stone. The options available are: 
1. Filler Color, Vein Color: The color of the filler material and the vein 
material. 
2. Vein Width: The thickness or width of the veins. 
 
3. Diffusion: Diffusion controls the amount of Vein Color that blends into the 
Filler Color. 
 
4. Contrast: The contrast between the Vein Color and Filler Color. 
 
5. Amplitude: A scaling fact applied to all values in the fractal noise about the 
average value. 

 
 
6. Ratio: Ratio controls the fractal 
noise frequency. 
7. Ripples: Ripples determines the texture‟s waviness in the X, Y, and Z 
directions. 
8. Depth: The minimum and maximum number of iterations used to calculate 
the texture pattern. Depth controls the texture‟s granularity. 
Rock 
Rock simulates rock using a random 3D distribution of two different grain material 
types. The options available are: 
1. Color1, Color2: The color of the two grains in the texture. 
2. Grain Size: Grain size specifies the grain size and scales the entire 
texture. 
3. Diffusion: Diffusion controls the amount Color1 blends into Color2. 
4. Mix Ratio: Mix ratio determines the dominant color. 
Snow 
Snow simulates snow on a surface. The available options are: 
1. Snow Color: The color of the snow on the top of the surface. 
2. Surface Color: The color of the surface on which the snow lies. 
3. Threshold: Threshold determines the maximum slope that holds snow. 
4. Depth Decay: The rate at which the snow color blends into the surface 
color. 
5. Thickness: The apparent depth of the snow. Thickness controls the 
opacity of the snow. 
Solid Fractal 
Solid Fractal represents a 3D random function with a particular frequency 
distribution. The available options are: 
1. Threshold: This is an offset factor applied to all values in the texture.
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2. Amplitude: Amplitude is the scaling factor applied to all values in the 
texture. 
3. Ratio: Ratio controls the frequency of the fractal noise. 
4. Frequency Ratio: This option determines the relative spacial scale of 
noise frequencies. If not a whole number, the fractal does not repeat at the 
UV boundaries. 
5. Ripples: Ripples determines the texture‟s waviness in the X, Y, and Z 
directions. 
6. Depth: The minimum and maximum number of iterations used to calculate 
the texture pattern. This parameter controls how fine grained the texture 
is. 
7. Bias: Values greater than zero result in a more contrasting fractal while 
values less than zero make it more flat and spiky. 
8. Inflection: This applies a kink in the noise function. This can be useful 
when creating puffy or bumpy effects. 
9. Animated: Turn on to animate the texture and access the Time and Time 
Ratio attributes. 
10. Time: Time determines the relative time scale of noise frequencies. 
11. Time Ratio: Default is equal to the Frequency Ratio setting, which means 
higher frequency noises move faster in direct proportion to the frequency. 
Stucco 
Stucco randomly disturbs the material by mixing two input attributes, Channel1 
and Channel2, to create an effect resembling stains or clouds. Stucco includes 
Normal Options attributes you can use to control the effect. The options available 
are: 
1. Shaker: Increase this value to add more detail to the default Shaker 
attribute setting. If used as a bump map, increase the value to increase 
the number of craters and valleys. 
2. Channel1, Channel2: The two channels through which information such 
as color values passes. You can also supply information to the channels 
using a three-channel (RGB) mapping. 
3. Normal Depth: This option controls the depth of the craters when the 
texture is used as a bump map. Increasing Normal Depth deepens the 
craters. 
4. Normal Melt: This option controls the softness of the crater edges when 
this texture is used as a bump map. Increasing Normal Melt softens the 
edges. Animate this texture to simulate a melting cratered surface. 
Wood 
Wood simulates wood by projecting a 2D pattern. This pattern consists of 
concentric ring layers defined by veins and filler. When you map the Wood 
texture to a surface, the surface seems to be carved out of wood. When you map 
it to several surfaces, they seem to be carved from a single block of wood. The 
options available are: 
1. Filler Color: The color of the space between veins. The vein color diffuses 
into the filler color. 
2. Vein Color: The vein color of the wood. The vein color diffuses into the 
filler color. 
3. Vein Spread: The amount of vein color that diffuses into the filler color. 
4. Layer Size: The average thickness of each layer or ring. 
5. Randomness: Randomizes the thickness of individual layers or rings.
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6. Age: The age of the wood (in years). This value determines the total 
number of layers or rings in the texture, and influences the relative 
thickness of central and outer layers. 
7. Grain Color: The color of the random grain in the wood. 
8. Grain Contrast: Grain contrast controls the amount of Grain Color that 
diffuses into the surrounding wood color. 
9. Grain Spacing: The average distance between grain spots. 
10. Center: The location of the center of the texture‟s concentric rings in the U 
and V directions. 
11. Amplitude X, Amplitude Y: An average scaling factor applied to all 
values in the fractal noise in the texture‟s X and Y directions. 
12. Ratio: Ratio controls the fractal noise frequency. 
13. Ripples: Ripples determines the texture‟s waviness in the X, Y, and Z 
directions. 
14. Depth: The minimum and maximum number of iterations used to calculate 
the texture pattern. This parameter controls how fine grained the texture 
is. 
Environment Textures 
Maya provides environment textures for use as backgrounds for your scene. 
Common Environment texture attributes 
Color Remap 
Color Remap applies a color map to the texture. It is the only common Effects 
Environment texture attribute. The U value of the Color Remap texture is mapped 
to the original texture‟s hue, and the V value is mapped to the original texture‟s 
intensity (the value defined by [R+G+B]/3). 
Env Ball 
Env Ball uses an image of a highly reflective chrome ball in an environment to 
recreate 
that environment. An Env Ball texture background renders faster than a 
procedural texture background or a background modeled with surfaces. You can 
therefore replace a complex background with an Env Ball texture to reduce 
rendering times. The options available are: 
1. Image: The texture used by the Env Ball texture. To use a single image of 
a highly reflective chrome ball in an environment, map a File texture to the 
Env Ball texture‟s Image attribute, and then specify an image file for the 
File texture‟s Image Name attribute. 
2. Inclination: The rotation of the ball image about the vertical axis. 
3. Elevation: The rotation of the ball image about the horizontal axis. 
4. Eyespace: Eyespace causes the position of the Env Ball texture‟s Image 
file to be defined relative to the window, not the camera view. 
5. Reflect: Reflect causes the Image file to be reflection mapped onto the 
background. 
6. Projection Geometry: The Projection Geometry attributes controls the 
appearance of reflections from an Env Ball texture. They define the 
location of the sky and, or room walls of the original environment so that 
Maya can calculate reflections on surfaces in the re-created environment. 
a. Sky Radius: The radius of the sky of the original environment. 
b. Bottom, Top, Left, Right, Front, Back: The distance between the 
reflective ball and each wall of the original environment. 
Env Chrome
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Env Chrome simulates a showroom environment. The texture consists of a plane 
and a sky plane, and provides a simple but effective environment to simulate 
reflections off chrome surfaces. The Environment Chrome Attributes control the 
size and placement of the simulated fluorescent lights in an Env Chrome texture. 
The options available are: 
1. Light Width, Light Depth: The width and depth of each light. These 
parameters also determine spacing between lights. 
2. Light Width Gain, Light Width Offset: The number of lights per unit 
length. 
3. Light Depth Gain, Light Depth Offset: This option defines the light 
displacement. 
4. Sky Color: The color of the sky at the horizon. Overall sky color is linearly 
interpolated between Sky Color and Zenith Color. 
5. Zenith Color: The color of the sky at the zenith. Overall sky color is 
linearly interpolated between Sky Color and Zenith Color. 
6. Light Color: The color of the simulated fluorescent lights. These “lights” 
produce reflections in surfaces, but they do not actually illuminate 
surfaces. 
7. Floor Color, Horizon Color, Grid Color: The color of the floor, the floor‟s 
horizon and the floor‟s grid. 
8. Real Floor: If Real Floor is off, the environment‟s floor is located at infinity, 
so reflections on moving objects and, or reflections viewed from a moving 
camera are incorrect. If Real Floor is on, the floor is located relative to the 
grid plane, so reflections on moving objects and, or reflections viewed 
from a moving camera are correct. 
9. Floor Altitude: The height of the floor relative to the grid plane. Floor 
Altitude has no effect if Real Floor is off. 
10. Grid Width, Grid Depth: The width and depth of the grid lines. These 
attributes also determine the spacing between grid lines. 
11. Grid Width Gain, Grid Depth Gain: The number of grid cells per unit 
length. 
12. Grid Width Offset, Grid Depth Offset: This option defines the grid 
displacement. 
Env Cube 
Env Cude simulates an environment by mapping six image files onto the inner 
surfaces of a large cube. Use Env Cube to make reflections on a moving surface 
during an animation if you do not have time to raytrace because it treats the 
texture placement box as the geometry of the environment. This means changes 
in the relative size and position of camera, surface, and environment are 
respected. The options available are: 
1. Infinite Size: When on, the images in the cube are reflected as though the 
sides of the cube were infinitely far away. If you are using images with 
distance, such as the horizon or a starfield, turn on Infinite Size. If the 
images are of the interior of a room, or nearby objects, leave Infinite Size 
off. 
2. Right, Left, Top, Bottom, Front, Back: The image files mapped to the 
right, left, top, bottom, front, and back inner surfaces of an infinite cube. 
Env Sky 
Env Sky simulates a planetary environment viewed from the surface of a planet. 
The options available are:
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1. Total Brightness: The overall brightness of the environment. 
2. Sun Brightness: The color and brightness of the sun. 
3. Halo Brightness: The color and brightness of the halo around the sun. 
4. Interactively adjusting Sun attributes: The following attributes relate 
directly to the Sky‟s texture placement object. You can use the Maya 
transform tools, such as Scale and Rotate to place the manipulator, or use 
the Show Manipulator tool. As you change the settings for Elevation, 
Azimuth, and Size attributes. 
5. Elevation: The angle of elevation of the sun relative to the floor. 
6. Azimuth: The angle of the sun in the sky about a vertical vector. 
7. Size: The size of the sun. 
8. Blur: The size of the halo around the sun. 
9. Sky Brightness: A scaling factor applied to the sky color. 
10. Air Density: The density of the air in the atmosphere. The denser the air, 
the more light is scattered. Air density represents low and high altitudes. 
11. Dust Density: The density of dust in the atmosphere. 
12. Sky Thickness: The thickness of the atmosphere. 
13. Sky Radius: The outer radius of the sky as a multiple of Sky Thickness. 
Sky Thickness and Sky Radius values determine the planet radius, and 
planet radius influences the appearance of sunsets. 
14. Has Floor: Turns the floor on or off. If Has Floor is off, the environment 
below the horizon is a mirror image of the environment above the horizon. 
15. Floor Color: The color of the floor. 
16. Floor Altitude: The height of the floor relative to the grid plane. 
17. Use Texture: This option controls whether or not Env Sky pays attention 
to the Cloud Texture attribute. 
18. Cloud Texture: The texture that determines cloud distribution in the sky. 
19. Cloud Brightness: The brightness and color of cloud illumination from 
ambient scattered light in the atmosphere. 
20. Sunset Brightness: The brightness and color of cloud illumination when 
the sun is below the horizon and the clouds are front lit. 
21. Density: The density of individual clouds. 
22. Threshold: A threshold value for the Cloud texture that controls how 
much of the sky is covered with cloud. 
23. Power: The clouds are scaled and positioned by adjusting the Power 
value. 
24. Altitude: The height of the clouds. It determines how much the 
atmosphere obscures the clouds near the horizon. 
25. Halo Size: The size of cloud illumination from direct back lighting by the 
sun. 
Calculation Quality 
The Calculation Quality attributes control the rendering speed of an Env Sky 
texture. The calculations required for curved atmospheres reduce speed. The 
Calculation Quality attributes do not greatly affect the appearance of the sky, but 
do affect the speed at which the calculations are computed. 
26. Sky Samples: The number of samples used above the cloud layer. 
27. Floor Samples: The number of samples used by the atmosphere 
between the eye and the horizon. 
28. Cloud Samples: The number of samples used below the cloud layer. 
Env Sphere
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Env Sphere simulates an environment by mapping a texture or image file directly 
onto the inner surface of an infinite sphere. The options available are: 
1. Image: The texture mapped to the inner surface of an infinite sphere. 
2. Shear U: Shears the Image texture in the U direction. 
3. Shear V: Shears the Image texture in the V direction. 
4. Flip: Flip reverses the U and V orientation of the Image texture. 
Utilities 
Bump 2d & 3d 
Bump 2d/3d converts a 2D/3D texture to bump map. The options available are: 
1. Bump Value: The source 2D/3D texture used for the bump map. You can 
connect the output of any shading network to Bump Value to use as the 
source of the bumps. 
2. Bump Depth: Bump Depth controls how high the bumps display on the 
surface. Increase Bump Depth to make the surface bumpier. 
3. Bump Filter: Bump filter affects the filtering level performed on a texture 
used as a bump map. 
4. Bump Filter Offset: This option affects the amount of filtering performed 
on a texture. 
5. Adjust Edges: Artifacts may display on texture boundaries when you map 
textures with the place2dtexture‟s Wrap U and Wrap V attributes turned 
off, using Adjust Edges removes these artifacts. 
Condition 
The condition utility in shader networks is capable of acting one way in one set of 
circumstances and another way in a different set of circumstances. Condition 
produces a color value depending on the conditions you set. It requires one 
logical operator and two choice values. It is similar to "IF" statement. The 
available options are: 
1. First Term: First term represents the first term of the condition. 
2. Second Term: Second term represents the second term of the condition. 
3. Operation: options option displays a drop-down list from which you can 
select an operator. The operators include: Equal, Not Equal, Greater 
Than, Greater or Equal, Less Than, Less or Equal. 
4. Color If True: The color or texture that is output when the condition is 
true. 
5. Color If False: The color or texture that is output when the condition is 
false. 
2d Placement 
2D placement defines a texture frame—a rectangular area on a surface in which 
the texture appears. You can control the position, size, and rotation of this frame 
on the surface. You can also control how the texture is tiled within the frame. The 
available options are: 
1. Interactive Placement: This option displays the texture placement 
manipulator. 
2. Coverage: Coverage specifies what ratio of the surface the texture map 
cover 
3. Translate Frame: The Translate attributes position the texture map on the 
surface and move the coverage area across the surface. 
4. Rotate Frame: Rotates the texture map on the surface. 
5. Mirror U, V: Only works when U Repeat or V Repeat attributes are greater 
than 1. Mirror in the U and V direction separately.
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6. Stagger: Maya offsets repeats of maps making alternate rows of repeats 
offset exactly by half. 
7. Wrap U, Wrap V: Wrap U and Wrap V attributes control whether a map is 
repeated in U or V directions, or both U and V. 
8. Repeat UV: This option specifies how many copies of the texture map are 
mapped within the coverage area along either the U or V directions. 
9. Offset: Offsets the pattern of the texture map. 
10. Rotate UV: You can not rotate surface placement with the interactive 
placement tool. So, you can use rotate UV to rotate. 
11. Noise UV: 2D noise for U and V. Displaces the colors of the texture map. 
12. Fast: Turn fast on to slightly improve rendering speed. 
3D Placement 
A 3D placement node defines a 3D texture or Environment texture‟s positioning 
and orientation in world space. 3D placement nodes make it easier to texture 
multiple surfaces as if they were one. Maya provides two methods to place 3D 
textures on NURBS surfaces—Interactive Placement or Fit to group bbox 
(Bounding Box). Select the method most suitable for your needs. When you 
create a 3D texture or project a texture onto an object, a cube-shaped icon 
appears in the scene that corresponds to the size, scale, and location of the 
texture on the surface. Especially for animated or deforming objects, you must 
maintain the correct positioning of the texture on the object. Options are same for 
2D and 3D texture placement utilities. 
Projection 
Projection turns any 2d texture into a 3d texture you can place on the surface 
using one of the available projection types. Use to adjust the texture placement 
on the surface. The options are: 
1. Interactive Placement: This option displays the Projection manipulators 
in the scene view. 
2. Fit To BBox: The texture map coincides with the bounding box of the 
mapped object or set. 
3. Proj Type: Select a projection type from the drop-down list to display 
seven projection manipulators. 
a. Off: Uses no projection type. 
b. Planar: Default Proj Type. Places the texture on a planar surface 
and projects it onto the object. 
c. Spherical: Places the texture inside a sphere and projects it onto 
the object. 
d. Cylindrical: Places the texture inside a cylinder and projects it onto 
the object. 
e. Ball: Places the texture inside a ball and projects it onto the object. 
f. Cubic: Defines the projection surface as a box. Maya places 
images on each plane and projects them onto the object. 
g. Triplanar: Extrudes the texture along the axis defined by the 
maximum direction of the surface normal. The texture is projected 
much like fabric pulled around an arc. 
h. Concentric: Projects a vertical slice of the texture from the inside 
to the outside edge of the voxel. The vertical slice used is randomly 
chosen for each voxel. A voxel is a 3D version of a rectangle—a 
voxel grid is a series of 3D cubes that line up to form a bigger cube. 
i. Perspective: Integrates 3D elements with a background image or a
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live action sequence. 
4. Image: The 2D texture to be used as a map. 
5. U angle: This option changes the U angle (For spherical and cylindrical 
mapping only). 
6. V angle: This option changes the V angle (For spherical mapping only). 
7. Link To Camera: The drop-down list contains a list of the perspective 
cameras in the scene. 
8. Fit Type: This option Controls how the texture fits to the camera when 
Proj Type is Perspective. Select from the following: 
a. None: The image is not squeezed or stretched to fit. 
b. Match Camera Film Gate: It squeezes the image to fit the film 
gate. 
c. Match Camera Resolution: If you use this to match a backdrop, 
match these settings to the settings in the Image Plane. 
9. Fit Fill: Only available if Proj Type is Perspective and Fit Type is None. 
Reverse 
Reverse reverses effect of the connected node. If the nodes‟ output value is 
white, it will reverse it into black and so. 
Sampler Info 
Sampler Info provides you with information about each point on a surface as it is 
being sampled, or calculated, for rendering purposes. Sampler Info can give you 
information about a point‟s position in space, its orientation and tangency, and its 
location relative to the camera. Many of the attributes for this node provide 
values in camera coordinate space, the local object space of the camera. The 
options available are: 
1. Point World: This option provides the position currently being sampled 
relative to the X, Y, and Z-axis of the world. 
2. Point Obj: This option provides the position currently being sampled 
relative to the X, Y, and Z-axis of the object. 
3. Point Camera: This option provides the point of the object being shaded. 
4. Normal Camera: This option provides the orientation of a face relative to 
the camera. 
5. Uv Coord: This option provides the UV coordinates of a point to be 
shaded. The convention is that UV coordinates are measured from (0, 0) 
to (1, 1). 
6. Ray Direction: This indicates the direction in which the current point is 
seen from the camera. Use this attribute in materials for objects to provide 
the direction towards the camera for every pixel in the object. 
7. Tangent UCamera, Tangent VCamera: This option sets the surface 
tangents in camera space. 
8. Pixel Center: This option provides Pixel Center X and Pixel Center Y. The 
result depends on the image, not on the geometry. 
9. Facing Ratio: This option produces a value that varies between 0 and 1 
depending on the angle between the surface normal and view direction. 
10. Flipped Normal: The flipped normal attribute indicates if the surface 
normal is flipped which also tells you which side of the surface Maya is 
shading. 
Stencil 
Stencil maps any image input onto an object. You can mask the input image to 
control how it covers a surface, to overlay different textures and control what
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parts of the texture are visible, or to label map a surface. The options available 
are: 
1. Image: The texture that is used as a stencil. 
2. Edge Blend: Edge Blend controls the sharpness of the texture edges. The 
default Stencil‟s color is the color of the edge blend. Increase this value to 
blend edges softly. 
3. Mask: Mask represents the Stencil‟s transparency. Use to control the 
overall transparency of the entire texture. 
4. Key Masking: This option enables or disables Chroma Key masking. 
5. Positive Key: Inverts the chroma key mask. 
6. Color Key: The color to be masked in the texture. 
7. Threshold: This option controls the point at which the color state 
changes. 
Blend Colors 
Blend colors utility blends two input values using a mixer. You use a mask to 
determine where to put two materials placed on an object. The options available 
are: 
1. Blender: Blender controls how much of each of the input colors mixes into 
the final Output. 
2. Color1/Color2: Color1 and Color2 are the first and second input colors. 
Switch Utilities 
Switch utilities let you apply textures to different patches that make up one 
object. Several objects can share shading characteristics and you can define 
unique characteristics on an object-by-object basis using Maya‟s Switch utilities. 
Single Switch 
Single switch connects only to a single value node, nodes which are controlled 
by a single value like Bump, Reflectivity etc. The options available are: 
1. Add Surfaces: This button adds all the shapes on which that material is 
applied in inshape column. 
2. inShape: This column contains the name of the shape you want to 
connect to the Single Shading Switch utility. You can add as many objects 
as you want to this column. 
3. inSingle: This column contains the texture, file, or placement node that 
you want to map to the object. 
4. Remove Item: This button removes the currently selected row in the 
Switch table. 
5. Map Item: You can use the Map Item button to select a texture, file, or 
placement node to map it to the object. 
Double Switch 
Double switch connects to a double value node, nodes which are controlled by a 
two value like Repeat UV, Offset, and Rotate UV etc in 2D placement. The 
options are similar to that of Single Switch. 
Triple Switch 
Triple switch connects to a triple value node, nodes which are controlled by a 
three value like all color nodes, nodes in 3D placement etc. The options are 
similar to that of Single Switch. 
Quad Switch 
Quad switch connects to a triple value node and single value node or a quad 
node. The options are similar to that of Single Switch. 
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Connection Editor 
This editor is useful for fine-tuning a shading network. Use it to make non-default 
connections, to traverse nodes to view their inputs or outputs, or to make 
connections going in either direction of the network. Connection Editor is also 
known as parameter wiring in other software like 3DS Max. The Connection 
Editor, however, is the best tool for fine-tuning a shading network and for making 
non-default connections. The Connection Editor shows node network information 
in a side-by-side layout so that you can view two connected nodes in a node 
network. You can quickly and easily traverse from node to node and show a 
node‟s outputs or inputs. Connected attributes in the Connection Editor appear in 
italics, while non-keyable attributes appear dimmed. Some dimmed attributes 
indicate a nested list of attributes. 

 
 
Texture-mapping NURBS surfaces: This is a Projection map kind of option. 
This option is available in the utilities panel. 
Here you can create a projector kind of effect like a light with a map falls on the 
object. It is very useful in creating 3D effects on any object just by applying the 
same in the projector map in the lights. Here are the options you find in it. 
1. Interactive Placement: It displays the Projection manipulators in the scene 
view. 
2. Fit To Bbox: It makes the map fit to the bounding box of the object. 
You can select a projection type from the drop-down list to display seven 
projection manipulators. 
 
Here the Projector Types are: 
1. Planar: Default Proj Type. Places the texture on a planar surface and 
projects it onto the object.
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2. Spherical: Places the texture inside a sphere and projects it onto the object. 

 
3. Cylindrical: Places the texture inside a cylinder and projects it onto the 
object. 

 
4. Ball: Places the texture inside a ball and projects it onto the object. For 
example, Maya projects the texture as if a candy wrapper is pulled around a 
lollipop. There is one pinch point to the mapping at the -z-pole, as opposed to 
the two pinch points at the +y and -y poles in spherical and cylindrical 
mapping. 

 
5. Cubic: Defines the projection surface as a box. Maya places images on each 
plane and projects them onto the object. 

 
6. Triplanar: Extrudes the texture along the axis defined by the maximum 
direction of the surface normal. The texture is projected much like fabric 
pulled around an arc.
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7. Concentric: Projects a vertical slice of the texture from the inside to the 
outside edge of the voxel. The vertical slice used is randomly chosen for each 
voxel. A voxel is a 3D version of a rectangle—a voxel grid is a series of 3D 
cubes that line up to form a bigger cube. 

 
8. Perspective: Integrates 3D elements with a background image or a live 
action sequence. 
Combining materials: You can combine the materials by using the Hypershade 
option given in Utilities > Hypershade or Hypershade from the render menu. 
Here the options are given to combine two, three, four materials together and use 
them. 
Texturing polygons: You can apply textures on the polygons by right click on 
the object in the view port and assign the material. Here you can use the bump, 
specular etc materials and modify them. 
 
Photoshop 
Here we will see how to make different kind of materials in Photoshop for use in 
MAYA materials, like face maps, unwrap maps for objects, hands of the 
character. This is very useful for gaming for decreasing the file size. 
Down is given a method of making a map for a face which is unwrapped. 
Here you need one person‟s photograph from front side, left or right side and a 
perspective side but the proportion of all must be same as we are going to merge 
them. You can collect more photographs from more sides for the better result. 
You can have photographs like the followings: 
 

 

 
Front photograph
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Side pose 

 

 

 
Perspective pose 
 
Take a new file. Arrange all the front, side and perspective photographs in three 
different layers and put guidelines to arrange them in proportion. Here in the 
following images it is shown how to put the guidelines for a better proportion. 

 
 
Then arrange the images as the following one by one and set them in proportion 
by using the guidelines. Like in the following picture: 
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After setting all the front, side and perspective view start merging the layers. 
First delete the unwanted areas from the layers and try to merge the face‟s front, 
side and perspective views. 
Now, You can start merging the views by using the stamp tool, selection tool etc. 
It is depended with which tool you are comfortable to work. While merging the 
face images take care of the proportions and shades of the face from all the 
sides. 
Photoshop 
Now, After mergin the pictures of all the sides like front, side and perspective you 
will have to make the part of fore head and neck also. 
Here you can use the following images or poses. 

 
Fore head pose 

 
Pose from down for neck
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By using these poses it will become easy to make a good unwrapped map for a 
face of the same character. While merging the pictures of different sides you will 
have to merge the layers as per requirement. 
At the end you will find the file like the following one. 

 
This map is an open map for the same character‟s face. 
Here if you are making a map for a character who belongs to the fantasy 
category like not existing In the world then you can unwrap the map from MAYA 
unwrap and take a snap shot from it then bring the image to Photoshop and paint 
it as you want it to look. Again take it to MAYA and apply it on the face of the 
character. 
Here you can create the textures for hands, legs etc in Photoshop by merging the 
images or painting them and use them. 
The same technique can be used for making the maps of faces for any cartoon 
character by using the sketch of it by arranging them in the same way and 

painting them as you want the colours of the character. 

 
 

 

2.3.8 UVs 
UV texture space is another coordinate system in 3D and it is used for mapping textures 
on surfaces and UVs are points that provide the information needed to apply textures to 
the surface. Subdivision surfaces and polygons require specific arrangement of the UVs
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so that textures look correct when applied to the surface material. Typically, you arrange 
UVs after you have completed your modeling and before you assign textures to the 
model. UVs act as marker points that control which points (pixels) on the texture map 
correspond to which points (vertices) on the mesh. You can see the texture space 
coordinates in UV Texture Editor. 

 
Mapping 
UV mapping is a process whereby you create, edit, and otherwise arrange the UVs that 
appear as a flattened, two-dimensional representation of the surface mesh, over top of 
the two-dimensional image to be used as a texture as it appears in the UV Texture 
Editor. UV mapping is a critical skill to master for accurate and realistic textures on 
polygonal surfaces. In Maya, UV texture coordinates (UVs) can be created for polygon 
surface meshes using the following UV mapping techniques: 
1. Automatic UV mapping 
2. Planar UV mapping 
3. Cylindrical UV mapping 
4. Spherical UV mapping 
5. User-defined UV mapping 
6. Camera UV mapping 

Automatic UV mapping 
Automatic mapping creates several UV 
map pieces or shells in texture space by 
attempting to find the best UV placement by simultaneously projecting from multiple 
planes. 

 
Planar UV mapping 
Planar mapping projects UVs onto a mesh through a plane. This type of mapping 
is best suited for planer objects. 
Figure 0083 
Cylindrical UV mapping 
Cylindrical mapping creates UVs for an object based on a cylindrical projection 
shape that gets wrapped around the mesh. This type of mapping is best suited 
for cylindrical objects. 
Figure 0084 
Spherical UV mapping 
Spherical mapping create UVs using a projection that is based on a spherical 
shape wrapped around the mesh. This type of mapping is best suited for 
spherical objects. 
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User-defined UV mapping 
User-defined UV mapping is same as the automatic mapping. The only 
difference is that in user-defined you can map UV texture coordinates by 
specifying user-defined planes for UV projection using the Load Projection 
option. 
Camera UV mapping 
The camera UV mapping creates a Planar UV mapping. The current camera 
view plane is used as the plane for the planar projection. 
UV Texture Editor 
The UV Texture Editor lets you interactively edit UV texture coordinates for 
polygons and subdivision surfaces. You can select, move, scale, and generally 
modify the UV topology for a surface. You can also view the image associated 
with the assigned texture map as a backdrop within the UV Texture Editor and 
modify the UV layout to match as required. 
UV Toolbar 
UV Lattice Tool 
This tool is used to manipulate the layout of UVs as a group by letting you create 
a lattice around the UVs for deformation purposes. 
Move UV Shell Tool 
Move UV Shell tool lets you select and reposition a UV shell by selecting a single 
UV on the shell. 
UV Smudge Tool 
UV Smudge Tool moves the position of selected UVs and their neighboring UVs. 
Select Shortest Edge Path Tool 
The Select Shortest Edge Path Tool determines the most direct path between 
any two selection points and selects the polygon edges in between. 
Flip U 
It flips the positions of the selected UVs in the U direction. 
Flip V 
It flips the positions of the selected UVs in the V direction. 
Rotate UVs counterclockwise 
It rotates the positions of the selected UVs by 45 degrees in a counterclockwise 
direction. 
Rotate UVs clockwise 
It rotates the positions of the selected UVs by 45 degrees in a clockwise 
direction. 
Cut UVs along selection 
This tool separates UVs along the selected edges, creating borders. 
Split UVs 
This tool separates UVs from each other along the edges connected to the 
selected UV points, creating borders. 
Sew UVs
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Attaches UVs along the selected borders, but does not move them together in 
the texture editor view. 
Move and Sew UVs 
Attaches UVs along the selected borders, and moves them together in the 
texture editor view. 
Layout 
This tool attempts to arrange the UVs into a cleaner layout. 
Grid UVs 
This tool moves every selected UV to its nearest grid intersection in editor 
window. 
Unfold 
Unfold unwraps the selected UV mesh while attempting to ensure that the UVs 
do not overlap. 
Relax 
Relax spreads out the selected UV mesh to make it easier to work with. 
Align Min U 
This tool aligns the positions of the selected UVs to the minimum U value. 
Align Max U 
This tool aligns the positions of the selected UVs to the maximum U value. 
Align Min V 
This tool aligns the positions of the selected UVs to the minimum V value. 
Align Max V 
This tool aligns the positions of the selected UVs to the maximum V value. 
Toggle Isolate Select Mode 
This tool switches between showing all UVs and only the isolated UVs. 
Add selected to isolation 
This tool adds the selected UVs to the set of isolated UVs. 
Remove selected from isolation 
This tool removes the selected UVs from the set of isolated UVs. 
Remove all 
This tool clears the isolated subset. 
Display Image 
Display Image tool shows or hides the texture image in the editor window. 
Toggle Filtered Image 
This tool switches the background image between hardware texture filtering and 
sharply defined pixels. 
Dim Image 
This tool reduces the brightness of the currently displayed background image. 
View Grid 
View Grid option displays or removes the grid. 
Pixel Snap 
If this is on, UVs automatically snap to pixel boundaries. 
Shade UVs 
This tool shades selected UV shells in a semi-transparent fashion so you can 
determine areas where UVs overlap. 
Toggle Texture Borders 
This option toggles the display of texture borders on UV shells. 
Display RGB Channels 
This option displays the RGB channels of the selected texture. 
Display Alpha Channel
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This option displays the Alpha channel of the selected texture. 
UV Texture Editor Baking 
This option bakes the texture and stores it in memory. 
Update PSD Networks 
This option updates or refreshes the PSD textures currently in use for the scene. 
Force editor texture rebake 
This option rebakes the texture after you make changes to the textures. 
Use Image Ratio 
If this is on, the texture will be shown in its aspect ratio. 
Create UVs > 
Create UVs based on Camera 
Creates UV texture coordinates for the selected object based on the current 
camera view as a planar projection. That is, the camera view becomes the plane 
of projection. 
Best Plane Texturing Tool 
Assigns UVs to the faces you select based on a plane computed from vertices 
you specify. 
Assign Shader to each Projection 
When Assign Shader to each Projection is turned on, a shader with a 
checkerboard texture is assigned to the selected mesh as you project UV texture 
coordinates. This aids in determining the alignment of the UVs by providing a 
known visual reference. The default setting is off. 
Create Empty UV set 
Creates a new, empty UV set on the current object. You can then create the UVs 
in the set using one of the mapping/projection methods. This feature is also 
available for use from the Polygons menu in the UV Texture Editor. 
Copy UVs to UV set 
Creates a new UV set based on an existing UV layout or transfers a UV layout 
from one set to another. This feature is also available for use from the Polygons 
menu in the UV Texture Editor. 
Set Current UV set 
Lets you specify which UV set you want to use for a particular polygon mesh. 
You specify which set you want by typing the name of the UV set in the text field 
that appears. This feature is also available for use from the Polygons menu in the 
UV Texture Editor. 
Rename Current UV set 
Lets you rename the currently selected UV set. This feature is also available for 
use from the Polygons menu in the UV Texture Editor. 
Delete Current UV set 
Deletes the currently selected UV set. This feature is also available for use from 
the Polygons menu in the UV Texture Editor. 

 

2.2.9 Edit UVs > 
Normalize 
Normalize command normalizes the UV texture coordinates. The following 
options are available in the option box. 
1. Collectively: This option will set the UV coordinates of all the selected 
faces between 0 and 1.
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2. Each face separately: This option will set the UV coordinates of each 
selected face between 0 and 1. 
3. Preserve the aspect ratio: If this options is on, the UVs scale 
proportionally to the image. 
Unitize 
Unitize repositions the UVs of the selected faces on the boundary of the UV 
texture space as they appear in the UV Texture Editor. 
Flip 
Flip command flips the UVs horizontally or vertically. 
Rotate 
Rotate command rotates the UVs. You can provide the rotate angle in the option 
box. 
Grid 
Grid command snaps the selected UVs to the specified grid. 
Align 
Align command aligns the selected UVs to the min/max U or min/max V 
Warp Image 
Warp image modifies a texture image by comparing two UV sets on a single 
polygonal mesh and produces a new bitmap image. 
Map UV Border 
Map UV Border repositions border UVs on a selected UV shell to a square or 
circle within the 0 to 1 range of the UV texture space. Map UV Border is useful 
for untangling borders before you use Relax UVs to untangle interior UVs. The 
available options are: 
1. Border target shape: This option select the shape type that you want to 
map the UV border to Square or Circle. 
2. Automatic: If this option is on, it will map the UV border automatically in a 
shape that approximates the best texture space while maintaining the 
world-space relationships between edges. 
3. Preserve original shape: Preserve original shape determines how 
closely the border mapping will match the selected Border Target Shape. 
Straighten UV Border 
Straighten UV Border untangles the border of the currently selected UV shell, 
such as an edge that loops around itself. The available options are: 
1. Curvature: This option pushes the selected border area outward or 
inward by the specified amount. 
2. Preserve length ratio: This option controls the size of UV texture edges 
when straightened. 
3. Blend original shape: This option affects the shape of the straightened 
border by blending it with the original border shape. 
4. Fill gaps in selection: The Fill gaps in selection options helps you 
straighten UVs that are missing from your selection. 
Layout 
Layout repositions the UV shells for selected objects so their arrangement is 
improved. The options available are: 
1. Layout Multiple Objects: 
a. Overlapping: When multiple objects are selected in the scene this 
option specifies to lay out the UV shells for each object individually 
within the UV Texture Editor. 
b. Non-overlapping: This option specifies the multiple UVs to be
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positioned in the UV Texture Editor as if it were one single object. 
2. Separate Shells: This option specifies how you want to cut and separate 
overlapping UV shells. 
3. Flip reversed: Flips UV shells that have normals pointing in opposite UV 
winding order. 
4. Shell Layout: This option specifies where the UV shells will lie in UV 
texture space. 
5. Scale mode: You can choose the way, how you want the UV shells 
scaled within the UV texture space with this option. 
6. Shell stacking: Shell stacking determines how the UV shells get stacked 
in relation to each other when laid out in the UV Texture Editor. 
7. Rotate: Rotate allows the UV texture shells to be rotated in order to better 
fit the UV texture space. 
8. Spacing presets: You can specify a spacing preset to ensure that there is 
at least one pixel separating the individual UV bounding boxes. Select a 
preset that corresponds to your texture map size. 
9. Percentage space: When the Spacing presets is set to Custom you can 
specify a distance measurement to specify the space between bounding 
boxes as a percentage of the map size. 
UV Linking 
UV Linking is used to link different nodes like textures, paint effects, hair and fur 
to UV sets using relationship editor. 
Texturing Using Painting Tools: Maya‟s paint tools work like paint brushes, 
providing you with an intuitive, efficient way to change the properties of your 
objects or create various effects. 
Maya has three types of paint tools: Paint Effects is a unique paint technology 
that lets you paint strokes on a 2D canvas to create 2D images or textures, or to 
paint strokes in a scene to create paint effects in 3D space. 
1. Maya Artisan paint tools: Artisan tools let you manipulate your geometry in 
a more artistic manner by allowing you to paint their values and properties
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with the brush tool.  
Artisan uses the Maya Tool Settings editor to set tool properties. All Artisan 
tools share common options, which are described in Common Artisan Brush 
Tool Settings. 
For each Artisan tool, the Tool Settings editor contains a section with settings 
that are specific to that tool. 
2. Maya Paint Effects Tool: Paint Effects is a component of Maya used to 
quickly and easily paint brush strokes and particle effects on a 2D canvas or 
on or between 3D geometry. 

 
You can use Paint Effects as a traditional paint program to paint images on a 
canvas, or to paint repeatable textures that you can apply to geometry in your
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scenes. 
Paint Effects goes beyond traditional painting as you can paint entire particle 
effects on your canvas or scene with a single brush stroke. On a 2D canvas a 
single brush stroke can produce complex images, for example trees or 
flowers or fire. In your scene, that same brush stroke produces these entities 
three-dimensionally. Imagine being able to paint an orchard in your scene 
where the painted trees exist as objects that your characters can move 
around. You can also apply dynamic forces to the effects you paint in your 
scenes and animate the display and movement of the effects. For example, 
you can make plants grow, make long hair blow in the wind, or make a river 
flow. 
You can get immediate high-quality feedback by rendering brush strokes 
while you paint. Paint Effects strokes render seamlessly with the rest of your 
scene during a post process in the final render. 
3. 3D Paint Tool: 
While dragging the Paint Effects Tool, Paint Effects creates a curve and attaches 
a stroke and new brush to it which define the appearance and behaviour of the 
paint applied along the stroke path. 
Whether you paint in the scene view or the scene painting view, you can paint 
strokes on the grid plane of the perspective view, directly on objects, and on the 
view plane. 

 
When you paint in the scene view, simple strokes display as curves. Strokes with 
tubes display as wire frame representations of the rendered stroke. Paint is not 
applied to the strokes until you do a post-process render, which makes painting 
in the scene view very quick. It provides immediate feedback in enough detail to 
see what you‟re doing. To improve redraw speed, you can adjust the display 
quality of the wireframe strokes, just as you can adjust the display quality of 
objects displayed as wireframe. Paint in the scene view when speed is an issue, 
but the final appearance of the strokes is not. 
 
 
Render strokes as you paint: 
 
To preview the rendered look of the strokes as you paint, click on the Draw as
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Mesh option in the Paint Effects panel.  
Alternatively, you can render the strokes as you paint them in the Paint Effects 
scene painting view. The scene painting view is a snapshot of the scene view. 
You can zoom, tumble, track, and dolly this view, and the scene painting view will 
update accordingly. You can render all the Paint Effects strokes or render them 
individually. 
Paint in the scene painting view when you need to see what the strokes look like, 
but you don‟t want to do a final render. You cannot use the transform tools, or 
any tools for Modeling in this view. Although you can select objects in the scene 
painting view and transform them in the Attribute Editor or Channel Box, it is best 
to use the scene view for non-painting tasks. 
To display the scene painting view: 
On the view menu bar, select Panels > Panel > Paint Effects to open the Paint 
Effects panel. The Paint Effects Tool is automatically selected. 
Select Paint > Paint Scene. The Paint Effects scene painting view displays. 
3D Paint tool provides you more facilities to work in different styles like 
followings: 
1. Paint on the grid plane of the perspective view: While painting on the grid 
of the perspective view, the stroke lies on that plane. 

 
2. Paint on objects: To paint on NURBS or polygonal objects, you must first 
make the objects paint able. When you paint directly on a paint able object, 
Paint Effects creates a curve on the surface along the stroke path and 
attaches the stroke and new brush to it. While translation of the object, the 
stroke moves with it. Also, you can offset the brush from the surface. 
While painting, the stroke does not leave the surface unless you paint over
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another object that is paintable. If you do paint across another paintable object 
during the stroke, the stroke will continue on the other object, bridging the two 

objects.  
3. Paint on the view plane: You can paint on the view plane in the scene 
painting view not the scene view. When you paint on the view plane in the 
scene painting view, each stroke renders on the view plane, as you would 
expect. However, the wire frame representation of each stroke displays 
between 0 and 1 in world space on the XY plane (near the origin). Although 
the wireframe representation of the strokes appear to overlap in this area, the 
rendered strokes display where you painted them. 

 
4. Reverse surface normals: When you paint a stroke on a paint able object, 
the tube growth is relative to the surface normal. You may find yourself 
painting on surfaces with reversed normals, In which case the tubes will grow 
in the opposite direction. 
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2.3 Assignment 

1. Facial Animation 
2. Photoshop Texture Room 
3. Unwrapping Head 
4. Texture Head 
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UNIT 3  Light 

 

 

 

Time Required to Complete the unit 

 

The time required to study thus Unit is broken as follows 

1. 1st Reading: It will need 2 Hrs for reading a unit 

2. 2nd Reading with understanding:  It will need 3 Hrs for reading and understanding a unit 
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1. Self Assessment:  It will need 3 Hrs for reading and understanding a unit 

2. Revision and Further Reading: It is continuous process 
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ROLE OF SELF INSTRUCTIONAL   MATERIAL INDISTANCELEARNING 

 

The need to plan effective instruction is imperative for a  

Successful distance teaching repertoire. This is due to the fact that the instructional 

designer, the tutor, the author (s) and the student are often separated by distance and may 

never meet in person. This is an increasingly common scenario in distance education 

instruction. As much as possible, teaching by distance should stimulate the student’s 

intellectual 

Involvement and contain all the necessary learning instructional activities ties that are 

capable of guiding the student through the course objectives. Therefore, the course / self-

instructional material are completely equipped with everything that the syllabus prescribes. 

To ensure effective instruction, a number of instructional design ideas are used and these 
help students to acquire knowledge, intellectual skills, motor skills and necessary attitudinal 
changes.  In this respect, 

Students ‘assessment and course evaluation are incorporated in the text. 



 

 

The nature of instructional activities used in distance education self- instructional materials 

depends on the domain of learning that they reinforce in the text, that is, the cognitive, 

psychomotor and affective. These are further interpreted in the acquisition of knowledge, 

intellectual skills and motor skills. Students may be encouraged to gain, apply and 

communicate (orally or in writing) the knowledge acquired. Intellectual- skills objectives may 

be met by designing instructions that make 

use of students’ prior knowledge and experiences in the discourse as the foundation on 

which newly acquired knowledge is built. 

The provision of exercises in the form of assignments, projects and tutorial feedback is 

necessary. Instructional activities that teach motor skills need to be graphically demonstrated 

and the correct practices pros vided during tutorials. Instructional activities for inculcating 

change in attitude and behavior should create interest and demonstrate need and benefits 

gained by adopting the required change. Information on the adoption and procedures for 

practice of new attitudes may then be introduced. 

 

 

Teaching and learning at a distance eliminates interactive  

Communication clues, such as pauses, intonation and gestures, associated with the face-

to-face method of teaching. This is particularly so with the exclusive use of print media. 

Instructional activities built into the instructional repertoire provide this missing 

interaction between the student and the teacher. Therefore, the use of instructional 

activities to affect better distance teaching is not optional, but mandatory. 

Our team of successful writers and authors has tried to r e d u c e  

This. Divide and to bring this Self Instructional Material as the b e s t  

teaching and communication tool. Instructional activities are varied in order to assess 

the different facets of the domains of learning. 

Distance education teaching repertoire involves extensive use of self- instructional 

materials, be they print or otherwise. These materials are designed to achieve certain 

pre-determined learning outcomes, namely goals and objectives that are contained in an 

instructional plan. Since the teaching process is affected over a distance, there is need to 

ensure that students actively participate in their learning by performing specific tasks 

that help them to understand the relevant concepts.  

Therefore, a set of exercises is built into the teaching repertoire in order to link what 

students and tutors do in the framework of the course outline. 

These could be in the form of students ‘assignments, a research project 



 

 

or a science practical exercise. Examples of instructional activities in distance education 

are too numerous to list. Instructional activities, when used in this context, help to 

motivate students, guide and measure students’ performance (continuous assessment) 

 

 

 

 

 

 

 

 

 

 

 

 

PREFACE 

 

 

We have put in lots of hard work to make this book as user-friendly as possible, but we 

have not sacrificed quality. Experts were involved in preparing the materials. However, 

concepts are explained in easy language for you. We have included many tables and 

examples for easy understanding. 



 

 

We sincerely hope this book will help you in every way you 

Expect. 

All the best for your studies from our team! 

 

 

 

 

 

 

All the best for your studies from our team! 

  



 

 

 

3.1 Introduction 

Light can be defined as something that makes things visible. It is the sensation 
produced by stimulation of the organs of sight. In Maya also, Lights are used to 
Illuminate the objects and cast shadows in the scene. Maya provides you 
different type of lights to simulate different type of light sources. The available 
lights are: 
1. Directional Light 
2. Ambient Light 
3. Point Light 
4. Spot Light 
5. Area Light 
6. Volume Light 

3.1.2 Lighting Types 

Directional Light 
Directional Light simulates the distant light source i.e. light coming from infinite.
The directional light rays are parallel. The attributes for directional light are: 
1. Intensity: Intensity represents the brightness of the light. 
2. Color: Color determines the light’s color. You can also map a texture on 
the color. 
3. Cast Shadows: Turn this option on, if you want to generate shadows. 
Shadows bring realism in the rendered scene. Shadows are of two types: 
Depth maps and Ray Traced. 
a. Depth Map Shadows: A depth map represents the distance from a 
specific light to the surfaces the light illuminates. Each pixel in the 
depth map represents the distance from the light to the nearest 
shadow casting surface in a specific direction. Depth map shadows 
produce very good results, with marginal increase to rendering 
time. 
b. Ray traced Shadows: Raytracing is a type of shadow rendering 
where the path of individual light rays is calculated from their 
source to their destination. Use raytraced shadows to produce 
more physically accurate shadows like those in the real world. 
Raytraced shadows can produce soft and transparent shadows but 
can be very time consuming. 
4. Shadow color: Shadow color determines the Color of the shadow. You 
can also map textures to shadows to create interesting effects. 
5. Interactive Placement: If this option is on, you will be automatically 
looking through the directional light upon its creation. 
6. Emit Diffuse and Emit Specular: Turn Either Emit Diffuse or Emit 
Specular or both on to create the respective shadings. 
 



 

 

 
Note: In Maya, most of the light attributes are common 
 
Ambient light 
An ambient light works in two ways: some of the light shines evenly in all 
directions from the location of the light, and some of the light shines evenly in all 
directions from all directions. Use an ambient light to simulate a combination of 
direct light and indirect light. Ambient lights produce only raytraced shadows. The 
attributes of Ambient light are: 
1. Ambient Shade: Ambient shade is the proportion of directional light to 
ambient light. 
2. Shadow Rays: Shadow Rays controls the graininess of shadow edges. 
Low values produce grainy shadows at the edges but takes less time to 
render. 
Point Light 
Point light emits light in all direction from the location of the light. Point light can 
represent a light bulb or a star. The attributes of point light are: 
1. Decay Rate: Decay Rate controls how the light’s intensity decreases with 
distance. Following options are available: 
a. No Decay: If this is set, the light will reach every object. 
b. Linear: If this is set, the light intensity decreases linearly with 
distance. 
c. Quadratic: If this is set, the light intensity decreases proportionally 
with the square of distance. In the real world light decays with the 
quadratic rate. 
d. Cubic: If this is set, the light intensity decreases proportionally with 
the cube of distance. 
 
Spot Light 
A spot light projects a beam of light evenly within a cone. You can adjust the 
softness of the light to create or eliminate the harsh circle of projected light. You 
can also project image maps from spot lights. The attributes of the spot light are: 
1. Cone Angle: Cone angle is the angle from edge to edge of the spot light’s 
beam. 
2. Penumbra Angle: Penumbra Angle is the angle from the edge of the 
spot light’s beam over which the intensity of the spot light falls off linearly 
to zero. 
3. Dropoff: Dropoff controls the rate at which light intensity decreases from 
the center to the edge of the spot light beam. 
 
Area Light 
Area Light simulates light coming from a window or a reflection from mirror or 
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window. The area lights takes longer to render but produce good results. The 
area light behaves like point light the deference between the two is that the area 
light uses a rectangular surface to emit light and it emits light from one face of the 
rectangle. The attributes of the area light are same as that of point light. 
 
Volume Light 
Volume lights illuminate objects which are enclosed in the volumetric shape of 
the light. The falloff of the volume light can be controlled with the help of a color 
ramp. The light shape option in the attribute editor determines the volumetric 
shape of the light. A volumetric light can be in the shape of: Box, Sphere, 
Cylinder, or Cone. 

 
3.1.3 Light Linking 
With the help of light linking you can link lights with the nodes in the scene. When 
you link the light to a specific node, the light will affect that node only. Light 
linking is done using Relationship editor. Two type of light linking are available: 
light centric in which you connect light to the illuminated objects and other one is 
object centric in which a specific object (node) is connected to the lights.

 
 

3.1.4 Light Baking:  

This process is also called Light Mapping. 
Light Baking is a method of sampling an object before rendering, and storing the 
results for later on uses. 
It is the most common application that samples illumination for each point of a 
texture image wrapped around to the object and stores that illumination in the 
texture. Here the Illumination is effectively frozen into the texture and later it can 
be mapped onto an object in the conventional way. 
Light Baking was introduced with mental ray 3.0. It is very flexible and user 
friendly to use as it is given in mental ray. Here Lightmap Shaders are very 
supportable with this option here. When you attach Lightmap Shader to the 
material then the Light Baking gets on for the object on which you have applied 
the same material. 
The advantage of Light Baking is that rendering can obtain illumination quickly 
from the frozen illumination, instead of computing it at rendering time which takes 
a long time as per the file size and the calculation of the bounced lights. It is 
especially valuable for indirect illumination which takes more time to compute 
than direct illumination. So, it is very useful in gaming. 
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3.1.5 Indirect Illumination 

Indirect Illumination is also called Global Illumination. 
Indirect Illumination is the technique used to capture indirect illumination, the 
natural phenomenon where light gets bounced off anything in its path until it is 
completely absorbed in the environment. Illumination is the calculation of the 
bounced light. Direct Illumination is the light which falls on the object directly and 
gets bounced from the object and the object is visible. Indirect Illumination is the 
light which is already bounced by the object and is spread in the environment. 

Here the objects in the place where the light is not falling they are also becoming 
visible to our eyes. For example – If the light enters in a dark closed room from a 
small window then also all the area and objects are becoming visible to our eyes. 
They are not very bright to see but you can see each of them at least. This 
happens due to the light which gets bounced by the object on which it falls. Here 
the intensity and material of the object which bounces the light is also very 
important. 
 

3.1.6 Shadows 
Shadows are the darkened areas which appear on a surface as an object gets in the 
path of a light source. Shadows fall onto the area of a surface 
that doesn’t directly receive light and which is opposite to the light. Shadows 
ground the objects in your scene and help in defining their three-dimensional 
appearance. Shadows make your scene real looking. 

 

 

3.2 Cameras 
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In Maya, two types of cameras are available: Perspective and Orthographic. By 
default, you have three orthographic cameras, Top, Front and Side and one 
perspective camera Perspective (persp). For rendering, you must use custom 
(user) cameras. You can place custom cameras anywhere in the scene; even 
inside a very small thing as well as you can animate custom cameras. You have 
three types of custom cameras: 
a) Camera: You can use camera for static scenes or simple 
animation. 
b) Camera and Aim: You can use camera and aim to create little 
complex animations where camera should focus on something like 
a randomly flying insect 
c) Camera, Aim and Up: You can use camera, aim and up in such 
animation where you want to control the up axis of the camera too. 
A camera’s exposure settings determine depth of field (the region of sharp 
focus), and whether or not subject matter is crisp or blurred by motion. In realworld 
photography, together the fStop and shutter speed determine how much 
light is exposed to film. However, fStop and shutter speed also determine what is 
in focus. The length of time light is allowed to pass through the camera lens to
the film is determined by the shutter speed. The higher the speed, the shorter the 
exposure time, the less light exposed to the film. The amount of light that is 
allowed to pass through the camera lens to the film is determined by the 
camera’s aperture setting (also known as the fStop). The wider the aperture, the 
more light exposed to the film. 
 

3.2.1 Motion Blur 
Motion blur gives the feeling of motion. Motion blur is determined by the shutter 
speed. Fast motion appears motion blurred at slower shutter speeds. Motion blur 
can be turned on and off on a per-object basis. 
 

3.2.2 Depth of Field 
Depth of field is the region of sharp focus in a photograph. Depth of field is 
determined by the camera’s aperture setting. At wide aperture settings, the depth 
of field is shallow. At narrow aperture settings, the depth of field is deep, and 
more of the foreground and background is in focus. 
Major Attributes of the camera are: 
 

3.2.3 Angle of view/Focal Length 

The focal length of a lens is the distance from the center of the lens to the film 
plane. The shorter the focal length, the closer the focal plane is to the back of the 
lens. Increasing the Focal Length zooms the camera in and increases the size of 
objects in the camera’s view. Decreasing the Focal Length zooms the camera 
out and decreases the size of objects in the camera’s view. Lenses are identified 
by their focal length. Focal length is expressed in millimeters. 
 
Camera scale 
Scales the size of the camera relative to the scene. If camera Scale is 0.5, the 
camera’s view covers an area half as large, but objects in the camera’s view are 
twice as large. 
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Auto Render Clip Plane 
If this is on, the near and far clipping planes are automatically set so they enclose 
all objects within the camera’s view. This option works only with Maya software 
renderer. If off, the near and far clipping planes are set to the Near Clip Plane 
and Far Clip Plane attribute values. 
 

3.2.5 Film Back 

The Film Back attributes control the basic properties of a camera. 
1. Film Gate: Film Gate lets you select a preset camera type. 
2. Camera Aperture: The height and width of the camera’s Film Gate 
setting, measured in inches. 
3. Film Aspect Ratio: The ratio of the camera aperture’s width to its height. 
4. Lens Squeeze Ratio: The amount the camera’s lens compresses the 
image horizontally. Some cameras, anamorphic cameras, compress the 
image horizontally to record a large aspect ratio image onto a square area 
on film. 
5. Fit Resolution Gate: Fit resolution gate controls the size of the resolution
gate relative to the film gate. 
6. Film Fit Offset: Film fit offset offsets the resolution gate relative to the film 
gate either vertically or horizontally. 
7. Film Offset: Film offset offsets vertically and horizontally the resolution 
gate and the film gate relative to the scene. 
8. Pre Scale: This value indicates the artificial 2D camera zoom. 
9. Film Translate: The Film Translate value indicates the artificial 2D 
camera pan. 
10. Film Roll Pivot: The Film pivot point is used to rotate from the center of 
the film back. 
11. Film Roll Value: This specifies the amount of rotation around the film 
back. 
12. Film Roll Order: Film Roll order specifies how the roll is applied with 
respect to the pivot value. 
Output Settings 
Output settings controls whether the camera generates an image during 
rendering, and what types of images the camera renders. 
1. Renderable: If on, the camera can create an image file, mask file, and, or 
depth file during rendering. 
2. Image: If on, the camera creates an image file during rendering. 
3. Mask: If on, the camera creates a mask during rendering. 
4. Depth: If on, the camera creates a depth file during rendering. A depth file 
is a type of data file that represents the distance of objects from the 
camera. 
5. Depth Type: This option determines how to compute the depth of each 
pixel. 
 

3.2.5 Environment 

Environment control the appearance of the scene’s background as seen from the 
camera. 
1. Background Color: This is the color of the scene’s background when it is 
rendered. 
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2. Image Plane: You can not apply texture to background color. For textures, 
you can create an Image plane and then apply texture on the plane. 
 
Shutter Angle 
The Shutter Angle influences the blurriness of objects of motion blurred objects. 
The larger the Shutter angle setting, the more blurry objects. Shutter Angle is 
measured in degrees. 
 

3.2.6 Batch Rendering 
Generally Maya renders only the current frame. If you want to render number of 
frames (animation), you have to use batch render. You can give the batch render 
command from the Maya and you can also batch render from the command 
prompt. Before giving the command, make the following changes in the render 
options: 
1. Set the filename. 
2. Set the Frame/Animation extension for the file. 
3. Set the Image format, for example single file like avi or you can generate
sequence of images. 
4. Set the video compression. 
5. Set the starting and ending frames. 
6. Set the camera through which you want to render. 
7. Set the Image size in which you want to render. 
8. In Maya Software tab set Anti-aliasing quality to Production quality. 
9. If Reflection and Refraction is used then Activate Raytracing. 
10. Then go to Rendering menu set, Render Menu and choose batch render. 
In the batch render option box you can specify whether to you all the available 
processors or you can enter number of processes. These work only on 
multiprocessor 
machines. You can continue using the Maya or you can close Maya 
and start working on different application while batch rendering is going. 

3.3 Assignment 

1. Light Character in Room 
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UNIT 4   Skinning 
 

 

 

Time Required to Complete the unit 

 

The time required to study thus Unit is broken as follows 

1. 1st Reading: It will need 2 Hrs for reading a unit 

1. 2nd Reading with understanding:  It will need 3 Hrs for reading and understanding a unit 

2. Self Assessment:  It will need 3 Hrs for reading and understanding a unit 

3. Revision and Further Reading: It is continuous process 
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4.1 Introduction   
 
Skinning is the process of setting up a character’s model so that it can be 
deformed by a skeleton. You skin a model by binding a skeleton to the model. 
You can bind a model to a skeleton by a variety of skinning methods, including 
smooth skinning and rigid skinning. Smooth skinning and rigid skinning are direct 
skinning methods. You can also use indirect skinning methods, which combine
the use of lattice or wrap deformers with either smooth or rigid skinning.  
 

4.1.1 Rigid Skinning 

 
Rigid skinning provides articulated deformation effects by enabling joints to 
influence sets of deformable object points. With rigid skinning, only one joint can 
influence each CV, vertex, or lattice point. This provides rigid deformation effects 
that you can smooth by using lattice deformers, cluster deformers, or flexors 

 

4.1.2 Bind Skin > Rigid Bind 
 
Rigid bind binds deformable object with the skeleton. The options available are: 
1. Bind to: This option specifies whether to bind to an entire skeleton or only 
to selected joints. 
2. Coloring: This option specifies whether to color the joints according to the 
colors automatically assigned to skin point sets. 
3. Bind Method: This option specifies whether you want to bind by closest 
point or by partition set. 
a. Closest Point: This option specifies that software automatically 
organize deformable object points into skin point sets for you based 
on the proximity of each point to a joint. 
Partition Set: This option specifies that Maya bind points that you’ve already 
organized into sets in a partition. 
 
Edit Rigid Skin > Create Flexor 
Create flexor creates flexor at the joint(s) or bone(s). The available options are: 
1. Flexor Type: This option specifies whether to create lattice flexors, sculpt 
flexors, or joint cluster flexors. 
2. Joints: This option specifies whether to create joint lattice, joint sculpt, or 
joint cluster flexors at selected joints only, or at all a skeleton’s joints. 
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3. Bones: This option specifies whether to create bone lattice or bone sculpt 
flexors at selected bones only or at all bones. 
 
Lattice Options: If Flexor Type is lattice, you can specify the Lattice Options: 
4. S, T, U Divisions: These specify the structure of the lattice in the lattice’s 
local STU space. 
5. Position the Flexor: This option enables you to adjust the lattice before it 
starts having an effect on skin objects. 
Sculpt Options: If Flexor Type is sculpt, you can specify the Sculpt Options: 
6. Max Displacement: This option specifies the distance that the sculpt 
sphere can push a skin object’s points from the sculpt sphere’s surface. 
7. Dropoff Distance: This option specifies the sculpt sphere’s range of 
influence. 
8. Dropoff Type: This option specifies how the sculpt sphere’s range of 
influence declines or drops off. There are two Dropoff Types: None and
Linear. 
9. Mode: This option specifies the sculpt sphere’s deformation mode as flip, 
project, or stretch. 
10. Inside Mode: This option specifies how the sculpt sphere influences the 
skin points located inside the sculpt sphere. There are two modes: 
a. Ring mode pushes inside points outside of the sculpt sphere, 
creating a contoured, ring-like effect around the sculpt sphere. 
b. Even mode spreads the inside points all around the sculpt sphere 
evenly, creating a smooth, spherical effect. 
 
Reassign Bone Lattice Joint 
Reassign Bone Lattice Joint sets a new driver joint for the current bone lattice 
flexor. The joint that drives a bone lattice flexor is the child of the bone that the 
flexor’s influence lattice surrounds. 
 
Preserve Skin Groups > Detach Skeleton 
This option disconnects the current skeleton from its skin. Detaching the skeleton 
preserves the rigid skin point sets and the rigid skin point weights, and unlocks 
the transformation attributes of its skin objects. 
 
Preserve Skin Groups > Reattach Skeleton 
This option reconnects the current skeleton to its skin objects. Reattaching the 
skeleton locks the transformation attributes of its skin objects. 
 
Deform > Edit membership Tool 
You can directly edit deformer set memberships by selecting deformable object 
points with the Edit Membership Tool. 

 

4.1.3 Smooth skinning 
Smooth skinning provides smooth, articulated deformation effects by enabling 
several joints to influence the same deformable object points. During smooth 
skinning, for each smooth skin point, software assigns a smooth skin point weight 
for each joint that controls the influence of that joint on each point. If you want to 
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change the results of smooth skinning to create unique skeletal deformation 
effects, you can edit or paint the weights of smooth skinning at the point level. 
Joints closer to a smooth skin point will have a greater influence than joints far 
from the skin point. 
 
Bind pose 
When you bind skin, software creates a bind pose node for each skeleton. This 
bind pose node keeps track of the joints’ transformation attributes when skinning 
takes place. The bind pose node also keeps track of the transformation attributes 
of any influence objects. The bind pose node facilitates putting the skeleton back 
into the bind pose at any time after binding skin. 
 

4.1.4 Bind Skin > Smooth Bind 
You can bind geometry to any transform node or hierarchy of nodes such as an
empty group node or a locator. With either Closest Joint or Closest Distance, you 
can limit the number of joints that influence nearby skin points by setting Max 
Influences. The options available in the option box are: 
1. Bind to: This option specifies whether to bind to an entire skeleton or only 
to selected joints. 
a. Joint Hierarchy: This option specifies that the selected deformable 
objects will be bound to the entire skeleton, from the root joint on 
down through the skeleton’s hierarchy, even if you have selected 
some joint other than the root joint. 
b. Selected Joints: This option specifies that the selected deformable 
objects will be bound to only the selected joints, not the entire 
skeleton. 
c. Object Hierarchy: When this option is selected, the selected 
deformable geometry is bound to the entire hierarchy of the 
selected joint or non-joint transform node, from the top node down 
through the entire node hierarchy. 
2. Bind Method: This selection includes Closest Joint or Closest Distance. 
a. Closest In Hierarchy: This option specifies that joint influence is 
based on the skeleton’s hierarchy. 
b. Closest Distance: This option specifies that joint influence is 
based only on proximity to the skin points. 
3. Max Influences: This option specifies the number of joints that can 
influence each skin point. 
4. After Bind (Maintain Max Influences): When this option is on, smooth 
skinned geometry cannot have a number of influences greater than that 
specified by Max Influences. 
5. Dropoff Rate: This option specifies how rapidly the influence of each joint 
on skin points will decrease with the distance from each joint. 
6. Remove Unused Influences: When this option is on, weighted influences 
that would receive a zero weighting are prevented from being included in 
the bind. 
7. Colorize Skeleton: When this option is on, bound skeletons and their 
skin’s vertices are colorized so that their vertices appear the same color 
as the joints and bones that influence them. 
 
Edit Smooth Skin > Add Influence 
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Add Influence option adds additional deformer objects to the skin. The options 
available are: 
1. Geometry: Click Use Geometry on if you want the influence object’s 
shape as well as its transform attributes to influence the skin’s shape. 
2. Dropoff: This option specifies the rate at which the influence of the 
influence object’s position drops as the distance from the influence object 
increases. 
3. Polygon Smoothness: This option specifies how accurately the smooth 
skin points follow a given polygonal influence object. 
4. NURBS Samples: This option specifies the number of samples used to 
evaluate the influence of a NURBS influence object’s shape. 
5. Weight Locking: This option specifies that you want to prevent the 
influence object’s weights from being changed indirectly, typically because 
of weight normalization during weight painting and editing.
6. Default Weight: This option specifies the default holding weight if Weight 
Holding is on. 
 
Remove Influence 
Remove Influence removes the current influence object’s influence from the skin. 
Remove Influence does not delete the current influence object from the scene. 
 

4.1.5 Paint Skin Weights Tool 
With the Paint Skin Weights Tool, you can paint a weight intensity value on the 
current smooth skin. Paint Skin Weights Tool settings are: 
 
Influence: 
1. Sort Transforms: This option sorts the joints that influence skin weights 
for the current character. 
2. Toggle Hold Weights On Selected: This button locks the weight of the 
current influence so that when the weights of other influences are painted, 
the influence that is held is not affected. 
 
Paint Weights: 
3. Paint Operation : The following operations are available: 
a. Replace: The brush stroke replaces the skin weight with the weight 
set for the brush. 
b. Add: The brush stroke increases the influence of nearby joints. 
c. Scale: The brush stroke decreases the influence of far away joints. 
d. Smooth: The brush stroke smoothes out the influences of the 
joints. 
4. Value: You can specify the weight value the brush stroke applies. 
5. Min/Max Value: This option sets the minimum and maximum possible 
paint values. 
6. Clamp: Clamp sets whether you want to clamp the values within a 
specified range, regardless of the Value set when you paint. 
7. Clamp Values: If you turns on the Lower and Upper clamping fields you 
can specify the value for them. 
8. Flood: You can click Flood to apply the brush settings to all the weights 
on the selected skin. The result depends on the brush settings defined 
when you perform the flood. 
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Mirror Skin Weights 
This option copies and pastes the reflected skin weights on the opposite side of 
the character. The options available are: 
1. Mirror Across: This option specifies mirroring weights about the global 
plane you choose. 
2. Direction: Positive to Negative (+Z to -Z) specifies direction of the 
mirroring along the specified Mirror Across plane. 
 
Copy Skin Weights 
Copy skin weights copies the skin weights of the selected source skin to the 
selected destination skin. The only option available is: 
1. Use Smooth Skin Weight Copy: This option improves the results of your
skin weight copy by smoothing the distribution of copied weights on the 
destination skin. This option is most useful when copying smooth skin 
weights from a low resolution polygonal mesh to a high resolution 
polygonal mesh. 
Normalize Weights 
Normalize weights adjusts the weighting of the selected skeleton so that all its 
smooth skin weights add up to one. 
Detach Skin 
Detach Skin detaches the deformable body from the skeleton. The options 
available are: 
History: Set this setting to Delete History, Keep History, or Bake History. 
Coloring: This option specifies whether to remove the joint colors assigned 
during binding or not. 

 

4.2. Animation 

 
The act, process, or result of imparting life, interest, spirit, motion, or activity to an 
object or picture is called as Animation. 
Animation is a sequence of consecutive images that creates an illusion (false 
imagination) of movement, when it is viewed with a rapid cycle. 
 

4.2.1 Types of Animations in Maya 
1. Keyframe Animation: Key frame animation lets you animate objects over 
time by creating keyframes. 
2. Driven key Animation: Driven key animation lets you link and drive the 
attributes of one object with those of another object by setting driven keys. 
3. Nonlinear Animation: Nonlinear animation lets you split, duplicate, and 
blend animation clips to achieve the motion effects. 
4. Path Animation: Path animation enables you to move an object along a 
path. You can also give deformation and rotation to the object along with 
movement. 
5. Dynamic Animation: Dynamic animation lets you create the real life like 
motion using the rules of physics. 
6. Motion Capture Animation: Motion capture animation lets you use 
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imported motion capture data to apply realistic motion to the characters. 
7. Animation with Expressions: Expressions are short set of instructions. 
You can also animate the attributes of an object with the help of 
expressions. 
 
 

4.2.2 Keyframes 
Animation is the process of creating and editing the properties of objects that 
change over time. Keyframes or simply keys are arbitrary markers on the timeline 
that designate the property values of an object at a particular time. In simple 
word, keyframes is the frames on which changes will occur. 
Breakdowns
Breakdowns are special keyframes that maintain proportional time relationships 
with adjacent keyframes. Breakdowns are used to adjust the timing of an 
animation while holding attribute values at points on the animation curve. 
 

4.2.3 Methods of Animation. 
There are Three methods of animation as under:- 
1) Straight Ahead Method: - Keying the first and the last frame is called straight 
ahead method. This method is also called as Traditional Animation method 
where all the frames are supposed to be drawn by hand only. Then the frames 
are passing through our eyes and we see the animation happening. 

 
2) Pose to Pose Method: - Keying the frames between first and last frame is 
called pose to pose method. This method is called Tweening also as here you 
can make two situations or poses and the in between are generated by them 
selves as an Illusion according to the arrangements of the poses or by any 
animation software like MAYA, 3DS MAX or in 2d Animation Flash etc. Here the 
arrangements of the poses is given in the following image. 
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4) Hybrid Method: - Combination of above two methods are called Hybrid 
method. So, if any technical person asks you, which method you are using 
for animation? Then answer is always Hybrid method. Combination of 
above two methods is called Hybrid method. So, if any technical person 
asks you, which method you are using for animation? Then answer is 
always Hybrid method. 
This method is a composition of both the straight ahead and pose to pose 
method and it is having the advantages of both of them. Here you can easily 
arrange the tining and poses according to your requirements.

 

 
4.2.4 Animation controls 
Animate > 
Set Key 
Set Key command is used to insert a key at the current position of the playback 
head in the timeline. The options available in the option window are: 
1. Set Keys on: This option specifies which attributes will have keys set on 
them. The sub options are: 
• All Manipulator Handles and Keyable Attributes: If you select 
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this option, it will set a key for the current manipulator, and if there 
is none, then the current object. 
• All Keyable Attributes: If you choose this option, it will set keys on 
all attributes of the selected object(s). 
• All Manipulator Handles: If you choose this option, it will set keys 
on attributes affected by the selected manipulator. 
• Current Manipulator Handle: This option will set keys on 
attributes affected by the selected manipulator handle. 
2. Set Keys at: It specifies on what time the keys will be set. The sub options 
are: 
• Current Time: It will set keys at the current time only. 
• Prompt: If this option is selected then you will be prompted for the 
time when setting keys. 
3. Set IK/FK Keys: When keying an IK handle or joint chain, Set IK/FK Keys 
adds keys for all attributes of the handle and all joint of the chain. This lets 
you create smooth IK/FK animations. This option is available only when 
“All Keyable Attributes” is on. 
4. Hierarchy: This option specifies which objects in a parent-child hierarchy 
will have keys set on them. 
5. Channels: This option specifies what channels will have keys set on 
them. 
• All Keyable: It sets keys on all the channels of the selected object. 
• From Channel Box: It sets keys on the selected channels of the
selected object. 
6. Control Points: Control Points option sets keys on the control points of 
the selected objects. Control points are NURBS CVs, polygonal vertices, 
or lattice points. 
 
Set Breakdown 
Set Breakdown command is used to insert Breakdowns on the timeline at the 
current position of the playback head in the timeline. 
 
Hold Current Keys 
Hold Current Keys sets keys for all animated attributes of a selected object at the 
current time. This command is most useful with Auto Key because Auto Key sets 
keys only for attributes that change value. 
 

4.3 Assignment  

1. Ball Bounce 
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UNIT 5   Path animation 

 

 

 

 

Time Required to Complete the unit 

 

The time required to study thus Unit is broken as follows 

1. 1st Reading: It will need 2 Hrs for reading a unit 

2. 2nd Reading with understanding:  It will need 3 Hrs for reading and understanding a unit 

3. Self Assessment:  It will need 3 Hrs for reading and understanding a unit 

4. Revision and Further Reading: It is continuous process 
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5.1 Path animation 
A path animation controls the position and rotation of an object along a curve. 
The point at which your object attaches to the path animation curve is the rotate 
pivot. 
 
Set Motion Path Key 
Set Motion Path Key adds a motion path marker to the selected motion path 
curve at the current time. 
 
Attach to Motion Path 
Attach to Motion Path places and links the selected object to the current curve. 
The current curve becomes the motion path. The options available in option box 
are: 
1. Start Time: This option specifies the start time of the motion path 
animation. This option is only available when Start or Start/End in Time 
Range is on. 
2. End Time: This option specifies the end time of the motion path 
animation. 
3. Parametric Length: This option specifies the method Maya uses to 
position an object as it moves along a curve. There are two methods: 
a. Parametric space method: In the parametric space method, the 
markers represent positions in the U-parameter space of the curve. 
b. Parametric Length method: In the parametric length method, the 
markers represent positions as a percentage of the total curve 
length. 
4. Follow: If Follow is on, Maya computes the object’s orientation as it 
moves along the curve. 
5. Front Axis: This option specifies the frontward orientation of the object as 
it travels along the curve. 
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6. Up Axis: This option specifies which of the object’s local axes aligns with 
the up vector. This specifies the upwards orientation of the object as it 
travels along the curve. 
7. Inverse Up: If this option is on, Up Axis tries to align itself with the inverse 
of up vector. 
8. Inverse Front: This option reverses the frontward direction an object is 
pointing along the curve. This is especially useful when you are trying to 
orient a camera so that it points frontward along a curve. 
9. Bank: Banking means the object will lean in towards the center of the 
curvature of the curve that it travels along. The bank option is only 
available if the Follow option is on, as banking also affects the rotations of 
the object. 
10. Bank Scale: If you increase the Bank Scale, then the banking effects will 
be more. 
11. Bank Limit: The Bank Limit lets you restrict the amount of leaning. 
Flow Path Object 
This option creates a flow path along the current motion path or around the 
current object. The options available in the option box are: 
1. Divisions: These values represent the number of lattice sections that will
be created. The Front, Up, and Side correspond to the axes that were 
specified when the path animation was created. 
2. Lattice Around: This option specifies the object around which lattice will 
be created. The options are: 
a. Object: This option creates the lattice around the object. 
b. Curve This option creates the lattice around the path curve. 
3. Local Effect: This option is most useful when you create the lattice 
around the curve. If the lattice is large, you probably don’t want to have 
the lattice points at one end of the lattice affect the object when it is close 
to the other end of the lattice. 
 
Driven keys 
Maya has special driven keys that link one attribute value to another. In regular 
animation, an attribute has values keyed to times in the Time Slider. For a driven 
key, an attribute has values keyed to the value of a driving attribute. A change in 
a driver attribute alters the value of the driven attribute. An attribute can be driven 
by multiple attributes. For example, you can make a muscle bulge when an elbow 
rotates. You can make the muscle bulge even more when the wrist rotates. 
 
Set Driven Key > Set 
This option opens the Set driven key window. The options available in the 
window are: 
1. Driver list: This list consists of a left column and a right column. The 
driver object’sname appears in the left column, and the object’s keyable 
attributes appear in the right column. 
2. Driven list: The driven object’s name appears in the left column, and the 
object’s keyable attributes appear in the right column. 
3. Key Button: Key button is used to connect the attributes of Driver and 
Driven objects. Select the attributes which you want to connect and press 
key button. 
4. Load Driver: Load Driver button loads the selected object as driver object 
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in the driver list. 
5. Load Driven: Load Driven button loads the selected object as driven 
object in the driven list. 
 
Set Driven Key > Go to Previous and Go to Next 
These options cycle you through the keys for the driven attributes of the current 
object and view the objects state at each of these keys. 
Set Transform Keys 
Translate 
This option adds a regular key at the current time on the X, Y, and Z translation 
channels of the selected object. 
Rotate 
This option adds a regular key at the current time on the X, Y, and Z rotation 
channels of the selected object. 
Scale 
This option adds a regular key at the current time on the X, Y, and Z scaling 
channels of the selected object. 

5.1.1 Create Animation Snapshot
This option creates an animation snapshot for the current object. The options 
available are: 
Time Range 
1. Start/End: This option, if selected, creates a Snapshot for the frames 
specified by the Start Time and End Time. 
2. Time Slider: This option creates a Snapshot for all the frames in the time 
slider. 
3. Increment: This option specifies the number of frames between which the 
Snapshot is drawn. 
4. Update: This option specifies how the snapshots will be updated: 
a. On Demand: This option updates the snapshot only when you 
select Animate > Update Motion Trail/Snapshot. 
b. Fast (Update Only When Keyframes Change): This option 
updates the snapshot when you add or change a keyframe for the 
object with the snapshot. 
c. Slow (Always Update): This option updates the snapshot if you 
change anything in the shape or animation of the object with the 
snapshot. 
Create Animated Sweep 
This option creates an animated sweep for the selected objects. The options 
available are: 
Time Range 
1. Time Slider: This option creates an animated sweep for the length of time 
defined by the length of the time slider. 
2. Start/End: This option lets you set a specific a Start time and End Time 
for the animated sweep. 
3. By Time: This option evaluates the animation and creates geometry for 
each By Time position. 
Parameterization 
4. Uniform knot: This option makes the profile curves run parallel to the V 
direction. The parameter values of the resulting surface in the U direction 
are equally spaced. 
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5. Chord Length: This option causes the parameter values on the resulting 
surface in the U direction to be based on the distance between the start 
points of the profile curves. 
6. Surface Degree: This option sets the lofted surface to linear or cubic in 
the U direction. 
7. Surface: This option specifies whether an open or closed surface is 
created. 
8. Output Geometry: This option specifies the type of geometry created. 
You can choose form NURB or Polygons. 
 
Turntable 
This option adds a turntable camera i.e. a camera which revolves around an 
object in 360 degrees, to your scene. This camera generates a turntable 
animation for the number of frames you specify in the Number of Frames field of 
the Create Turntable Animation options window. The options available in the 
option box are: 
1. Number of Frames: This option specifies the duration and speed of the 
turntable animation.
2. Direction: The direction in which camera revolves: 
a. Clockwise: When this option is on, the turntable camera orbits 
clockwise around the selected objects. 
Counter Clockwise: When this option is on, the turntable camera orbits 
counterclockwise around the selected objects. 
Trax Editor 
The Trax Editor is a nonlinear animation tool. The Trax Editor is a high-level 
animation tool that lets you select and control characters and their animation 
clips, layer and blend animation sequences, synchronize your animation and 
audio clips, and drag-and-drop animation clips between mapped characters. With 
the Trax Editor, you can manipulate and arrange your animation sequences from 
a higher level than from the Graph Editor or Dope Sheet. 
 
Animate >Create Clip 
Create Clip creates an animation clip. A clip is a collection of animation curves 
for a character. Animation clips can be used for non-linear animation. Clips can 
also store in the visor so that they can be reused. The options available are: 
1. Name field: You can specify a name for the clip. 
2. Keys (Leave Keys in Timeline): If this option is on, the current character 
set’s keys are not removed from the Time Slider when you create a clip for 
the current character’s animation curves. When off, the current character 
set’s keys are removed from the Time Slider when you create a clip for the 
current character’s animation curves. 
3. Clip: This option specifies where to put the clip you’re creating: 
a. Put Clip in Visor Only: This setting is useful if you won’t use the 
clip currently but want to store it for future use. 
b. Put Clip in Trax Editor and Visor: This setting lets you work on 
the clip in the Trax Editor as well as stores it in the visor. 
4. Time Range: This option specifies the clip’s time range in the Trax Editor: 
a. Selected: This option uses a time range you’ve selected in the 
Timeline for the clip. To select a time range, drag through the 
desired times in the Time Slider’s Timeline. 



Maya Part II  
    BMGA303 

 

85 

b. Time Slider: This setting uses a time range defined by the 
Playback Start and End times of the Timeline. 
c. Animation Curve: This setting uses a time range that spans the 
range of the character set’s animation curves. 
d. Start/End: This setting specifies a time range from Start Time to 
End Time. 
e. Start Time: This option specifies the start of the time range. 
f. End Time: This option specifies the end of the time range. 
5. Subcharacters (Include Subcharacters in Clip): When this option is on, 
it creates a single source clip that includes all animation curves for the 
character set and all its subcharacter sets. 
6. Timewarp (Create Timewarp Curve): This option creates a time warp 
curve for the selected clip. 
 
Animate >Create Pose 
Create Pose creates a pose of the current character. You can store a snapshot 
of a character’s current position for any moment in its animation. The options 
available are:
Name field: This option defines the name of the pose as it is displayed in the 
Visor. 
 
Previewing your animation ghosting: Like all the frames you are able to see in 
the straight ahead method of animation, here you can see all the frames which 
are generated while making the animation in the software. You need to see each 
and every frame to make the animation smooth and realistic and for that you 
need to use the Hybrid method where you are going to make the poses as well 
as straight animations. So, you can use the ghosting as it shows each and every 
frame in the view port when it is on. 
Ghosting is the simulation of a technique in classical animation where an 
animator rapidly flips through a handful of cell drawings to get a feel for the timing 
of the action he is working on. 
Select the object and select Animate > Create Motion Trail > 

 

 

5.2 Assinment  

1. Ball Bounce – Lab
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ROLE OF SELF INSTRUCTIONAL   MATERIAL INDISTANCELEARNING 

 

The need to plan effective instruction is imperative for a  

Successful distance teaching repertoire. This is due to the fact that the 

instructional designer, the tutor, the author (s) and the student are often 

separated by distance and may never meet in person. This is an increasingly 

common scenario in distance education instruction. As much as possible, 

teaching by distance should stimulate the student’s intellectual 

Involvement and contain all the necessary learning instructional activities ties 

that are capable of guiding the student through the course objectives. Therefore, 

the course / self-instructional material are completely equipped with everything 

that the syllabus prescribes. 

To ensure effective instruction, a number of instructional design ideas are used 
and these help students to acquire knowledge, intellectual skills, motor skills and 
necessary attitudinal changes.  In this respect, 

Students ‘assessment and course evaluation are incorporated in the text. 

The nature of instructional activities used in distance education self- instructional 

materials depends on the domain of learning that they reinforce in the text, that 

is, the cognitive, psychomotor and affective. These are further interpreted in the 

acquisition of knowledge, intellectual skills and motor skills. Students may be 

encouraged to gain, apply and communicate (orally or in writing) the knowledge 

acquired. Intellectual- skills objectives may be met by designing instructions that 

make 

use of students’ prior knowledge and experiences in the discourse as the 

foundation on which newly acquired knowledge is built. 

The provision of exercises in the form of assignments, projects and tutorial 

feedback is necessary. Instructional activities that teach motor skills need to be 

graphically demonstrated and the correct practices pros vided during tutorials. 

Instructional activities for inculcating change in attitude and behavior should 

create interest and demonstrate need and benefits gained by adopting the 

required change. Information on the adoption and procedures for practice of new 

attitudes may then be introduced. 



 

 

 

 

Teaching and learning at a distance eliminates interactive  

Communication clues, such as pauses, intonation and gestures, associated 

with the face-to-face method of teaching. This is particularly so with the 

exclusive use of print media. Instructional activities built into the instructional 

repertoire provide this missing interaction between the student and the teacher. 

Therefore, the use of instructional activities to affect better distance teaching is 

not optional, but mandatory. 

Our team of successful writers and authors has tried to r e d u c e  

This. Divide and to bring this Self Instructional Material as the b e s t  

teaching and communication tool. Instructional activities are varied in order to 

assess the different facets of the domains of learning. 

Distance education teaching repertoire involves extensive use of self- 

instructional materials, be they print or otherwise. These materials are designed 

to achieve certain pre-determined learning outcomes, namely goals and 

objectives that are contained in an instructional plan. Since the teaching process 

is affected over a distance, there is need to ensure that students actively 

participate in their learning by performing specific tasks that help them to 

understand the relevant concepts.  

Therefore, a set of exercises is built into the teaching repertoire in order 

to link what students and tutors do in the framework of the course outline. 

These could be in the form of students ‘assignments, a research project 

or a science practical exercise. Examples of instructional activities in distance 

education are too numerous to list. Instructional activities, when used in this 

context, help to motivate students, guide and measure students’ performance 

(continuous assessment) 

 

 

 

 

 



 

 

 

 

 

PREFACE 

 

 

We have put in lots of hard work to make this book as user-friendly as possible, but 

we have not sacrificed quality. Experts were involved in preparing the materials. 

However, concepts are explained in easy language for you. We have included many 

tables and examples for easy understanding. 

We sincerely hope this book will help you in every way you 

Expect. 

All the best for your studies from our team! 

 

 

 

 

 

 

All the best for your studies from our team! 

  



 

 

6.1 Introduction 

Rendering is the final stage in the 3D computer graphics production process. 
Though the wider context of rendering begins with shading and texturing objects 
and lighting your scene, the rendering process ends when surfaces, materials, 

lights, and motion are processed into a final image or image sequence 

6.1.1 Visualization vs. the final render 

As you build your scenes like shade and texture objects, light scenes, position 
cameras, and so on, you’ll want to visualize your scene many times before you 
produce the final rendered image or image sequence. This process may involve 
creating and setting up additional cameras. Rendering involves a large number of 
complex calculations which can keep your computer busy for a long time. 
Producing rendered images always involves making choices that affect the 
quality of the images, the speed with which the images are rendered, or both. 
 

6.1.2 Software Rendering 
Software rendering produces images of the highest quality, letting you achieve 
the most sophisticated results. Maya has the following software renderers: 
1. The Maya software renderer: Maya’s software renderer is an advanced, 
multi-threaded renderer. It is a hybrid renderer, offering true raytracing 
plus the speed advantages of a scan-line renderer. The Maya software 
renderer supports all of the various entity types found within Maya 
including particles, various geometry and paint effects and fluid effects. 
The Maya software renderer features IPR, a tool designed to allow you to 
make interactive adjustments to the final rendered image, and which 
greatly enhances rendering productivity. Most importantly, the nature of 
Maya's integrated architecture allows complex interconnections, like 
procedural textures and ramps that govern particle emission and other 
unpredictable relationships that are capable of producing stunning visual 
effects. 
2. mental images mental ray for Maya: mental ray for Maya offers all the 
features traditionally expected of photorealistic rendering and includes 
functionality not found in most rendering software. mental ray for Maya 
allows interactive and batch mental ray rendering from within the Maya 
user interface. 
 

6.1.3 Hardware Rendering 
Hardware rendering uses the computer's video card and drivers installed on the 
machine to render images to disk. Hardware rendering is generally faster than 
software rendering, but typically produces images of lower quality compared to 
software rendering. Hardware rendering cannot produce some of the most 
sophisticated effects, such as some advanced shadows, reflections, and 
postprocess effects. To produce these kind of effects, you must use software 
rendering. 
 
Vector Rendering 



 

 

Vector rendering lets you create stylized renderings in various bitmap image 
formats and 2D vector formats. You can use the Maya Vector renderer to create 
stylized renderings for example, cartoon, tonal art, line art, hidden line, wireframe 
in various bitmap image formats or in the following 2D vector formats: 
• Macromedia Flash (non-interactive) (SWF) 
• Adobe Illustrator (AI) 
• Encapsulated PostScript (EPS) 
• Scalable Vector Graphics (SVG). 
The Maya Vector renderer cannot render the following Maya features. 
• Bump maps 
• Displacement maps 
• Maya Fluid Effects 
• Image planes 
• Lights (only point lights are used) 
• Maya Fur 
• Multiple UVs 
• Maya Paint Effects 
• Particles 
• Post-render effects 
• Shaders (only Anisotropic, Lambert, Blinn, Phong and Phong E shaders 
are used) 
• Multiple shaders assigned to a single NURBS or subdivision surface are 
not rendered. 
• Textures (Texture rendering is limited by the Fill Style and the number of 
polygons) 
 
Render > Render Current Frame 
Render Current Frame opens the Render View window and renders the current 
scene. The options available only for mental ray renderer are: 
1. Number of Rendering Threads to Use: This option specifies the number 
of rendering threads to be used by mental ray for Maya for rendering. 
2. Render on this machine: This option is used for network rendering only. 
This specifies whether the local machine renders the scene, or whether 
slaves render the scene. This is useful in reducing the workload on the 
master machine where Maya is running. 
 
Render > IPR Render Current Frame 
IPR Render Current Frame opens the Render View window and IPR renders the 
current scene. 
 
Shockwave 3D 
The Maya Shockwave 3D Exporter provides you with a fast and efficient way to 
get your Maya content into Macromedia Director. Your content exports in a form 
that can be authored for use with an interactive experience and played on the 
Macromedia Director Shockwave player. 
 
Render > Render Settings 
Render settings for the Maya Hardware renderer, the mental ray for Maya 
renderer, the Maya Software renderer, the Maya Vector renderer are consolidated 
into one Render Settings window. Use the settings in this window to set scene-wide 



 

 

render options. Especially when used in conjunction with perobject render settings, 
the render settings give you a great deal of control over quality of rendered images 
and the speed with which they are rendered. 
 
Common tab 
1. Image File Output: The name of rendered image files can consist of three 
separate components: file name, frame number extension, and file format 
extension. A combination of these three components is referred to as the 
file name syntax. 
2. File Name Prefix: The File name prefix attribute to add one or more of 
these fields to the file name for your scene: scene name, layer name, 
camera name, version number, current date or current time. You can also 
create subdirectories to save out rendered images by adding a / (slash) in 
your file name prefix. 
3. Frame/Animation Ext: This option defines the format of rendered image 
file names. 
4. Image Format: This is the format (extension) for saving rendered image 
files. 
5. Compression: Click this button to select the compression method for AVI 
or QuickTime movie files. 
6. Start Frame, End Frame: This option specifies the first and last frames to 
render. Start Frame and End Frame are only available if Frame/Animation 
Ext is set to an option containing #. 
7. By Frame: The increment between the frames you want to render. If you 
use a value less than 1, make sure the Renumber Frames Using option is 
turned on. Otherwise, many frames will appear to be missing when they 
are just being overwritten. 
8. Frame Padding: The number of digits in frame number extensions. For 
example, if Frame/Animation Ext is set to name.#, and Frame Padding is 
3, Maya names rendered image files name.001, name.002, and so on. 
 
Renderable Cameras: Render a scene from one or more cameras. The 
default is to render from one camera. If you are rendering the scene from one 
camera, select the camera from the drop-down list. The drop-down list is 
divided into three sections, separated by dashes: 
• The first section is the camera currently selected as renderable. 
• The second section lists existing cameras that you can select as 
renderable. 
• The third section is the Add Renderable Camera option. If you want to 
add another existing camera to the list of renderable cameras, you can 
select Add Renderable Camera. 
9. Alpha Channel (Mask): This setting controls whether rendered images 
contain a mask channel. 
10. Depth Channel (Z Depth): This setting controls whether rendered images 
contain a depth channel. 
 
Image Size: The Image Size attributes control the resolution and pixel aspect 
ratio of rendered images. 
11. Presets: Select a film- or video-industry standard resolution. When you 
select an option from the Presets drop-down list, Maya automatically sets 



 

 

the Width, Height, Device Aspect Ratio, and Pixel Aspect Ratio. 
12. Maintain Width/Height Ratio: Turn on this setting when you want to 
scale the image size proportionally in width and height. When you enter a 
value for either Width or Height, the other value is automatically 
calculated. 
13. Maintain Ratio: This setting specifies the type of rendering resolution ratio 
you want to use, Pixel Aspect or Device Aspect. 
14. Width: This setting specifies the width of the image in the unit specified in 
the Size Units setting. 
15. Height: This setting specifies the height of the image in the unit specified 
in the Size Units setting. 
16. Size Units: This option sets the unit that you want to specify the image 
size in. 
17. Resolution: This setting specifies the resolution of the image in the unit 
specified in the Resolution Units setting. 
18. Resolution Units: This option sets the unit that you want to specify the 
image resolution. 
19. Device Aspect Ratio: The aspect ratio of the display device on which you 
view the rendered image. The device aspect ratio represents the image 
aspect ratio multiplied by the pixel aspect ratio. 
20. Pixel Aspect Ratio: The aspect ratio of the individual pixels of the display 
device on which you are viewing the rendered image. 
Renderings available in Maya are: 
 
Mental Ray Custom Shaders: Here Custom shaders are the custom-coded 
mental ray shaders which help you in creating looks over and above those that 
can be achieved with the standard mental ray for Maya Base shaders. You can 
create them in C or C++ language, then process them into modes that you can 
see and use in Maya. 
A collection of custom shaders make up a Custom Shader Library. Custom 
shaders are typically distributed in custom shader libraries. To see a particular 
custom shader in Maya, you must load the shader library that contains that 
custom shader. 
Custom mental ray shaders with color attributes create corresponding RGBA 
attributes in Maya. This means that the alpha_component of color values on 
custom shaders can drive or can be driven by Maya shading networks. Custom 
shaders written for Maya’s Software renderer can be related to mental ray for 
Maya custom shaders. The correspondence is driven by an .mi declaration that is 
loaded in the Shader Manager. Then, mental ray for Maya detects the 
corresponding Maya shading node. The corresponding parameters or attributes 
and connections to other supported nodes are associated. As a result, you can 
create a single shading network that is compatible for both Maya and mental ray 
rendering. 
A custom shader library consists of two files: 
One declaration file (for example, mayabase.mi) that contains descriptions of the 
interfaces of the shaders and One library file (for example mayabase.so or 
mayabase.dll) that contains the actual implementations of the shaders. 
 
Mental Ray Lights, Shadows And Fog: 
Mental Ray Motion Blur: 



 

 

Mental ray computes motion blur of highlights, textures, shadows, reflections, 
refractions, transparency, and intersecting objects. There are two methods of 
defining motion blur: 
• Instance motion blur defines a transformation matrix that controls the 
orientation of the instanced object, light, or camera after a shutter interval 
of one time unit, in addition to the regular transformation matrix that 
defines the orientation at the beginning of the shutter interval. Moving 
lights cause blurred highlights and shadows. 
• Motion vectors can be defined at object vertices to create internal motion 
caused by shape changes. Each vertex has a vector associated with it 
that describes how far that vertex moves in one time unit. For deferred 
objects, where the vertices are created later during rendering, it is 
necessary to supply a motion bounding box that describes the lowest and 
highest expected motion vector components. mental ray supports motion 
blur both in scanline and raytracing mode. Motion blur does introduce 
rendering overhead only where blur must be computed; if the camera 
moves this could be the entire image but if only a small object moves the 
overhead is small. 

6.1.4 Final Gathering 
Final gather is a method of global illumination to create very diffuse scenes 
where the indirect illumination changes slowly. Final gathering is a technique for 
estimating global illumination for a given point by either sampling a number of 
directions in the hemisphere over that point, or by averaging a number of final 
gather points nearby since final gather points are too expensive to compute for 
every illuminated point. Without final gathering, the global illumination on a 
diffuse surface is computed by estimating the photon density near that point. 
With final gathering, many new rays are sent out to sample the hemisphere 
above the point to determine the incident illumination. Final gathering is useful in 
scenes where the indirect illumination varies slowly, such as purely diffuse 
scenes. For such scenes, final gathering eliminates photon map artifacts such as 
low frequency noise and dark corners. 
If you want to use Final Gather, you have to enable the Final Gather from the 
render setting for mental ray for Maya renderer. The options available are: 
1. Final Gather: Use this setting to turn Final gathering for global illumination 
on or off. 
2. Precompute Photon Lookup: This option causes photon tracing to 
compute and store an estimate of the local irradiance at every photon 
location. This means that far fewer final gathering points are required 
because the photon map carried a good approximation of the irradiance in 
the scene—mental ray for Maya can estimate irradiance with a single 
lookup, instead of many photons. In this case, photon tracing takes longer 
than before and requires slightly more memory, but rendering is faster. 
3. Final Gather Rays: This setting controls how many rays are shot in each 
final gathering step to compute the indirect illumination. 
4. Min Radius, Max Radius: Max Radius and Min Radius control the size of 
the sampling region within which Final Gather rays search for irradiance 
information from other surfaces. 
5. View (Radii in Pixel Size): This option causes the Min Radius and Max 
Radius of final gather rays to be calculated in pixel size, rather than in 



 

 

object space. This allows you to set the visual quality in pixel size, without 
knowing the object or scene bounds. 
6. Final Gather Scale: The Scale value allows you to easily control the 
intensity and color of the final gather contribution on a global scene level. 

6.4 Dynamics 
 
Dynamics 
Dynamics is a branch of physics that uses rules of physics to simulate natural 
forces. Dynamic animation lets you create realistic motion that’s hard to achieve 
with traditional keyframe animation. 
 
Particles 
Particles are chunks that display as dots, streaks, spheres, blobby surfaces, etc. 
You can animate the display and movement of particles. A particle object is a 
collection of particles that share the same attributes. You can create particle 
objects containing a single particle or millions of particles. 
 
Particles > Particle Tool 
Particle tool creates static particle objects. You can create random particles, a 2D 
and 3D particle object grid and you can also sketch particles. The options 
available in the option box are: 
1. Particle Name: You can give name to the particle object. The name helps 
you identify the object in the Outliner. 
2. Conserve: Conserve influences the motion of particles whose velocity and 
acceleration attributes are controlled by dynamic effects. The Conserve 
value controls how much of a particle object’s velocity is retained from 
frame to frame. Conserve doesn’t affect motion created by keyframes. 
3. Number of Particles: Enter the number of particles you want to create 
per mouse click. 
4. Maximum Radius: If you choose a number greater than 1 for Number of 
Particles, you can distribute particles randomly in a spherical region where 
you click. 
5. Sketch Particles: When this option is selected, you can sketch particles. 
6. Sketch Interval: Sketch Interval sets the pixel spacing between particles. 
7. Create Particle Grid: When this option is on, it creates a particle grid. 
8. Particle Spacing: This option sets the spacing between particles in the 
grid. 
9. Placement: You can choose to draw the grid with the cursor or with the 
text fields. 
10. Minimum Corner: The x, y, z co-ordinates of the lower left corner of the 
3D particle grid. 
11. Maximum Corner: The x, y, z co-ordinates of the upper right corner of the 
3D particle grid. 
 

 
 
6.4.1 Create Emitter 



 

 

Emitters generate particles when an animation plays. Maya includes the following 
types of emitters: 
1. Point emitters: These emit particles from a position in the workspace. 
When you select a NURBS surface or curve and add a default emitter, you 
create a point emitter that emits from all CVs. There are two type of point 
emitters: 
a. Omni: Omni creates an omnidirectional point emitter. 
b. Directional: Directional creates a directional point emitter. Particles 
emit in the direction you specify with the Direction X, Y, and Z 
attributes. 
2. Surface emitters: These emit particles from random, evenly distributed 
positions on the outer faces of NURBS or polygonal surfaces. 
3. Curve emitters: These emit particles from random, evenly distributed 
positions of a NURBS curve. 
4. Volume emitters: These emit particles from a closed volume. You can 
choose from cube, sphere, cylinder, cone, and torus. 
The options available in the option box are: 
1. Rate: Rate sets the average rate at which particles are emitted per 
second. 
2. Scale Rate by Object Size: This option is only available when the current 
Emitter Type is Surface, Curve, or Volume. If you turn on this attribute, the 
size of the object emitting the particles affects the rate of particles emitted 
per frame. 
3. Need Parent UV NURBS: If you turn this on in the Emitter Options 
window, Maya adds parentU and parentV attributes to the particle shape 
and sets the needparentUV attribute to on. 
4. Cycle Emission: Cycle Emission lets you restart the random number 
sequence of the emission. 
5. Cycle Interval: Cycle Interval defines the interval in frames for restarting 
the random number sequence when using Cycle Emission. 
 
Distance/Direction Attributes 
6. Min Distance: This option sets the minimum distance from the emitter at 
which emission occurs. Particles are emitted randomly and uniformly 
between the Min Distance and Max Distance. 
7. Max Distance: This option sets the maximum distance from the emitter at 
which emission occurs. 
8. Direction X, Y, Z: This option sets the emission direction relative to the 
emitter’s position and orientation. 
9. Spread: Spread defines a conical region where the particles are emitted 
randomly. 
10. Speed: Speed sets a speed multiplier for the original emission speed of 
the emitted particles. 
11. Speed Random: The Speed Random attribute lets you add randomness 
to your emission speeds without using expressions. 
12. Tangent Speed: This option sets the magnitude of the tangent component 
of emission speed for surface and curve emission. 
13. Normal Speed: This option sets the magnitude of the normal component 
of emission speed for surface and curve emission 
Volume Emitter Attributes 



 

 

14. Volume Shape: Volume Shape specifies the shape of the volume that the 
particles are emitted into. 
15. Volume Offset: Volume offset offsets the emitting volume from the 
location of the emitter. If you rotate the emitter, you also rotate the offset 
direction because it operates in local space. 
16. Volume Sweep: This option defines the extent of rotation for all volumes 
except cubes. 
17. Section Radius: This option defines the thickness of the solid portion of 
the torus, relative to the radius of the torus central ring. 
18. Die on Emission Volume Exit: If you turn this attribute on, the emitted 
particles die when they exit the volume. 
19. Volume Speed Attributes: The Volume Speed Attributes apply only to 
the initial velocity of the particles. 
20. Away From Center: This option specifies the speed at which particles 
move away from the center point of volumes. 
21. Away From Axis: This option specifies the speed at which particles move 
away from the central axis of volumes. 
22. Along Axis: This option specifies the speed at which particles move along 
the central axis of all volumes. 
23. Around Axis: This option specifies the speed at which particles move 
around the central axis of all volumes. 
24. Random Direction: Random direction adds irregularity to the direction 
and initial speed of the particle’s Volume Speed attributes. 
25. Directional Speed: Direction speed adds speed in the direction specified 
by the Direction XYZ attributes of all volume emitters. 
26. Scale Speed by Size: If you turn this attribute on, when you increase the 
size of the volume, the speed of the particles increases. 
 
Emit From Object 
Emit from object converts an object into an emitter. The particles are emitted 
from the vertex, CVs etc. The option are same as that of the create emitter. 
 
Use Selected Emitter 
Use selected emitter connects a particle object with the selected emitter. 
 
Per-Point Emission Rates 
Per-Point emission rates let you vary emission rates on a per particle basis. 
 
Goal 
Goal sets a goal for a particle. When you play animation, particle rush towards 
the goal object. The available options are: 
1. Goal Weight: The goal weight sets how much all particles of the trailing 
object are attracted to the goal. You can set the goal weight before you 
create the goal using the Goal options window. A goal value of 0 means 
that the goal’s position has no effect where as a value of 1 move the 
trailing particles to the goal object position immediately and a value 
between 0 and 1 cause the particles to move toward the goal. 
2. Use Transform as Goal: This option makes particles follow the object’s 
transform rather than its particles, CVs, vertices, or lattice points. 
Instancer 



 

 

Instancer replaces the traditional particles with an object you select. You can 
apply the particle instancer two or more times to the same particle object. The 
options available are: 
1. Particle Instancer Name: You can provide name for the instancer. 
2. Rotation Units: If you set the Rotation settings for particles, this option 
specifies whether the value is interpreted as degrees or radians. 
3. Rotation Order: If you set the Rotation settings for particles, this option 
sets the precedence order of rotation, for instance, XYZ, XZY, or ZXY. 
4. Level of Detail: This option sets whether the source geometry appears at 
the particle locations or whether a bounding box or boxes appear instead. 
5. Cycle: Cycle changes the instanced objects with time. 
a. None: If none is selected, it instance a single object. 
b. Sequential: If sequential is selected, it cycle through the objects in 
the Instanced Objects list. 
6. Cycle Step Unit: If you’re using an object sequence, select whether 
frames or seconds are used for the Cycle Step Size value. 
7. Cycle Step Size: If you’re using an object sequence, enter the particle 
age interval at which the next object in the sequence appears. 
 
Sprite Wizard 
The particle Sprite Wizard simplifies the process for displaying a texture image or 
image sequences on particles. The particle Sprite Wizard leads you through the 
steps necessary to associate image files with sprites. You can assign a single 
image or a sequence of images to each particle. 
 
Connect to Time 
Connect to time reconnects the current time to the scene time for particles. You 
can use connect to time to stop the particle in between the animation. 
 
General Control Attributes for particles Is Dynamic 
If you turn on this option, Dynamics will be calculated for the particles. 
 
Dynamics Weight 
This option controls the effect of fields, collisions, springs, and goals connected 
to the particle object. 
 
Conserve 
The Conserve value controls how much of a particle object’s velocity is retained 
from frame to frame. 
 
Forces in World 
If you turn this option on, World space calculations will be converted to local 
space coordinates. 
 
Cache Data 
You can cache the particles' animation. Once cached, Maya will not calculate 
particle animation every frame. To see the effect of any changes made after 
caching, you have to disable and then enable the cache. 
 
 



 

 

 
Emission Attributes 
Max Count 
This option contains the maximum count of particles this shape will allow. If some 
particles die off, new particles will again be accepted up to the max count, and so 
on. 
 
Lifespan Attributes 
Lifespan Mode 
This attribute defines the life of the emitted particles. 
Live forever 
All particles live forever, unless killed by collision events or emission volume exit. 
Constant 
This setting allows you to input a constant lifespan for the particles. The particles 
will die at the specified time. 
Random range 
This attribute must be set to enable Lifespan Random. 
Lifespan 
This setting allows you to input a lifespan for the particles. 
Lifespan Random 
This attribute is used only if lifespanMode is set to Random Range. 
General Seed 
This attribute represents the seed for random number generation. 
 
Time Attributes 
Start Frame 
This attribute represents the frame after which dynamics will be solved. 
Current Time 
This attribute represents the current time in the timeline. 
 
Collision Attributes 
Trace Depth 
This attribute represents the maximum number of consecutive collisions that are 
detected within a frame for each particle. 
Offset 
Offset attribute lets you offset the position of the current particle when it collides 
with the surface. Offset also prevents the current particle from penetrating the 
surface of the specified collision object. This attribute is only available when the 
current particle has a collision object. 
 
Goal Weights and Objects 
Goal Smoothness 
This value is used to control the smoothness of the change in the goal forces as 
the weight changes. The higher the value, the smoother the change. 
Goal Active 
This option makes the goal active. 
 
goalWeightNPP 
This option provides per-particle goal weights for the Nth goal object. 
 



 

 

 
Instancer 
Instancer Nodes 
This option selects which instancer is used for the instanced objects. 
Particle Object To Instance 
This attribute sets the particle object to which the geometry is applied. 
General Options 
Position 
This attribute sets position of the instanced objects. 
Scale 
This attribute sets scale of the instanced objects. 
Shear 
This attribute sets shear value of the instanced objects. 
Visibility 
This attribute sets whether display of each instanced object is on or off. 
ObjectIndex 
If you set the Cycle option of the Instancer to None, this option sets which object 
from the Instanced Objects list is instanced for each particle. If you set Cycle to 
Sequence, ObjectIndex is ignored. 
 
Rotation Options 
RotationType 
You can choose one of three methods to set their orientation: Rotation, 
AimDirection, and AimPosition. 
Rotation 
This attributes sets the orientation of the instanced objects relative to their initial 
orientation. 
AimDirection 
This attribute sets the orientation of the instanced objects by specifying the 
direction along which each instanced object points relative to the original position 
of its local origin. 
AimPosition 
This attribute sets the orientation of the instanced objects by specifying the 
location where each instanced object points relative to the original position of its 
local origin. 
AimAxis 
This option specifies the object axis that points directly at the AimDirection or 
AimPosition. 
AimUpAxis 
This attribute specifies the object axis that points up relative to how the AimAxis 
points at the AimDirection or AimPosition. 
 
Cycle Options 
CycleStartObject 
CycleStartObject specifies the cycle’s starting object from the Instanced Objects 
list. 
Age 
Age works with the Instancer’s Cycle Step setting to set how often Maya changes 
from one object to another. 
 



 

 

6.4.2 Render Attributes 
Particle Render Type 
This attribute specifies the hardware rendering method for the particles. You can 
choose whether to have Hardware Render or Software Render Particles. 
Add attributes for 
Add attributes for displays the attributes for the current selected particle render 
type. 
Per Particle (Array) Attributes 
These attributes are assigned on per particle basis i.e. you can assign different 
values to the different particles of the same object. 
Add Dynamic Attribute 
You can add dynamic attributes which can be controlled and change with the 
time. 
 
Solvers 
Create Particle Disk Cache 
This option creates a particle disk cache. The options available in the Particle 
Render Cache Options window are: 
1. Cache Directory: You can specify where to store the disk cache. 
2. Only Update particles: If Only Update particles are off (default), the 
particles will be evaluated by normal DG evaluation, and the cache is 
guaranteed to have the same result as in interactive playback. If Only 
Update particles are on, Maya optimizes the evaluation by triggering the 
evaluation only on particles. This optimization can create a discrepancy if 
one particle system is dependent on another particle system. 
Particle systems to cache: You can specify to cache either Selected or All 
particle systems. 
Fields 
You can simulate the motion of natural forces with dynamic fields. Fields in Maya 
can be categorized as: Stand alone Fields, Object Fields and Volume Fields. The 
Fields available in Maya are: 
Air 
This creates an Air field which simulates the real life air. The options for an Air 
field are: 
Air Field Predefined Settings 
1. Wind: Wind button sets the Air Field attributes to default settings that 
approximate the effects of wind. 
2. Wake: Wake button sets the Air Field attributes to default settings that 
approximate the movement of air disrupted and pulled along by a moving 
object. 
3. Fan: Fan button sets the Air Field attributes to default settings that 
approximate a local fan effect. 
4. Magnitude: Magnitude sets the strength of the air field, which sets the 
speed along the direction the air is moving. 
5. Attenuation: Attenuation sets how much the strength of the field 
diminishes as distance to the affected object increases. 
6. Direction X, Y, Z: These options specify the direction in which the air 
blows. 
7. Speed: Speed controls how quickly the connected objects match the 
velocity of the air field. 



 

 

8. Inherit Velocity: When an air field is moving or parented to a moving 
object, Inherit Velocity specifies how much the moving air field’s velocity 
that is added to the Direction and Magnitude. 
9. Inherit Rotation: If you turn on Inherit Rotation and the air field is rotating 
or parented to a rotating object, the air flow undergoes that same rotation. 
Distance 
10. Use Max Distance: If you turn on Use Max Distance, connected objects 
within the area defined by the Max Distance setting are affected by the air 
field. 
11. Max Distance: This option sets the maximum distance after which air field 
has no effect. 
12. Volume shape: You can choose one out of None, Cube, Sphere, 
Cylinder, Cone or Torus. 
13. Volume Exclusion: When Volume Exclusion is turned on, the volume 
defines the region in space where the field has no effect on particles or 
rigid bodies. 
14. Volume Offset X, Y, Z: This option offsets the volume from the location of 
the field. 
15. Volume Sweep: Volume sweep defines the extent of rotation for all 
volumes except cubes. 
16. Section Radius: Section radius defines the thickness of the solid portion 
of the torus, relative to the radius of the torus’s central ring. 
 
Drag 
This creates a Drag field which can be used to slow down the fast moving 
particles. The options for drag field are: 
1. Magnitude: Magnitude sets the strength of the drag field. 
2. Attenuation: Attenuation sets how much the strength of the field 
diminishes as distance to the affected object increases. 
3. Speed Attenuation: This option weakens the amount of drag when the 
speed of the particle is less than the Speed Attenuation value. 
Gravity 
This option creates a Gravity field which simulates the gravity. It pulls every thing 
specified direction. The available options are: 
1. Magnitude: This option sets the strength of the gravity field. The greater 
the magnitude, the faster the objects will accelerate in the direction of the 
gravitational force. 
2. Direction X, Y, Z: These options specify the direction in which the gravity 
works. 
Newton 
This option creates a Newton field which works some what like gravity but it pulls 
the thing towards its or the objects center. The options available are: 
1. Magnitude: This option sets the strength of the Newton field. A positive 
number pulls objects toward the field. A negative number pushes objects 
away. 
2. Min Distance: Min Distance sets the minimum distance from the Newton 
field at which the field is exerted. 
3. Max Distance: Max Distance sets the maximum distance from the 
Newton field at which the field is exerted. 
 



 

 

Radial 
This option creates a Radial field. The options available are: 
1. Magnitude: Magnitude sets the strength of the radial field. 
2. Attenuation: Attenuation sets how much the strength of the field 
diminishes as distance to the affected object increases. 
3. Radial Type: Radial Type specifies how the radial field’s effect diminishes 
with Attenuation. 
Distance: 
4. Use Max Distance: If you turn on Use Max Distance, connected objects 
within the area defined by the Max Distance setting are affected by the 
radial field. 
5. Max Distance: This option sets the maximum distance from the radial 
field that the field is exerted. 
Turbulence 
This option creates a Turbulence field which causes random motion. The options 
available are: 
1. Magnitude: Magnitude sets the strength of the turbulence field. You can 
use positive or negative values to move the influenced objects in random 
directions. 
2. Frequency: Frequency sets the frequency of the turbulence field. Higher 
values cause more frequent irregularities in the motion. 
3. Phase X, Y, Z: These options determine the direction of the disruption. 
4. Interpolation Type: Linear specifies a linear interpolation between values 
in the noise table. This can create noticeable breaks along lines of force. 
Quadratic interpolation creates a smoother look but requires noticeably 
more execution time. 
5. Noise Level: The Noise Level attribute specifies the number of additional 
lookups in the noise table. 
6. Noise Ratio: Noise Ratio specifies the weighting of successive lookups. 
 
Uniform 
This option creates a Uniform field. The available options are: 
1. Magnitude: This option sets the strength of the uniform field. A positive 
number pushes the influenced object away. A negative number pulls the 
object toward the field. 
2. Direction X, Y, Z: These options specify the direction the uniform field 
pushes objects. 
Vortex 
This option creates a Vortex field which produces the swirl effects. The available 
options are: 
1. Magnitude: Magnitude sets the strength of the vortex field. A positive 
number moves the influenced object counterclockwise. A negative number 
moves the object clockwise. 
2. Axis X, Y, Z: Axis specifies the axis around which the vortex field exerts 
its force. 
Volume Axis 
This option creates a Volume Axis field. The available options are: 
1. Magnitude: Magnitude specifies the strength of the volume axis field. 
2. Attenuation: This option sets how much the strength of the field 
diminishes from the central axis of the volume axis field. 



 

 

Volume Control Attributes 
3. Volume Shape: This option specifies the closed volume that defines the 
area in which the volume axis field affects particles and rigid bodies. You 
can choose from five volume shapes: cube, sphere, cylinder, cone, and 
torus. 
4. Volume Offset X, Y, Z: This option offsets the volume axis field from the 
actual location of the field. 
5. Volume Sweep: This option defines the extent of the rotation for all 
volume shapes except cube. 
6. Section Radius: This option defines the thickness of the solid portion of a 
torus volume shape. 
 
Volume Speed Attributes 
7. Invert Attenuation: When you turn on Invert Attenuation, the strength of 
the volume axis field is strongest at the edge of the volume and diminishes 
to 0 at the central axis of the volume axis field. 
8. Away From Center: You can use this attribute to create explosive effects. 
9. Away From Axis: This option specifies the speed at which particles move 
away from the central axis of cylinder, cone, or torus volumes. 
10. Along Axis: This option specifies the speed at which particles move along 
the central axis of all volumes. 
11. Around Axis: This option specifies the speed at which particles move 
around the central axis of all volumes. 
12. Directional Speed: This adds speed in the direction specified by the 
Direction XYZ attributes of all volumes. 
13. Direction X, Y, Z: This moves particles in the directions specified by the 
X, Y, and Z axes. 
 
Use Selected as Source of Field 
Use Selected as Source of Field is used to add a field to the object which creates 
a object field. 
Collision 
You can make particle objects collide with geometry. You can make particles 
split, emit new particles, die, or run a MEL script when they collide with geometry. 
There are two main types of particles: 
1. Hardware Rendered Particles: Hardware rendering of particle makes 
use of computer’s graphics hardware, and is much faster than software 
rendering. However, the quality of hardware rendered images may not 
always be as high as software rendered images. Hardware rendered 
particles have a render type of MultiPoint, MultiStreak, Numeric, Points, 
Spheres, Sprites, or Streak. 
2. Software Rendered Particles: Software rendered particles have a render 
type of Blobby Surface, Cloud, or Tube. 
Particles > Make Collide 
Make collide option makes particles collide with geometry. The options available 
in the option box are: 
1. Resilience: Resilience sets how much rebound (bounce) occurs. 
2. Friction: Friction sets how much the colliding particle’s velocity parallel to 
the surface decreases or increases as it bounces off the collision surface. 
It controls the sliding of particles. 



 

 

 
 
Particle Collision Events Editor 
Objects and Events 
Click a particle object in the Objects list to select it. All events belonging to the 
selected particle object are displayed in the Events window. 
Update Object List 
This option updates the list of objects if you have added or deleted particle 
objects while the editor is displayed. 
Selected Object 
This option displays the selected object. 
Selected Event 
This option displays the selected event. 
Set Event Name 
You can give name or edit the name of the event. 
 
CREATING/EDITING EVENT 
New Event 
You can create a new event with this button. 
All Collisions 
You can check this box to have the event occur on all collisions. 
Collision Number 
You can adjust this value to have the event occur on a specific collision number. 
 

6.4.3 Event Type 
Emit 
You can check this box to set the particle event type to Emit i.e. after collision 
new particles will be emitted. 
Split 
You can check this box to set the particle event type to Split i.e. after collision the 
colliding particle will be splited. 
Random # Particles 
You can check this box to instruct the event to use a random number of particles. 
Num Particles 
You can adjust this value to affect the number of particles involved in the event. 
Spread 
You can adjust this value to affect the spread of the particles involved in the 
event. 
Target Particle 
You can input a particle into this field to be used as a target for the event. 
Inherit Velocity 
Adjust this value to affect the percentage of velocity that particles inherit during 
the event. 
Event Actions 
Original Particle Dies 
You can check this box if you want the original particle to die during the event. 
Event Procedure 
The Event Procedure is a MEL script procedure that will be executed whenever 
any particle in the particle object that owns the event collides with an object. 



 

 

6.3 Assignment  

1. Make objects collide with geometry. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

Unit 7 Fields 
 

 

 

Time Required to Complete the unit 

 

The time required to study thus Unit is broken as follows 

1. 1st Reading: It will need 2 Hrs for reading a unit 

2. 2nd Reading with understanding:  It will need 3 Hrs for reading and understanding a unit 

3. Self Assessment:  It will need 3 Hrs for reading and understanding a unit 

4. Assignment: It will need 4 Hrs for completing an assignment 

5. Revision and Further Reading: It is continuous process 

 

 

 

 

 

 

  



 

 

7.1 Fields 
 
You can simulate the motion of natural forces with dynamic fields. Fields in Maya 
can be categorized as: Stand alone Fields, Object Fields and Volume Fields. The 
Fields available in Maya are: 
 
Air 
This creates an Air field which simulates the real life air. The options for an Air 
field are: 
Air Field Predefined Settings 
1. Wind: Wind button sets the Air Field attributes to default settings that 
approximate the effects of wind. 
2. Wake: Wake button sets the Air Field attributes to default settings that 
approximate the movement of air disrupted and pulled along by a moving 
object. 
3. Fan: Fan button sets the Air Field attributes to default settings that 
approximate a local fan effect. 
4. Magnitude: Magnitude sets the strength of the air field, which sets the 
speed along the direction the air is moving. 
5. Attenuation: Attenuation sets how much the strength of the field 
diminishes as distance to the affected object increases. 
6. Direction X, Y, Z: These options specify the direction in which the air 
blows. 
7. Speed: Speed controls how quickly the connected objects match the 
velocity of the air field. 
8. Inherit Velocity: When an air field is moving or parented to a moving 
object, Inherit Velocity specifies how much the moving air field’s velocity 
that is added to the Direction and Magnitude. 
9. Inherit Rotation: If you turn on Inherit Rotation and the air field is rotating 
or parented to a rotating object, the air flow undergoes that same rotation. 
 
Distance 
10. Use Max Distance: If you turn on Use Max Distance, connected objects 
within the area defined by the Max Distance setting are affected by the air 
field. 
11. Max Distance: This option sets the maximum distance after which air field 
has no effect. 
12. Volume shape: You can choose one out of None, Cube, Sphere, 
Cylinder, Cone or Torus. 
13. Volume Exclusion: When Volume Exclusion is turned on, the volume 
defines the region in space where the field has no effect on particles or 
rigid bodies. 
14. Volume Offset X, Y, Z: This option offsets the volume from the location of 
the field. 
15. Volume Sweep: Volume sweep defines the extent of rotation for all 
volumes except cubes. 
16. Section Radius: Section radius defines the thickness of the solid portion 
of the torus, relative to the radius of the torus’s central ring. 
 
Drag 



 

 

This creates a Drag field which can be used to slow down the fast moving 
particles. The options for drag field are: 
1. Magnitude: Magnitude sets the strength of the drag field. 
2. Attenuation: Attenuation sets how much the strength of the field 
diminishes as distance to the affected object increases. 
3. Speed Attenuation: This option weakens the amount of drag when the 
speed of the particle is less than the Speed Attenuation value. 
Gravity 
This option creates a Gravity field which simulates the gravity. It pulls every thing 
specified direction. The available options are: 
1. Magnitude: This option sets the strength of the gravity field. The greater 
the magnitude, the faster the objects will accelerate in the direction of the 
gravitational force. 
2. Direction X, Y, Z: These options specify the direction in which the gravity 
works. 
 
Newton 
This option creates a Newton field which works some what like gravity but it pulls 
the thing towards its or the objects center. The options available are: 
1. Magnitude: This option sets the strength of the Newton field. A positive 
number pulls objects toward the field. A negative number pushes objects 
away. 
2. Min Distance: Min Distance sets the minimum distance from the Newton 
field at which the field is exerted. 
3. Max Distance: Max Distance sets the maximum distance from the 
Newton field at which the field is exerted. 
Radial 
This option creates a Radial field. The options available are: 
1. Magnitude: Magnitude sets the strength of the radial field. 
2. Attenuation: Attenuation sets how much the strength of the field 
diminishes as distance to the affected object increases. 
3. Radial Type: Radial Type specifies how the radial field’s effect diminishes 
with Attenuation. 
 
Distance: 
4. Use Max Distance: If you turn on Use Max Distance, connected objects 
within the area defined by the Max Distance setting are affected by the 
radial field. 
5. Max Distance: This option sets the maximum distance from the radial 
field that the field is exerted. 
Turbulence 
This option creates a Turbulence field which causes random motion. The options 
available are: 
1. Magnitude: Magnitude sets the strength of the turbulence field. You can 
use positive or negative values to move the influenced objects in random 
directions. 
2. Frequency: Frequency sets the frequency of the turbulence field. Higher 
values cause more frequent irregularities in the motion. 
3. Phase X, Y, Z: These options determine the direction of the disruption. 
4. Interpolation Type: Linear specifies a linear interpolation between values 



 

 

in the noise table. This can create noticeable breaks along lines of force. 
Quadratic interpolation creates a smoother look but requires noticeably 
more execution time. 
5. Noise Level: The Noise Level attribute specifies the number of additional 
lookups in the noise table. 
6. Noise Ratio: Noise Ratio specifies the weighting of successive lookups. 
 
Uniform 
This option creates a Uniform field. The available options are: 
1. Magnitude: This option sets the strength of the uniform field. A positive 
number pushes the influenced object away. A negative number pulls the 
object toward the field. 
2. Direction X, Y, Z: These options specify the direction the uniform field 
pushes objects. 
Vortex 
This option creates a Vortex field which produces the swirl effects. The available 
options are: 
1. Magnitude: Magnitude sets the strength of the vortex field. A positive 
number moves the influenced object counterclockwise. A negative number 
moves the object clockwise. 
2. Axis X, Y, Z: Axis specifies the axis around which the vortex field exerts 
its force. 
Volume Axis 
This option creates a Volume Axis field. The available options are: 
1. Magnitude: Magnitude specifies the strength of the volume axis field. 
2. Attenuation: This option sets how much the strength of the field 
diminishes from the central axis of the volume axis field. 
 
Volume Control Attributes 
3. Volume Shape: This option specifies the closed volume that defines the 
area in which the volume axis field affects particles and rigid bodies. You 
can choose from five volume shapes: cube, sphere, cylinder, cone, and 
torus. 
4. Volume Offset X, Y, Z: This option offsets the volume axis field from the 
actual location of the field. 
5. Volume Sweep: This option defines the extent of the rotation for all 
volume shapes except cube. 
6. Section Radius: This option defines the thickness of the solid portion of a 
torus volume shape. 

 

7.2 Collision 

 
You can make particle objects collide with geometry. You can make particles 
split, emit new particles, die, or run a MEL script when they collide with geometry. 
There are two main types of particles: 
1. Hardware Rendered Particles: Hardware rendering of particle makes 
use of computer’s graphics hardware, and is much faster than software 



 

 

rendering. However, the quality of hardware rendered images may not 
always be as high as software rendered images. Hardware rendered 
particles have a render type of MultiPoint, MultiStreak, Numeric, Points, 
Spheres, Sprites, or Streak. 
2. Software Rendered Particles: Software rendered particles have a render 
type of Blobby Surface, Cloud, or Tube. 
 
Particles > Make Collide 
Make collide option makes particles collide with geometry. The options available 
in the option box are: 
1. Resilience: Resilience sets how much rebound (bounce) occurs. 
2. Friction: Friction sets how much the colliding particle’s velocity parallel to 
the surface decreases or increases as it bounces off the collision surface. 
It controls the sliding of particles.   

 
7.3 Instancer 
Instancer replaces the traditional particles with an object you select. You can 
apply the particle instancer two or more times to the same particle object. The 
options available are: 
1. Particle Instancer Name: You can provide name for the instancer. 
2. Rotation Units: If you set the Rotation settings for particles, this option 
specifies whether the value is interpreted as degrees or radians. 
3. Rotation Order: If you set the Rotation settings for particles, this option 
sets the precedence order of rotation, for instance, XYZ, XZY, or ZXY. 
4. Level of Detail: This option sets whether the source geometry appears at 
the particle locations or whether a bounding box or boxes appear instead. 
5. Cycle: Cycle changes the instanced objects with time. 
a. None: If none is selected, it instance a single object. 
b. Sequential: If sequential is selected, it cycle through the objects in 
the Instanced Objects list. 
6. Cycle Step Unit: If you’re using an object sequence, select whether 
frames or seconds are used for the Cycle Step Size value. 
7. Cycle Step Size: If you’re using an object sequence, enter the particle 
age interval at which the next object in the sequence appears. 

 

 

7.4 Assignment 

1. Pool Table 

 

Unit 8 Rigid-body Dynamics  



 

 

 

 

Time Required to Complete the unit 

 

The time required to study thus Unit is broken as follows 

1. 1st Reading: It will need 2 Hrs for reading a unit 

2. 2nd Reading with understanding:  It will need 3 Hrs for reading and understanding a unit 

3. Self Assessment:  It will need 3 Hrs for readng and understanding a unit 

4. Assignment: It will need 4 Hrs for completing an assignment 

5. Revision and Further Reading: It is continuous process 

 

 

 

 

 

  



 

 

8.1 Rigid - body Dynamics 

Rigid bodies 
A rigid body is a polygonal or NURBS surface converted to an unyielding shape. 
Rigid bodies collide rather than pass through each other during animation. To 
animate rigid body motion, you use fields, keys, expressions, rigid body 
constraints, or collisions with particles. 
Maya has two kinds of rigid bodies—active and passive. An active rigid body 
reacts to dynamics—fields, collisions, and springs—not to keys. A passive rigid 
body can have active rigid bodies collide with it. You can key its Translate and 
Rotate attributes, but dynamics have no effect on it. 
Note: You can make a rigid body collide inside another. Place the object inside 
the other object; reverse the normals or surface of the outer object, then animate 
the inner object in an outward direction. 
 

8.1.1 Create Active/Passive Rigid Body 
This option creates an active rigid body. The attributes/options of a rigid body 
are: 
1. Rigid Body Name: You can assign a name to rigid body for easy 
identification. 
2. Active: This attribute makes the rigid body an active rigid body. If this 
option is off, the rigid body is passive. 
3. Particle Collision: If you’ve made particles collide with the surface and 
the surface is an active rigid body. 
4. Mass: This attribute sets the mass of an active rigid body. Maya ignores 
the mass attribute of passive rigid bodies. 
5. Center of Mass X, Y, Z: This attribute specifies the position of an active 
rigid body’s center of mass in local space coordinates. 
6. Static Friction: This option sets how much a rigid body resists moving 
from resting contact with another rigid body. Static friction has little or no 
effect after an object is moving. 
7. Dynamic Friction: Dynamic Friction sets how much a moving rigid body 
resists movement against another rigid body’s surface. 
8. Bounciness: Bounciness sets the resilience of the rigid body. 
9. Damping: Damping sets an opposing force against the rigid body’s 
movement. A positive value diminishes movement where as a negative 
value increases movement. 
10. Impulse X, Y, Z: This option creates an instantaneous force, with 
magnitude and direction, on the rigid body at the local space position 
specified in Impulse Position X, Y, Z. 
11. Impulse Position X, Y, Z: This option specifies the position in the rigid 
body’s local space where the impulse strikes. 
12. Spin Impulse X, Y, Z: This option applies an instantaneous rotational 
force on the rigid body’s center of mass in the direction you specify by the 
X, Y, and Z values. 
 
 
Initial Settings attributes 
13. Initial Spin X, Y, Z: This option sets the initial angular velocity of the rigid 
body. 



 

 

14. Initial Position X, Y, Z: This option sets the initial position of the rigid 
body in world space. 
15. Initial Orientation X, Y, Z: This option sets the initial local space 
orientation of the rigid body. 
16. Initial Velocity X, Y, Z: This option sets the initial speed and direction of 
the rigid body. 
17. Collision Layer: You can use collision layers to create exclusive groups 
of objects that collide with each other. Only rigid bodies with the same 
collision layer number can collide with each other. 
Tip: A value of '-1' in the collision layer makes it a universal collision 
object. 
18. Collisions: This option tells Maya whether to calculate collisions for the 
object or not. 
 

8.1.2 Solvers > 

Rigid Body Solver Attributes 
Dynamic animation of rigid bodies and rigid body constraints is controlled by a 
Maya component called a rigid body solver. Dynamic animation of rigid bodies 
refers to motion created by fields and collisions. You can change attributes of the 
rigid body solver to adjust aspects of the dynamic animation. Select Solver > 
Rigid Body Solver Attributes to edit the rigid body solver attributes. 
 
Rigid Solver Attributes 
Step Size: Sets how often within a frame the rigid body calculations occur. For 
example, if each frame of the animation is 0.1 seconds and the Step Size is 
0.033 seconds, the solver calculates rigid body animation three times in the 
frame. 
Generally, decreasing the Step Size value improves rigid body animation 
accuracy but slows scene play. If you have fast-moving rigid bodies that don’t 
collide as expected, decrease the Step Size. This is a nonkeyable attribute 
available in the Attribute Editor only. 
Collision Tolerance: Sets how accurately and quickly a rigid body solver detects 
collisions. Generally, smaller Collision Tolerance values increase the calculation 
time and collision accuracy. A small Collision Tolerance is often necessary to 
create accurate collisions involving tiny or thin objects. This is a nonkeyable 
attribute available in the Attribute Editor only. 
Scale Velocity: Scale Velocity is used with the Display Velocity attribute. If you 
turn on Display Velocity, a moving rigid body displays a velocity arrow icon that 
represents the magnitude and direction of the rigid body motion. You can change 
the Scale Velocity to scale the arrow. 
Start Time: Sets the Time Slider frame when the solver starts animating 
dynamics for the rigid bodies it controls. 
Current Time: Lets you speed up or slow down dynamic animation for all rigid 
bodies connected to the solver. Current Time works the same for rigid bodies as 
it does for particle objects. 
Current Rigid Solver 
If there are more than one solver and you want any one of them as a Current 
Rigid Solver then from Solver > Current Rigid Solver > select the solver from 
the list. 
 



 

 

Create Rigid Body Solver 
Create a new Rigid Body Solver and makes it current. 
Set Rigid Body Interpenetration 
Set Rigid Body Collision 
 
 

8.2 Soft - body Dynamics 
Soft bodies 
You can recreate a geometric object as a flexible object called a soft body. You 
can use various animation techniques to make the soft body bend, ripple, and 
bulge like soft objects in nature. When you make a soft body from geometry or a 
lattice, Maya creates a corresponding particle object. The combination of the 
geometry and particles is a soft body. The particle object has one particle for 
each CV or vertex in the geometry. 
 

8.2.1 Create Soft Body 
This option creates a soft body. The attributes/ options available are: 
1. Make Soft: This option converts the object to a soft body. 
2. Duplicate, Make Copy Soft: Makes a copy of the object a soft body 
without altering the original object. 
3. Duplicate, Make Original Soft: This option works like Duplicate, Make 
Copy Soft, except it makes the original object a soft body, and makes a 
copy of the original object. 
4. Hide Non-Soft Object: If you turn on this option, the object that’s not a 
soft body is hidden. 
5. Make Non-Soft a Goal: Turn this option on to make the soft body trail or 
move towards the goal object made from the original or duplicate 
geometry. 
6. Weight: This option sets how closely the soft body follows the goal object 
made from the original or duplicate geometry. 
 
Paint Soft Body Weights Tool 
Using the Paint Soft Body Weights Tool, you can set goal weights on a soft body 
on a per particle basis by painting on the soft body surface. The tool provides 
color feedback so you know which parts of the soft body have particles with 
different goal weights. Weights display as a range of grayscale values, with a 
weight of 1 displaying as white and 0 as black. 
Select the soft body you want to paint goal weights on. The soft body must have 
been created with goal weights. Select the Paint Soft Body Weights Tool and 
open the Tool Settings editor (Soft/Rigid Bodies > Paint Soft Body Weights 
Tool > ). 
The Paint Soft Body Weights Tool automatically detects the soft body and 
goalPP attributes and selects the soft body for painting. 
There are attributes unique to the Paint Soft Body Weights Tool in the Paint 
Attributes section. These unique attributes are described below. 
Paint Attributes 
These are descriptions of the attributes in the Paint Attributes section. 
 
Displays the name of the particle node selected to paint and the attribute you are 



 

 

painting (goalPP weights). To select another particle node to paint, click this 
button and select the appropriate particle node goalPP weights name. By default, 
the tool selects the first particle node it detects. 
When you select the soft body, the Paint Soft Body Weight Tool automatically 
detects the particle node and goalPP attribute on the soft body. The name of the 
node and attribute displays on the top button. 
 
Filter: particle: Sets a filter so that only particle nodes display on the menu for 
the button above this one. You are painting particle goalPP weights with the 
Paint Soft Body Weights Tool, so you do not need to change this filter unless you 
want to paint other types of attributes. 
 
Paint Operation: Select an operation to define how you want painted goalPP 
values to be affected. 
 
Replace: Replaces the goalPP values for the soft body particles you paint 
over with the specified Value and Opacity. 
 
Add: Adds the specified Value and Opacity to the current goalPP values 
you paint over. If the value is negative (possible if you set Min or Max to a 
negative value), the value actually decreases. 
 
Scale: Scales the current goalPP values you paint over by the Value and 
Opacity factors. 
 
Smooth: Changes the goalPP values to be the average values of the 
surrounding goalPP values. 
 
Value: Set the value to apply when you perform any of the painting operations. 
 
Min/Max Value: Set the minimum and maximum possible paint values. By 
default, you can paint values between 0 and 1. Setting the Min/Max Values you 
can extend or narrow the range of values. Negative values are useful for 
subtracting weight. For example, if you set Min Value to -1, Value to -0.5, and 
select Add for the operation, you would subtract 0.5 from the weight of vertices 
you paint. Positive values are added. 
 
Tip: To help you differentiate paint values when you paint with ranges greater 
than 0 to 1 (for example, -5 to 5), and to maximize the range of values that 
display when you paint values with ranges between 0 to 1 (for example, 0.2 to 
0.8), set Min Color and Max Color (in the Display section) to correspond with the 
Min/Max values. 
 
Clamp: Select whether you want to clamp the values within a specified range 
when you paint, regardless of the Value set. 
 
Lower: Turn this on to clamp the lower value to the Clamp Value specified 
below. For example, if you clamp Lower and set the lower Clamp Value to 
0.5, the values you paint will never be less than 0.5, even if you set the 
Value to 0.25. 



 

 

 
Upper: Turn this on to clamp the upper value to the Clamp Value specified 
below. For example, if you clamp Upper, set the upper Clamp Value to 
0.75, and set Value to 1, the values you paint will never be greater than 
0.75. 
 
Clamp Values: Set the Lower and Upper values for clamping. 
 
Flood: Click Flood to apply the brush settings to all the particle goals on the 
selected soft body. The result depends on the brush settings defined when you 
perform the flood. 
 
Vector Index: If you are painting a three channel attribute (RGB or XYZ), select 
the channel you want to paint. Soft body goalPP weight is a single channel 
attribute, therefore you do not need to change this setting. 
 
Springs 
You can add springs to a soft body’s particles to give the soft body internal 
structure and improve your deformation control. You can also add springs to 
regular particles to give them reactive, interconnected motion. 
Note: You can also create springs on emitted particles. This provides a cohesive 
mass of particles, for example, a gas cloud. 
 

8.2.2 Create Springs 
This option creates a spring. The available options are: 
1. Spring Name: You can assign a name to the spring for easy identification 
in the Outliner. 
2. Add to Existing Spring: This option adds springs to an existing spring 
object rather than a new one. 
3. Don’t Duplicate Springs: If this is on, it avoids creating a spring between 
two points if a spring already exists there. 
Spring Attributes 
4. Stiffness: Stiffness sets the rigidity of the spring constraint. The greater 
the value, the greater the force the spring exerts on the object for the 
same displacement. 
5. Damping: Damping mutes the spring action. A high value brings the 
springs to rest faster. 
6. End1 Weight: This option sets the amount of the spring’s force applied to 
the spring’s starting point. 
7. End2 Weight: This option sets the amount of the spring’s force applied to 
the spring’s ending point. 
The Dynamic relationship editor 
The Dynamic Relationships Editor lets you connect and disconnect dynamic 
relationships between objects and fields, emitters, and collisions. You can display 
the Dynamic Relationships Editor as a separate window or as a panel in the 
workspace. 
From the menu bar, select Window >Relationship Editors > Dynamic 
Relationships.  
Or 
From the Panels menu of the current panel, select Panel > Dynamic 



 

 

Relationships. To display the Dynamic Relationships Editor. 
 

8.3 Assignment 

1. Pool Table 
2. Pool Table - LAB 
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Time Required to Complete the unit 

 

The time required to study thus Unit is broken as follows 

1. 1st Reading: It will need 2 Hrs for reading a unit 

2. 2nd Reading with understanding:  It will need 3 Hrs for reading and understanding a unit 

3. Self Assessment:  It will need 3 Hrs for reading and understanding a unit 

4. Assignment: It will need 4 Hrs for completing an assignment 

5. Revision and Further Reading: It is continuous process 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

9.1 Fluid Effects 

Maya Fluid Effects is a technology for realistically simulating and rendering fluid 
motion. Fluid Effects lets you create a wide variety of 2D and 3D atmospheric, 
pyrotechnic, space, and viscous liquid effects. You can use the Fluid Effects 
solvers to simulate effects, or you can use fluid animated textures for more 
unique, distinguishing effects. 
 

9.1.2 Types of fluids 
In Maya, there are three basic types of fluid effects: 
• Dynamic fluid effects: Dynamic fluid effects behave according to the 
natural laws of fluid dynamics, a branch of physics that uses mathematical 
equations to calculate how things flow. For dynamic fluid effects, Maya 
simulates fluid motion by solving the Navier-Stokes fluid dynamics 
equations at each time step. You can texture dynamic fluids, apply forces 
to them, and have them collide with and move geometry, affect soft 
bodies, and interact with particles. 
• Non-dynamic fluid effects: 3D fluids inherently require extra data to 
define them, which can make them very large. This extra data can slow a 
dynamic simulation exponentially because more calculations must be 
performed at every step of the simulation. For a less memory intensive 
effect, you can use a 2D fluid, or you can create a non-dynamic fluid. Nondynamic 
fluid effects do not use the fluid solvers to simulate fluid motion. 
For non-dynamic fluid effects, you create the look of fluid using textures 
and you create fluid motion by animating texture attributes. 
• Oceans and Ponds: You can create Ocean and Pond fluids to simulate 
large realistic water surfaces, such as stormy oceans with foam and 
swimming pools. Oceans are NURBS planes with ocean shaders 
assigned to them. Ponds are 2D fluids that use a spring mesh solver and 
a height field. Also, you can add Wakes to Oceans and Ponds to create 
boat wakes, add additional turbulence, or generate bubbling and ripple. 
The components of a fluid are: 
 

9.1.3 Fluid containers 
A fluid container is a rectangular 2D or 3D boundary that defines the space in 
which the fluid exists. Fluid effects cannot exist outside a container. The fluid 
container is the principle component for any dynamic or non-dynamic fluid effect. 
Fluid containers are divided into three dimensional grids, and each unit of one of 
these grids is called a voxel. To create a fluid effect, you need to add contents to 
the container and then modify the look and behavior of the fluid by modifying the 
container attributes. 
1. 2D containers: A 2D fluid container is a 3D fluid container with a depth of 
one voxel. 
2. 3D containers: A 3D fluid container is a fluid container with a depth of two 
or more voxels. 



 

 

Fluid emitters 
You can add fluid properties to a fluid container using a fluid emitter. A fluid 
emitter creates fluid property values and populates the voxels of a grid with those 
values as a simulation plays. The fluid emitter must be within the bounds of the 
fluid container to emit. 
 
Container contents 
You define a fluid effect by putting values for any or all of the following fluid 
properties into its container: Density, Velocity, Temperature, Fuel, and Color. You 
can use different methods to define these properties, depending on the effect you 
want and whether the effect is dynamic or non-dynamic. 
1. Density: Density represents the material property of the fluid in the real 
world. 
2. Velocity: Velocity affects the behavior of dynamic fluids by moving 
Density, Temperature, Fuel, and Color values inside the container. 
Velocity has both magnitude and direction values. Direction defines the 
moving fluid values’ path. 
3. Temperature: Temperature affects the behavior of a dynamic fluid, 
causing it to rise or react. 
4. Fuel: For dynamic fluids, Fuel combined with Density creates a fluid 
where a reaction can take place. Density values represent the substance 
being reacted, and Fuel values describe the state of the reaction. 
Temperature can ignite Fuel to start a reaction. During the course of the 
reaction, the Density and Fuel values get smaller until the reaction is 
complete. 
5. Color: This property applies color to Density. Color appears only where 
there is Density. There are two ways to color fluids: 
a. Using the built-in shader color: The shader is built into the fluid 
making this an efficient way to color your fluids. 
b. Using grids: Grids give you control over where color is placed in 
each voxel. You can also make color behave dynamically, which 
means you can make colors interact and mix. 
 
Defining the contents of a fluid container 
There are two ways you can define a fluid property for a fluid container: 
1. Preset gradients: You can set the property values of a fluid container as 
predefined gradients. Predefined gradients are sets of values in the form 
of gradients that are provided with Maya. Predefined gradient property 
values stay constant over time and they require no calculations at render 
time; making them render more quickly than dynamic grid fluid properties. 
2. Grids: When you define a fluid property as a grid, you can place different 
property values in each individual grid unit called a voxel (volume pixel). 
Grids give you precise control over what the values are in the container. 
 
Fluid Effects > Create 2D Container 
Create 2D container creates an empty 2D container for fluids. The options 
available in the option box are: 
1. X, Y Resolution: These options define the resolution of the fluid in voxels. 
Higher resolutions produce finer detail, but increase rendering time and 
slow the interactive simulation. 



 

 

2. X, Y, Z Size: Define the physical dimensions of the fluid container in the 
working units set for Maya. 
 
Fluid Effects > Create 2D Container with Emitter 
This command creates a 2D container for fluids with an Emitter. The options 
available in the option box are: 
1. Emitter Name: You can provide a name for the emitter. 
2. Parent to Container: Turn this option on to parent the emitter to the 
container. When the emitter is parented to the container, selecting the 
container automatically selects the emitter automatically. 
 
Basic Emitter Attributes: 
3. Emitter Type: You can set the emitter type for the fluids. The available 
types are Omni and volume emitters. 
4. Density Rate (/Voxel/Sec): This option sets the average rate at which 
Density values are emitted into the grid voxels per second. 
5. Heat Rate (/Voxel/Sec): This option sets the average rate at which 
Temperature values are emitted into the grid voxels per second. 
6. Fuel Rate (/Voxel/Sec): This option sets the average rate at which Fuel 
values are emitted into the grid voxels per second. 
7. Fluid Dropoff: This option sets the dropoff value for fluid emission. 
8. Cycle Emission: Cycling emission restarts the random number stream 
after an interval in frames, specified by the Cycle Interval attribute. 
9. Cycle Interval: This option specifies the number of frames between 
restarts of the random number stream. 
Distance Attributes: 
10. Max Distance: Maximum distance at which new property values are 
created from emitter. 
11. Min Distance: Minimum distance at which new property values are 
created from emitter. 
 
Volume Emitter Attributes: 
12. Volume Shape: This setting sets the shape of volume the emitter will use 
if the emitter is of volume type. 
13. Volume Offset X, Y, Z: This is the parent attribute for the translational 
offset of the emission volume's center from the emitter's origin. 
14. Volume Sweep: The arc of the volume emission. Used for sphere, cone, 
cylinder and torus. 
15. Section Radius: This setting applies to torus volumes only. This defines 
the radius of a section of the torus. 
 
Add/Edit Contents > Gradients 
This option will add gradient to the container. 
 
Density/Velocity/Temperature/Fuel: You can turn on the properties you 
want to be represented by gradients. You must select at least one property. 
1. Density/Velocity/Temperature/Fuel Gradient: You can select which 
predefined set of values you want to place in the container: 
2. Constant: This option sets the value to 1 throughout the fluid. 
3. X Gradient: This option sets a ramp of values from 1 to 0 along the X 



 

 

axis. 
4. Y Gradient: This option sets a ramp of values from 1 to 0 along the Y 
axis. 
5. Z Gradient: This option sets a ramp of values from 1 to 0 along the Z axis. 
6. -X Gradient: This option sets a ramp of values from 0 to 1 along the X 
axis. 
7. -Y Gradient: This option sets a ramp of values from 0 to 1 along the Y 
axis. 
8. -Z Gradient: This option sets a ramp of values from 0 to 1 along the Z 
axis. 
9. Center Gradient: This option sets a ramp of values from 1 at the center, 
to 0 along the edges. 
 
Add/Edit Contents > Initial States 
This Initial State Options window lets you set the resolution of your fluid to that of 
an example fluid’s initial state. The options available are: 
Fluid Resolution: 
1. As Is: This setting sets the fluid example’s resolution to that of the current 
fluid container’s initial state. 
2. From Initial State: This setting sets the current fluid container’s resolution 
to that of the fluid example’s initial state. 
 
Make Collide 
Make Collide turns on the collision between the selected object and fluids. The 
option in the option box is: 
1. Tessellation Factor: Maya internally converts NURBS objects to 
polygons before it animates the simulation. The Tessellation Factor sets 
the number of polygons created during the conversion. 
 
Make Motion Field 
Motion fields let you accurately simulate objects moving through a fluid. This field 
applies a force to its parent object, so that the object then appears to move or 
push its fluid. For example, for the animation of a boat pulling a water-skier 
through a fluid, you can apply a motion field to the boat and the water-skies so 
that they appear to push through the water while they are in motion. 
The attributes available in the attribute editor are: 
 
Basic Emitter Attributes 
1. Emitter Type 
a. Omni: This sets the emitter type to an Omni directional point emitter. 
b. Surface: This emits fluid properties from randomly distributed positions 
on or near a NURBS or polygonal surface. When you emit from an 
object, the emitter is a surface emitter. 
c. Curve: This emits fluid properties from randomly distributed positions 
on or near a curve. 
d. Volume: This emits fluid properties from a closed volume. You pick the 
shape from the Volume Shape option. 
 
Fluid Attributes 
2. Fluid Emission Turbulence 



 

 

Turbulence Type: Select the type of turbulence to apply to fluid 
emission. 
a. Gradient: This option applies turbulence that ranges smoothly 
through space. 
b. Random: This option applies random turbulence. 
3. Turbulence: The intensity of a force simulating a turbulent wind that 
evolves over time. 
4. Turbulence Speed: The rate of change of the turbulence over time. To 
animate this, attach a new time node to the time input and animate the 
time value on the time node. 
5. Turbulence Freq: This option controls how many repeats of the 
turbulence function fit inside the bounding volume of the emitter. Low 
values create a very smooth turbulence. 
6. Turbulence Offset: Use this option to translate the turbulence within the 
volume. Animating it can simulate blowing turbulent wind. 
 
Texturing Fluids 
Procedural texturing capabilities are built into the fluid container. You can apply 
the built-in noise textures to both dynamic and non-dynamic fluid effects. By 
animating textures set for non-dynamic fluids, you can produce beautiful effects 
that take much less time to render than dynamic effects. 
 
Fluids as textures 
You can create 2D and 3D fluid textures and map them to surface shaders. The 
fluid can be dynamic or non-dynamic. 
 
2D fluid textures 
Mapping a 2D fluid texture to a surface shader creates the fluid pattern on the 
surface. 
 
3D fluid textures 
When you map a 3D fluid texture to a surface shader, the geometry that the 
surface is assigned to must be inside the fluid container for the texture to render. 
The texture renders only where Density contacts the surface geometry. 
 
Fluids as materials 
You can create a fluidShape in Hypershade and assign it to any volume primitive 
node using the volumetric Fluid Shape material. This is possible because a 
fluidShape is actually both a volume shader and a volume shape node. 
 
Fluids Effects 
The attributes which define the basic characteristics of the fluid container are: 
1. Resolution: This attribute defines the resolution of the fluid container in 
voxels. 
2. Size: This attribute defines the size of the fluid container in world space 
units. 
3. Boundary X, Y, Z: The boundary attributes control the way the solver 
treats property values at the boundaries of the fluid container. 
a. None: This makes all boundaries of the fluid container open so that 
fluid behaves as though the boundary isn’t there. 



 

 

b. Both Sides: This closes both boundaries of the fluid container so 
they act like walls. 
c. -X, -Y, or -Z Side: This closes the -X, -Y, or -Z boundary, 
respectively, so it acts like a wall. 
d. X, Y, or Z Side: This closes the X, Y, or Z boundary, respectively, 
so it acts like a wall. 
e. Wrapping: This attribute causes the fluid flowing off one side of the 
fluid container to enter at the opposite side. This can be useful if 
you want to have a windy fog, but you do not want to continually 
replenish the Density at the in-flowing regions. 
4. Color Method: Color displays and renders only where Density is defined. 
Select which method to use to define color. 
a. Use Shading Color: This defines color using the Color ramp 
attribute in the Shading section of the Attribute Editor. 
b. Static Grid: This creates a color grid which you can populate with 
specific color values. While these values can be used in dynamic 
simulations, they cannot change due to any dynamic simulation. 
c. Dynamic Grid: This creates a color grid which you can populate 
with specific color values for use in a dynamic simulation. 
5. Falloff Method: This adds falloff edges to the display of fluids, so that you 
can prevent the fluid from appearing in part of the volume. 
 
Dynamic Simulation: To simulate flow for a fluid property, the Contents 
Method for that property must be set to Dynamic Grid and Velocity cannot be 
off. 
6. Gravity: The Gravity setting is a built-in gravitational constant that 
simulates the gravitational attraction of the mass of the world in which the 
simulation is occurring. 
7. Viscosity: Viscosity represents the resistance of the fluid to flow, or how 
thick, and non-liquid the material is. When this value is high, the fluid flows 
like tar. When this value is small, the fluid flows more like water. 
8. Friction: Friction defines internal friction used in Velocity solving. 
9. Damp: Damp defines the amount the Velocity solution is damped towards 
zero at each time step. Small amounts of damping can be useful when 
boundaries are open to keep strong winds from building up and leading to 
instability. 
10. Start Frame: This attribute sets the frame after which the fluid simulation 
will start. Nothing will play back for this object prior to this frame. You 
could use this attribute to delay the effect of a field on a fluid until the 
frame of your choice. 
11. Conserve Mass: Turn this option on to conserve mass when updating the 
Density values during solving. 
12. Use Collisions: Turn this option off to disable the collision of fluid with 
collision geometry in the container. 
13. Use Emission: Turn this option to off to ignore all connected fluid emitters 
during simulation. 
14. Use Fields: Turn this option to off to ignore all connected external fields 
during simulation. 
 

9.1.4 Create 3D Container with Emitter 



 

 

This command creates a 3D container for fluids with an Emitter. The options 
available are: 
1. Emitter Name: You can provide a name for the emitter. 
2. Parent to Container: Turn this option on to parent the emitter to the 
container. When the emitter is parented to the container, selecting the 
container automatically selects the emitter automatically. 
 
Basic Emitter Attributes: 
3. Emitter Type: You can set the emitter type for the fluids. The available 
types are Omni and volume emitters. 
4. Density Rate (/Voxel/Sec): This option sets the average rate at which 
Density values are emitted into the grid voxels per second. 
5. Heat Rate (/Voxel/Sec): This option sets the average rate at which 
Temperature values are emitted into the grid voxels per second. 
6. Fuel Rate (/Voxel/Sec): This option sets the average rate at which Fuel 
values are emitted into the grid voxels per second. 
7. Fluid Dropoff: This option sets the dropoff value for fluid emission. 
8. Cycle Emission: Cycling emission restarts the random number stream 
after an interval in frames, specified by the Cycle Interval attribute. 
9. Cycle Interval: This option specifies the number of frames between 
restarts of the random number stream. 
 
Distance Attributes: 
10. Max Distance: Maximum distance at which new property values are 
created from emitter. 
11. Min Distance: Minimum distance at which new property values are 
created from emitter. 
 
Volume Emitter Attributes: 
12. Volume Shape: This setting sets the shape of volume the emitter will use 
if the emitter is of volume type. 
13. Volume Offset X, Y, Z: This is the parent attribute for the translational 
offset of the emission volume's center from the emitter's origin. 
14. Volume Sweep: The arc of the volume emission. Used for sphere, cone, 
cylinder and torus. 
15. Section Radius: This setting applies to torus volumes only. This defines 
the radius of a section of the torus. 
 

9.1.5 Fluids | Oceans 
An ocean is defined by a flat surface with an ocean shader assigned to it. Fluid 
Effects simplifies the process of creating an ocean by providing a single 
command that creates a plane that is optimized for best results and an ocean 
shader, with appropriate connections. The ocean plane is a NURBS plane with 
more detail concentrated in the center so you can have the ocean extend to the 
horizon, but see a reasonable resolution locally. Since interactive shading would 
slow down playback, the shading is turned off for the surface. You need a 
preview plane to see displacement and shading in hardware display. 
 
Wakes 
A Wake is a fluid container with a Spring Mesh solver. A fluid emitter is used to 



 

 

drive the motion of the Wake fluid. With Wakes you can create boat wakes, add 
additional turbulence to an ocean, or generate bubbling and ripple. Ocean Wakes 
differ from Pond Wakes. For Oceans, a Wake is a fluid texture with a Spring 
Mesh solver that adds additional displacement and/or foam to the Ocean shader. 
For Ponds, a Wake is a 2D fluid with a Spring Mesh solver that is rendered 
directly as a fluid. 
 
Floating objects 
You can float objects in your Oceans and Ponds using fluid locators. You can 
add these locators to objects individually, or you can use commands in the 
Ocean or Pond menus to quickly create a buoy, float an object, or make a boat. 
Fluid locators are connected to the displacement channel of fluid waves and are 
controlled by predefined expressions. These expressions define the attributes 
that control the movement of the target object. 
 
Fluid Effects > Ocean > Create Ocean 
Create Ocean command creates an ocean. The options for creating an ocean 
are: 
1. Attach to Camera: Turn this option on to attach the ocean to the camera. 
Attaching the ocean automatically scales and translates the ocean based 
on the camera, thus maintaining an optimum amount of detail for the given 
point of view. 
2. Create Preview Plane: Turn this option on to create a preview plane that 
shows a shaded patch of the ocean with displacement in shaded display 
mode. You can scale and translate it to preview different parts of the 
ocean. If you do not create this plane at the time you create the ocean, 
you can create the plane later by selecting the ocean plane and then 
selecting Fluid Effects > Ocean > Add Preview Plane. 
 
Fluid Effects > Ocean > Add Dynamic Locator 
Dynamic locators follow the motion of the ocean in the Y direction, but 
additionally react appropriately to dynamic attributes. You can parent Dynamic 
Locator to an object in the scene. 
 
Fluid Effects > Ocean > Add Boat Locator 
Boat locators follow the motion of the ocean in the Y direction, but additionally 
rotate in X and Z to allow the boat to pitch and roll in the waves. 
 
Fluid Effects > Ocean > Float Selected Objects 
You can make an object float by adding a dynamic locator to it. Dynamic locators 
follow the motion of the ocean in the Y direction and also react to dynamic 
attributes such as buoyancy, gravity, and damping. 
 
Fluid Effects > Ocean > Make Boats 
You can make an object float like a boat by adding a boat locator to it. Standard 
boat locators behave like dynamic locators, but also rotate in X and Z. 
 
Fluid Effects > Ocean > Make Motor Boats 
You can make an object float like a boat by adding a boat locator to it. Motor boat 
locators include throttle, rudder and roll attributes to realistically simulate the 



 

 

motion of a motor boat. 
 
Fluid Effects > Ocean > Create Wake 
Create Wake create an ocean wake. The options available are: 
1. Wake Size: Wake Size sets the size attribute of the Wake fluid. 
2. Wake Intensity: This value determines the magnitude of the wakes. In the 
fluid emitter attributes, this value is Density/Voxel/Second. 
3. Foam Creation: This value determines the amount of foam generated by 
the fluid emitter. In the fluid emitter attributes, this value is the 
Heat/Voxel/Second. For Oceans, this value directly affects the foam. 
 
Ocean Shader / Ocean Texture 
The Ocean texture can be used to simulate a range of water wave patterns, from 
small scale waves in a bathtub to large stormy sea swells. It is designed to be 
used as a displacement map. The Ocean shader simulates the way color 
changes with light and view angle for an ocean effect. 
The attributes of Ocean shaders are: 
1. Scale: Scale controls the size in meters that corresponds to the 0 to 1 
texture space in UV. 
2. Time: You can use this attribute to animate the Ocean texture. You can 
keyframe the Time attribute to control the rate and amount of change of 
the ocean texture in your scene. 
3. Wind UV: Wind UV controls the average direction that the waves will 
travel, simulating the effect of wind. 
4. Wave Speed: This attribute defines how fast waves move. 
Tip: To freeze the waves, make the speed zero. 
5. Num Frequencies: This attribute controls the number of interpolated 
frequencies between Wave Length Min and Wave Length Max. 
6. Wave Length Min: This attribute controls the minimum length of waves in 
meters. 
7. Wave Length Max: This attribute controls the maximum length of waves 
in meters. 
8. Wave Height: This attribute controls the size of waves relative to their 
wave length. 
9. Wave Turbulence: This attribute controls the amount of turbulence at 
different wave frequencies. 
10. Wave Peaking: This attribute controls the amount of crest formation for 
waves across the range of wave frequencies. Wave Peaking simulates a 
side to side sloshing of waves, as opposed to up-down motion. Wave 
Turbulence must be non-zero for this attribute to have an effect, as it is 
only applied to the turbulent waves. 
11. Foam Emission: This attribute controls the density of foam generated 
above the Foam Threshold. The Foam Emission value is output to the 
outFoam attribute, which can be used to define opacity of a layered foam 
shader. 
12. Foam Threshold: This attribute controls the Wave Amplitude required to 
generate foam and how long the foam will last. 
13. Foam Offset: This option adds uniform foam everywhere. It is useful 
when you need to add a custom foam texture. 
14. Water Color: This attribute defines the basic color of the surface. 



 

 

15. Foam Color: This attribute defines the color of the foam layer. Part of the 
simulated foam might be considered submerged, in which case the color 
is blended with the material color. 
16. Transparency: This attribute controls how transparent or opaque the 
material is. Black means completely opaque and white means completely 
transparent. 
17. Refractive Index: This attribute defines how much a ray of light will bend 
when it passes through an object. This attribute only works if your material 
is partially or completely transparent, refractions are turned on, and you 
are rendering using Ray Tracing. 
18. Diffuse: This attribute controls how much of the light in the scene is 
scattered from the object. Most materials absorb some of the light falling 
on them, and scatter the rest. 
19. Trough Shadowing: This attribute darkens the diffuse color in the wave 
troughs. This can simulate certain lighting conditions where wave peaks 
are brighter, scattering light. This attribute works well when the wave color 
is in a blue-green range. 
20. Environment: This attribute defines a simple sky to ground environmental 
reflection using a ramp. The left of the ramp is the top of the sky and the 
right is the bottom. 
21. Refractions: Turn on Refractions to make your material refract light when 
you are rendering with Ray Tracing. 
 

9.1.6 Fluid | Ponds 
Ponds are 2D fluids that use a spring mesh solver and a height field. With the 
pond options and attributes, you can set the size and color of your fluid surface. 
You can generate waves, bubbles, and ripples in the fluid surface using Wakes. 
Increasing the size of your pond extends the range of your waves and ripples. 
 
Fluid Effects > Pond > Create Pond 
Create Pond creates a pond fluid in the scene. The available option is: 
1. Size: This option defines the size of your Pond fluid. The size of the Pond 
can be modified by using the container properties of the Pond fluid shape. 
 
Fluid Effects > Pond > Create Wake 
The options available for the pond wake are: 
1. Wake Size: The size of the Wake fluid is determined by the size attribute 
of the Pond fluid container. 
2. Wake Intensity: This value determines the magnitude of the wakes. In the 
fluid emitter attributes, this value is Density/Voxel/Second. 
3. Foam Creation: This value determines the amount of foam generated by 
the fluid emitter. In the fluid emitter attributes, this value is the 
Heat/Voxel/Second. 

 
 
9.2 Maya Cloth 
With Maya Cloth, you can create realistic animated cloth within the Maya 
environment. Maya Cloth gives you the ability to model garments for any 



 

 

animated 3D figure, apply dynamic effects, and simulate the cloth behavior. In 
addition to clothing characters, you can create many other types of cloth 
animation, including sheets, bedding, drapery, flags, and fabric goods of all 
kinds. 
 

9.2.1 Creating Cloth 
With Cloth, you can create a simple piece of cloth, such as a tablecloth or flag, or 
a complicated article of clothing that is fitted on a model. 
 
Draping and fitting 
After you create the garment, you drape it and fit it to the character. To drape the 
garment on the model, you specify the model as a collision object and use the 
cloth solver to drape the garment over the model. Fitting involves modifying the 
original garment to accommodate peculiarities of the character on which it is 
draped. You can influence how the cloth settles on the character using 
constraints and dynamic fields. 
 
Applying properties to cloth in Maya 
Cloth properties work much like shaders. However, instead of assigning a color 
or texture like a shader, cloth properties specify the physical properties of the 
cloth. These properties affect how the cloth behaves when it moves. For 
example, you could create a property that makes your cloth behave like denim. 
 
Animating Cloth 
When you animate your character, cloth solver calculates the collisions and 
motion of the cloth. Before you begin animating your character, you need to 
move your character from the dress-up pose to the animation start pose. To 
modify the movement of the cloth during the animation, you can add constraints 
or fields from Maya Dynamics. 
 
Playing back Cloth simulation 
When you run your simulation, you can cache the results for quick playback. You 
can save different cache files for the same scene to compare. Playback can be 
speed up by disabling the solver or the collision objects. 
 
Adding textures and shaders 
It adds a life like realism to your cloth. You use the standard Maya tools to add 
textures and shaders to your cloth just like you add them to any object in Maya. 
Cloth > Create Panel 
Use this command to create a cloth panel from the selected curves. 
Cloth > Create Garment 
Use this command to create a cloth garment from the selected panel or curves. 
Cloth > Create Seam 
Use this command to create a cloth seam from the selected curve(s). 
Cloth > Create Cloth Object 
Use this command to create a cloth object from the selected polygon. 
 
Differences between a garment and a cloth object 
A cloth object is a piece of geometry simulated as cloth. If you select a NURBS 
shape and make it a cloth object, Cloth first converts the NURBS to a polygonal 



 

 

object. 
A garment is one or more panels that are seamed together to form a cloth. A 
panel is made up of two or more NURBS curves that are on the same plane and 
form a closed region. 
Garments 
When you create a garment from curves, Cloth creates a mesh with varying sizes 
of triangles that are randomly distributed. The mesh has no regularity or stress 
lines. This creates more natural folds. In addition, if you change the resolution of 
a garment after simulating, Cloth can update the geometry without resimulating. 
However, you need to simulate for the cloth to move with the new resolution. 
 
Cloth 
You create cloth objects from polygonal shapes or NURBS shapes. The original 
shape is hidden and the tessellated cloth shape is displayed. The original shape 
and the cloth shape are grouped under the object’s transform. With NURBS 
objects and certain procedurally-generated polygonal objects, you can get 
artificial stress lines caused by the regular tessellation. 
Cloth > Create Collision Object 
This command sets the selected object as a collision object. 
Cloth > Create Collision Offset/Depth Mesh 
This command displays a collision mesh for the selected collision objects. 
 
Paint Collision Properties Tool 
This tool lets you use the Paint Collision Properties Tool to paint collision 
properties of cloth objects. In the Paint section there are some attributes unique 
to the Paint Collision Properties Tool. These unique attributes are described 
below. 
 
Paint section: 
1. Select Attribute: Be sure to first select a Cloth collision object in the scene 
view, and then select a cloth attribute from the drop-down list. When you 
paint, you paint values for that attribute. 
2. Priority Map: This is a per-vertex value. These values are averaged over 
a face and added to Collision Priority. 
3. Depth Map Offset: This is a per-vertex value. These values are averaged 
over a face and then used as a percentage offset applied to the calculated 
depth at that face. This is used to adjust for situations where the depth 
map calculation method does not produce perfect results. The effective 
depth can be painted up or down as needed. 
4. Collision Offset Map: This is a per-vertex value. These values are 
averaged over a face and then used as a percentage offset applied to the 
calculated offset at that face. This is used to adjust for situations where 
the depth offset calculation method does not produce perfect results. The 
effective offset can be painted up or down as needed. 
Collision Cloth Sets 
This command lets you control cloth collisions on a per-face basis, which is 
helpful if you want a subset of faces on a collision object to collide. All created 
collision cloth sets are stored in the Cloth > Collision Cloth Sets submenu. 
 

9.2.2Constraints > Button 



 

 

This creates a button constraint. When it is created a transform is created and 
updated every frame, which tracks the position and orientation of the cloth. You 
can parent an object to the transform and it will follow cloth like a button does. 
The options available in the option box are: 
1. Button Name: Enter a name for the button. 
2. Preserve Translation: This preserves the position of the button in world 
space. The button does not move after the constraint is created. 
3. Translate: When Preserve Translation is turned off, you can set the 
translate X, Y, Z values. 
4. Preserve Rotation: This preserves the offset of the button in world space. 
The button does not move after the constraint is created. 
5. Rotate: When Preserve Rotation is turned off, you can set the rotate X, Y, 
Z values. 
 
Constraints > Field 
You can use this command to connect a dynamic field to cloth. 
Constraints > Collision 
You can use a collision constraint to let you control collisions on a per-vertex 
basis and animate the control over time. 
Constraints > Cloth 
You can use a cloth constraint to bind cloth vertices to cloth. Useful for creating 
pockets etc. 
Constraints > Mesh 
You can use a mesh constraint to constrain cloth to a collision object. Sometimes 
you may want to constrain certain parts of your clothing to your character so the 
clothing doesn’t fall away. 
Constraints > Transform 
You can use this to create a transform constraint that constrains the cloth to the 
object at a certain distance, as though it were welded. If the object moves, the 
points on the cloth that are constrained also move. 
Simulation > Properties > Create Cloth Property 
Use this to create a new property. 
Simulation > Properties > Paint Cloth Properties Tool 
Lets you use the Paint Cloth Properties Tool to paint properties and wrinkling 
effects across the entire surface of a garment. 
 
Properties (Attributes) of the Cloth object 
These are the attributes of the Cloth object: 
1. U/V Bend Resistance: This attribute controls how much the cloth resists 
bending in the U and V directions. The greater the U/V Bend Resistance 
value, the stiffer the cloth. 
2. U/V Bend Rate: The U/V Bend Resistance may increase non-linearly as 
the cloth triangles are folded from 0 degrees to 180 degrees. The U/V 
Bend Rate attribute controls the exponent of how much the U/V Bend 
Resistance increases from 0 to 180 degrees. 
3. U/V Stretch Resistance: This attribute controls how much the cloth 
resists stretching in the U and V directions. The greater the value, the 
more the cloth resists stretching. 
4. Shear Resistance: This attribute controls how much individual triangles 
resist moving in an opposite but parallel sliding motion. The higher the 



 

 

number, the less the triangles can shear. 
5. U/V Scale: This attribute controls the scale of the cloth in the U and V 
directions. 
6. Density: This attribute controls the mass per unit area of the cloth. 
7. Thickness: This attribute controls the depth dimension of the cloth. The 
value specifies the collision offset of the cloth when it collides with itself 
and with other cloth bodies. The amount of offset may vary depending on 
the Thickness Force attribute. 
8. Thickness Force: This attribute controls the force used to maintain the 
collision offset specified by the Thickness attribute during cloth-to-cloth 
collisions. If a heavy piece of cloth gets closer to another piece of cloth 
than the distance specified by the Thickness attribute, you can increase 
this value to keep the heavier cloth at the proper distance. 
9. Cloth Friction: This attribute controls friction between the cloth and other 
cloth bodies. 
10. Cloth Damping: This attribute specifies how strongly the overall motion of 
the cloth is diminished. 
11. Air Damping: This attribute specifies how strongly the motion of the cloth 
is diminished by the physical properties of the air. Air damping provides air 
resistance to triangles that are normal to the direction of travel. If the 
triangles on the cloth are parallel to the direction of travel, Air Damping 
has no effect. 
 
Solvers > Create Solver 
Create Solver lets you create a solver so you can segment cloth simulations into 
multiple independent simulations that are solved separately. The options 
available are: 
1. Name: Enter a name for the solver. 
2. Start Frame: You can specify at what frame the solver starts calculating. 
3. Frame Samples: You can specify the number of times the solver samples 
the time interval between successive frames. Frame Samples and Time 
Step Size work together. 
4. Time Step Size: This option specifies the maximum time, in seconds, that 
the internal dynamic solution advances. 
5. Gravity: This option specifies the value for gravity. 
6. Relax Frame Length: This option specifies the number of frames that a 
rubbery “relax material” is applied to a garment and the garment does not 
react to gravity. After the specified number of frames, the normal material 
is applied and the cloth reacts to gravity. 
Save as Initial Cloth State 
Use this option to tell the cloth solver to use the current position as its start 
position. 
Update Cloth State 
Use this option to give the new cloth positions to the solver, but it doesn’t delete 
the cache. 
 

9.2.3 Simulation 
Once you have your cloth ready to drape over your character, you can start the 
simulation. The simulation is performed by the cloth solver, which assembles 
information on all the garments, cloth objects, the bodies they interact with, and 



 

 

any fields or constraints applied to the cloth. 
 

9.2.4 Start Local Simulation 
This command starts the Cloth simulation. 
 

9.2.5 Show Cloth Stress 
Use this option to turn on the display of stress feedback on the cloth. 
 

9.2..6 Manipulators > Drag Control 
This command activates the Drag Control Cloth manipulator and the locator at 
the end of the path is selected.  

 

9.3 Assignment  

1. Create dress for a model 

2. Flood in the city  

  



 

 

Unit 10 Maya Hair  

 

 

Time Required to Complete the unit 

 

The time required to study thus Unit is broken as follows 

1. 1st Reading: It will need 2 Hrs for reading a unit 

2. 2nd Reading with understanding:  It will need 3 Hrs for reading and understanding a unit 

3. Self Assessment:  It will need 3 Hrs for reading and understanding a unit 

4. Assignment: It will need 4 Hrs for completing an assignment 

5. Revision and Further Reading: It is continuous process 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
10.1 Maya Hair 
Maya Hair is a component of Maya Unlimited that you use to 



 

 

create a dynamic hair system so you can model realistic 
hairstyles and hair behavior. Since Hair is a generic dynamic 
curve simulation, you can also use these curves to create nonhair 
effects. With Hair you can simulate: 
• Natural movement and collisions of long hair 
• Hair blowing in the wind or being blow dried 
• Hair when swimming underwater 
• Various hairstyles, including ponytails, braids, and 
updos 
• Other dynamic curve effects such as ropes, chains, cables, wires, a suspension 
bridge, sea creatures, or even a lofted surface from a curve. 

 
A hair system is a collection of hair follicles. A NURBS or polygonal surface can 
have multiple hair systems on the same surface and one hair system can span 
multiple surfaces. A hair follicle in human hair typically hosts one hair, whereas in 
Maya each hair follicle hosts a hair curve. The hair follicle controls the attributes 
and curves associated with a particular hair clump, and how the hairs attach to a 
NURBS or polygonal surface. 
 
Paint Hair Tool 
With the Paint Hair Tool you can create hair, add and remove follicles, as well as 
paint follicle attributes, including Hair Scale, Stiffness, and Braid. 
 
Rendering Hair 
Paint Effects hair can be rendered using the Maya Software renderer. You can 
also convert Paint Effects hair to polygons and render in another renderer, such 
as mental ray. 
 

10.1.2 Create Hair 

Use create Hair to create dynamic hair on a NURBS or polygon surface. The 
options in the Create Hair options box are: 
1. Output: This is the hair system’s output. Select from one of the following: 
a. Paint Effects: Each follicle has hair clump containing information 
about the color and shading of the hair, as well as its position. 
b. NURBS Curves: Each follicle contains one NURBS curve that 
represents the position of the hair in that follicle. 
c. Paint Effects and NURBS Curves: Each follicle contains one 
NURBS curve that represents the position of the hair in that follicle. 
Each follicle also has a hair clump containing information about the 



 

 

color and shading of the hair. 
2. Create Rest Curves: When turned on, this creates a set of Rest curves 
that are straight and normal to the surface. 
3. Grid, At Selected Points/Faces: These options specify whether the hair 
to be created is placed on the grid of the selected surface, or at the 
selected surface points/faces. 
4. U Count: The number of follicles to be created along the U direction. 
5. V Count: The number of follicles to be created along the V direction. 
6. Passive Fill: The number of passive curves to active curves. Passive 
curves interpolate the dynamic behavior of active curves, but are less 
expensive than simulating every curve. 
7. Randomization: The degree of randomization for the placement of 
follicles along the U and V directions. With a value of 0 there is no 
randomization and the follicles are lined up. With a value of 1 the follicles 
are extremely random. 
8. Edge Bounded: When turned on, the follicles are created along the edge 
of the U and V parameters. 
9. Equalize: Turn this on so when hair is created Maya compensates for 
uneven mapping between UV space and world space, equalizing the 
distribution of the follicles so they aren’t cluttered at the poles. 
10. Static, Dynamic: These options specify whether the hair to be created is 
Static or Dynamic. Static hair does not respond to the dynamic forces, but 
can be manually keyframed, whereas dynamic hair does respond to the 
dynamic forces. 
11. Points Per Hair: The number of points/segments per hair. As this value 
increases the hair curve becomes smoother. Keep in mind for relatively 
short stiff hair use fewer points, but for long flowing hair use more points, 
especially if you plan to style the hair curves. 
12. Length: The length of the hair in world space units. 
13. Place Hairs into: Place the hairs to be created in a new hair system, or 
an existing hair system. 
 
 
 
Scale Hair Tool 
Lets you change the scale of the selected hair system. Drag right to make the 
hair larger or longer and drag left to make the hair smaller or shorter. 
 

10.1.3 Paint Hair Follicles 
You can use the Paint Hair Follicles Tool to add dynamic hair to a NURBS or 
polygonal surface, to remove hair, or to paint follicle attributes of an existing hair 
system. Paint Hair Follicles Settings are: 
1. Paint Modes: These are descriptions of the Paint Modes you can select in 
the Paint Hair Tool Settings window. 
a. Create Follicles: This option adds follicles to the surface as you 
paint. The follicles that are created and their appearance are based 
on the Density, Points Per hair and Hair Length settings in the Paint 
Hair Tool Settings window. 
b. Create Passive Follicles: This option adds passive follicles to the 
surface as you paint. Passive follicles draw their attributes and 



 

 

behavior from their neighboring active follicles/curves at the start of 
the simulation. 
c. Delete Follicles: This option removes follicles from the surface as 
you paint. 
d. Edit Follicle Attributes: This option modifies the follicles you paint 
based on the settings in the Paint Hair Tool Settings window. 
e. Trim Hairs: As you paint over the hairs they are trimmed based on 
the Value you specify for the Replace operation in the Paint Hair 
Tool Attribute Editor. The length that is trimmed is relative to the 
existing hair Length value. 
f. Extend Hairs: As you paint over the hairs they are lengthened 
based on the Value you specify for the Replace/Add operation in 
the Paint Hair Tool Attribute Editor. The length that is extended is 
relative to the existing hair Length value. 
2. Follicle Attribute: Select the follicle attribute to paint using the Edit 
Follicle Attributes Paint Mode. Specifically, you can paint Clump Width 
Mult, Density Mult, Curl Mult, Clump Twist Offset, Color Blend, Braid, Hair 
Scale, Inclination, Roll, Polar, Surface Inset, Stiffness. 
3. Hair System: Select which hair system to paint. 
4. Output: If Paint Mode is Creating Follicles, then select the type of hair 
output. 
5. Follicle Density U: If Paint Mode is Creating Follicle, this value 
represents the number of follicles to create in the U direction. 
6. Follicle Density V: If Paint Mode is Creating Follicle, this value represents 
the number of follicles to create in the V direction on the surface. 
7. Points Per hair: If Paint Mode is Creating Follicles, this value represents 
the number of points each new hair has. As this value increases the hair 
curve becomes smoother. If the Paint Mode is Trim Hairs or Extend Hairs, 
this value represents the number of points along the hair affected by the 
operation. 
8. Hair Length: The length of the hair in world space units. 
9. Follicle Override Color: You can specify a follicle color override if you 
select Edit Follicle Attributes as the Paint Mode and then select Color 
Blend as the attribute. You control the value of the Color Blend by 
adjusting the Value in the Tool Settings editor. 
 
Paint Hair Textures 
This command lets you paint maps for various Hair attributes, such as baldness, 
hair color, and specular color. 
 
Get Hair Example 
This command opens the Visor window, where you can choose from a selection 
of Hair Presets. 
 
Set Start Position 
Select this to set the position for the Start curves based on the Current Position 
or the Rest Position. The Start Position represents the position of the hair at the 
start of the simulation. 
 
Modify Curves 



 

 

Use these menu items to manipulate the hair curves to achieve the hairstyle you 
want. 
 
Lock Length 
This command locks the length of the hull for the selected curve or CV(s). 
 
Straighten 
Use this to straighten the hair curves. You can set the Straightness and turn on 
or off the Preserve Length in the Straighten Curves Options window. 
 
Curl 
Use this to add curl to or adjust the curl of the hair curves. You can set the Curl 
Amount and Curl Frequency values in the Curl Curves Options window. 
 
Bend 
Use this to add bend or adjust the bend in the hair curves. You can set the Bend 
Amount and Twist values in the Bend Curves Options window. 
 
Hair > Create Constraint 
Use these menu items to add constraints to selected hair curves. 
 
Create Constraint > Rubber Band 
Rubber Band adds a Rubber Band constraint to the selected hair curves. This is 
like attaching rubber bands from the constraint to the point set. The length of 
each rubber band is the distance from the constraint to the point at the start 
frame. If the distance between a point and the constraint becomes greater than 
the rubber band length a force is applied pulling it toward the constraint. 
 
Create Constraint > Stick 
Stick adds a Stick constraint to the selected hair curves. This is like attaching 
sticks from the constraint to the point set, where the sticks may rotate freely 
about the constraint center. This is similar to the Rubber Band constraint, except 
that when the distance between the constraint and points is less than the start 
distance a repulse force is also applied. This tends to keep all the constrained 
points at a fixed distance from the constraint center. 
 
Create Constraint > Transform 
Transform adds a Transform constraint to the selected hair curves. This is like 
constraining the points to a block of jelly at the start frame. This is useful when 
constraining hair to fall along a contact point, like a shoulder. Also this can be 
used to simulate hair being grabbed and twisted by a hand. If you animate the 
constraint's scale the hair can be pulled together or pushed apart. 
 
Create Constraint > Hair to Hair 
Hair to Hair adds a Hair to Hair constraint to the selected hair curves. This allows 
you to bind hairs together where the hair group is free to move with respect to the 
constraint position. 
 
Create Constraint > Hair Bunch 
Hair Bunch adds a Hair Bunch constraint to the selected hair curves. This can 



 

 

help create body to the hair as it animates in a fashion similar to self collision, but 
with much less computation. The initial set of points nearest the constraint will 
repel each other where they overlap. There is also a slight static cling where the 
points stick together slightly when they touch. If the hair clumps overlap at the 
start frame they may suddenly push apart. 
 
Assign Hair System 
Assigns the selection to the specified hair system, which can either be a new hair 
system or an existing hair system. 
 

10.1.4 Make Selected Curves Dynamic 
Any NURBS curve can be made into a dynamic hair, such as a curve deformer or 
input curves to a lofted surface. In addition to creating long hair and hairstyles 
you can use hair curves to create: 
• ropes and chains 
• a fish 
• a fishing line 
• a tied-back beaded curtain 
• an octopus 
• a suspension bridge 
• a wire deformer on particles 
 
Make Collide 
Make Collide sets the selected object to collide with the selected hair system. 
First select the object and then select the hair system. 
 

10.2 Maya Fur 
Maya Fur is a component of Maya Unlimited that you use 
to create realistic, self-shadowing fur and short hair on 
multi-surface NURBS, polygonal and subdivision surface 
models. You can set fur attributes, such as color, width, 
length, baldness, opacity, scraggle, curl, and direction 
globally, or map them on a local basis. Using an attractor 
system, you can also keyframe fur movement, or have fur 
react to dynamic forces within Maya. 

 
 

 
 
10.2.1 Modifying fur attributes 
You can modify fur description attributes so that all surfaces with the fur 
description attached have the new attributes. You can also style a fur description, 



 

 

such as shorten or lengthen the fur on some parts of the model, by mapping 
attribute values, or by painting fur attribute values directly on the model. 
 
Animating fur attributes 
You can keyframe the changes you make to fur attributes, and thus animate 
effects like growing fur or changing fur color. 
 
Adding movement to fur 
If you are animating your scenes, you can add movement to fur for a more 
natural effect. Using attractors, you can manually keyframe fur movement, or 
using Dynamics, you can make the fur react to forces or have fur react to the 
movement of the surface the fur is attached to for example, a shaking dog. 
 
Attach Fur Description 
Attach fur Description is used to attach a new or existing fur description to the 
selected surface(s). 
 
Edit Fur Description 
Use this to select a fur description and view its Attribute Editor: 
1. FurDescription: You can assign a name to the fur. 
2. Light Model: Select the light model you want applied to the fur 
description. 
a. Ambient Only: Only the Base Ambient Color and Tip Ambient 
Color of the fur are used in the final color calculation. 
b. Ambient + Diffuse: The Base Ambient Color and Tip Ambient 
Color values are added to the Base Color and Tip Color values 
respectively. 
c. Ambient + Diffuse + Specular: The Base Ambient Color and Tip 
Ambient Color values are added to the Base Color and Tip Color 
values respectively, and the Specular values are added to the hairs 
according to the Specular Sharpness. 
d. Specular Only: Only the specular lights for the fur are rendered. 
3. Density: Type the number of hairs you want distributed either across all 
surfaces the fur description is attached to or on each surface the fur 
description is attached to. 
4. Global Scale: Use this setting to adjust the Base Width, Tip Width, 
Length, and Offset values by a common factor. This scales the hairs 
uniformly. 
5. Assigned Surfaces: This option lists the surfaces that have the current 
fur description assigned to them. 
6. Base Color: Base color defines the color of the fur base. 
7. Tip Color: Tip Color defines the color of the fur tip. 
8. Specular Color: Specular color defines the color of shiny highlights on the 
fur. 
9. Length: Length defines the fur length in world units. 
10. Baldness: Baldness defines how much fur is on the surface. 
11. Inclination: Inclination sets the amount of inclination. 
12. Roll: Roll rotates the fur about the surface V axis. You can achieve almost 
any fur angle using Polar and Inclination, so use this option only when the 
fur has curl and you want the curls to lie flat. 



 

 

13. Polar: Polar rotates the fur about the surface normal. 
14. Base Width: Base Width defines the width of each hair at the base, in 
world units. 
15. Tip Width: Tip width defines the width of each hair at the tip, in world 
units. 
16. Base Curl: Base curl defines the amount of curl at the base of the fur. 
17. Tip Curl: Tip curl defines the amount of curl at the tip of the fur. 
18. Scraggle: Scraggle defines how crooked the fur is. 
19. Scraggle Frequency: This defines the amount of change over each 
length of hair. 
20. Attraction: Attraction defines the amount of attraction this fur description 
has towards attractors. Attractors are used to add movement to fur. 
 
Fur Render Settings 
Use this to set the render settings attributes for the Fur Description. 
 

10.2.2 Fur > Fur Shadowing attributes 
This is use to add or remove from a light’s Attribute Editor the Fur 
Shading/Shadowing attributes. 
Tip: This applies only to lights set up to render Fur with the Maya Software 
renderer. 
 
Add to selected Light 
To create more realistic looking fur with self-shading and shadows, you must first 
add fur light attributes. Then you can set up one of the following effects per light: 
• No shadows, no shading (less realistic) 
• No shadows, simple shading (relatively realistic) 
• (Depth Map) Shadows (most realistic, but longer rendering time) 
 
Remove from selected Light 
Adding lights with fur shading/shadowing attributes increases render time. 
Therefore the more lights that have fur shading/shadowing attributes, the longer 
the scene takes to render. Including many lights that have fur shading/shadowing 
attributes may not noticeably improve the look of the fur. Experiment with the 
number of lights with fur shading/shadowing you need to achieve the effect you 
want and optimize render time. 
You can easily remove fur shading/shadowing attributes from a light. However 
they only exist on a light if you’ve previously assigned them. 
 
Attach Hair System to Fur 
Use this to attach a hair system to a specified fur description. You can attach 
more than one fur description to the same hair system. 
 
Edit Curve Attractor Set 
Use this to open the FurCurveAttractors node in the Attribute Editor for the 
selected fur curve attractor set. The FurCurveAttractors node is created when 
you attach a hair system to a Fur description. 
1. FurCurveAttractors: You can assign a name to the attractors. 
2. Attractor Model: Select the type of curve attractor you want. 
a. Local: Local attraction affects the direction and shape of the fur by 



 

 

the amount the nearest attractor varies from its initial state. This 
lets you accurately propagate the exact changes in the attractors to 
the fur, whether those changes are subtle or extreme. 
b. Global: Global attraction attracts the fur towards the nearest 
attractor hair, causing a clumping effect. 
3. Curves Per Fur: Type the number of curves a fur should be influenced by. 
4. Influence: Influence set how much influence the curve will have on the 
fur. The value you enter linearly increases or decreases the influence over 
the length of the fur. 
 
Set Start Position To 
Use this to set the starting position of dynamic curves of a hair system based on 
the combed position of the fur. 
 
10.3 Maya Paint Effects 
Paint Effects is a component of Maya used to quickly and easily paint brush 
strokes and particle effects on a 2D canvas or on or between 3D geometry. You 
can use Paint Effects as a traditional paint program to paint images on a canvas, 
or to paint repeatable textures that you can apply to geometry in your scenes. 
Paint Effects goes beyond traditional painting—you can paint entire particle 
effects on your canvas or scene with a single brush stroke. On a 2D canvas a 
single brush stroke can produce complex images, for example trees or flowers. In 
your scene, that same brush stroke produces these entities three-dimensionally. 
You can also apply dynamic forces to the effects you paint in your scenes and 
animate the display and movement of the effects. Paint Effects strokes render 
seamlessly with the rest of your scene during a post process in the final render. 
 

10.3.1 Paint Effects > Paint Effects Tool 
This tool allows you to paint strokes with Paint Effects brushes. The available 
Paint Effects Tool settings are: 
1. Draw As Mesh: This setting lets you preview the rendered look of your 
strokes interactively in the scene view; you don't have to view them in the 
Paint Effects panel. You can also edit brush attributes and see the 
changes happening to the stroke in the scene view. 
2. Paint at Depth: When Paint at Depth is off, the depth values of the paint 
change as you drag the brush into the scene. If the stroke has tubes, the 
tubes grow from the surface you paint. When Paint at Depth is on, the 
depth value of the stroke is determined when you first click the brush, and 
is then fixed at that value. If the stroke has tubes, the tubes grow from the 
plane orthogonal to the path at each step. This is useful for creating 
effects where you want tubes to sprout out from the path. The Paint 
Effects Tool cursor changes to project ortho-normal to the view, to indicate 
you are painting at depth. 
3. Display Quality: This setting set the display quality of the wireframe for 
the next stroke. The higher the percentage, the more closely the stroke 
wireframe represents the rendered stroke. 
4. Surface Offset: This setting set the distance you want the next stroke 
offset from the object or plane you paint the stroke on. 
5. Pressure Mapping 1, 2, and 3: Select which value you want to map to 



 

 

pressure. Select Off for no pressure sensitivity. 
6. Pressure Min1, 2, and 3: This setting set the minimum pressure at which 
the pressure mapping will start to take effect. The minimum attribute value 
that you can paint is determined by multiplying the Pressure Min by the 
value set for the mapped attribute. 
7. Pressure Max1, 2, and 3: This setting set the maximum pressure at 
which the pressure mapping will take effect. The maximum attribute value 
that you can paint is determined by multiplying the Pressure Max by the 
value set for the mapped attribute. 
 
Make Paintable 
Make Paintable allows you to paint the selected NURBS or polygonal objects. To 
paint on NURBS or polygonal objects, you must first make the objects paintable. 
 
 
Share One Brush 
Share one brush forces the selected strokes to share the brush of the last 
selected stroke. When strokes share a brush, any changes you make to the 
brush affect all the strokes that brush is attached to. 
 
Get Brush 
Get Brush opens the Visor so you can select a preset brush. 
 

10.3.2 Visor 

The window that displays the rendering-related nodes currently used in a scene, 
and provides access to files on disk which the user may wish to bring into the 
scene like animation clips, brushes, shader libraries, or texture libraries 

 

 

10.4 Assignment 

1. Create Hair 
2. Character with fur 



 

 

3. Character Weighting 
 


